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Preface

Welcome to ChromQuest™ 5.0. The ChromQuest chromatography data system is a member 
of the Thermo Scientific family of LC data systems.  

Whether you are a new ChromQuest user or are upgrading from a previous version of 
ChromQuest, we think you will find the features of ChromQuest 5.0 both powerful and well 
organized.

This ChromQuest Chromatography Data System Reference Guide contains technical details, 
such as how integration is performed and equations are used.

For instructions on how to use the ChromQuest chromatography data system to acquire and 
process data, refer to the ChromQuest User Guide.

Related Documentation
In addition to this guide, Thermo Fisher Scientific provides the following documents for the 
ChromQuest chromatography data system:

• ChromQuest 5.0 Installation Guide (PDF on the ChromQuest CD)

• ChromQuest 5.0 Administrator Guide (PDF on the ChromQuest CD)

• ChromQuest 5.0 User Guide (PDF on the ChromQuest CD)

• ChromQuest 5.0 Quick Reference Guide (laminated card)

New Features
The ChromQuest 5.0 chromatography data system provides these new features:

• A navigation bar has been added to the Instrument window. 

• The Move Baseline Start and Stop integration timed events have been replaced by the 
Move Baseline integration timed event. See “Move Baseline ” on page 25.

• A custom peak parameter has been added to the sequence table. 

• A new Graphics Export function has been added. See “Graphics Export” on page 91.
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• Overlaid traces are now normalized by default. 

• A System Administration Report has been added. 

• Users can be found by searching the Active Directory. 

• System Administrators can now create pre-defined custom reasons for audit trails. 

• Multi-level bracketed calibrations are now supported. 

• A sequence print table is available for custom reports. 

• A sequence run type, baseline file, has been added that enables you to subtract a baseline 
file from other runs in the sequence. 

• A Stop Run option has been added: Stop sequence after current run completes. 

• A configurable Filtered Method Report has been added. 

• Run Type can be selected as a field in Advanced Reports. 

• A user-configurable Sequence Contents Report is available. 

• The available fields in the Method Custom Report have been updated to include User 
Acquiring the Data. 

• Page break has been added to the custom report editor. 

• In the PDA software, you can specify a wavelength to designate a chromatogram to be 
used as a baseline subtraction chromatogram for other chromatograms extracted from the 
3D data. See “Multi-Chromatogram” on page 131.

Safety and Special Notices
Make sure you follow the precautionary statements presented in this guide. The safety and 
other special notices appear in boxes.

Safety and special notices include the following:

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.
ChromQuest Reference Guide Thermo Scientific
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Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

To contact Technical Support

Find software updates and utilities to download at www.mssupport.thermo.com.

To contact Customer Service for ordering information

To copy manuals from the Internet

Go to mssupport.thermo.com and click Customer Manuals in the left margin of the window. 

To suggest changes to documentation or to Help

• Fill out a reader survey online at www.thermo.com/lcms-techpubs.

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com.

Phone 800-685-9535
Fax 561-688-8736
E-mail TechSupport.C+MS@thermofisher.com
Knowledge base www.thermokb.com

Phone 800-532-4752
Fax 561-688-8731
Web site www.thermo.com/ms
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Examples of Integration Timed Events

Integration Timed Events are used to customize the integration of certain peaks or regions of 
the chromatogram. The following examples demonstrate how each integration timed event 
would affect the integration of the chromatogram displayed, in order to give you a feel for 
how an integration timed event might be used in your chromatography method. 

There are two ways to add an integration timed event to a method: by manually adding the 
event to the Integration Timed Event Table, or graphically by clicking on the chromatogram. 
For details on how to add an event to your method, refer to Chapter 3: Method 
Development of the ChromQuest Chromatography Data System User Guide.

Contents

• Integration Timed Events Tables

• Required Integration Timed Events

• Optional Integration Events

• Baseline Code Descriptions
Thermo Scientific ChromQuest Chromatography Data System Reference Guide 1
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Integration Timed Events Tables

2

Integration Timed Events Tables
ChromQuest has two tables where integration timed events are saved. It is important to 
understand the difference between these two tables. When you add an integration timed event 
graphically, a dialog box appears before it is added to the method, allowing you to choose 
whether you want to place the event in your method, and if so, in which integration timed 
events table the event is placed. The default table for each integration event is selected. An 
example of such a dialog is shown below.

Figure 1. Integration Off dialog box

If you select the Add to Table command, the timed event is inserted in either the Integration 
Events Table, or the Manual Integration Fixes Table, depending on which of these is 
selected.

Integration Events Table

When you add an integration event to the Integration Events Table, the integration changes is 
used on all subsequent samples analyzed using this method. (Assuming the method is saved.) 
These events should be setup to accurately analyze typical samples. 

Figure 2. Integration Events table
ChromQuest Chromatography Data System Reference Guide Thermo Scientific



 1 Examples of Integration Timed Events
Integration Timed Events Tables
The Integration Events Table contains all current Integration Timed Events for the current 
method channel. You can add an event manually by selecting the event from the drop-down 
list in the Events field, entering an appropriate Start and Stop time and a Value for the event 
(if required). To remove an event’s effect from an analysis, yet keep the event in the table, 
click the check mark next to the event. Only events with a red check mark have an effect on 
subsequent analyses.

To remove an event entirely from the table, click the row number of the event, followed by 
the Delete key.

A right-hand mouse click anywhere in the table produces a menu of commands for 
manipulating cells and rows in the spreadsheet. The Insert Paste command is used to insert a 
line at the same time you paste to the location. The Insert Line command simply inserts a 
blank line where your cursor is located. 

Manual Integration Fixes Table

When you add an integration event to the Manual Integration Fixes Table, it is applied only 
to this sample. Thus, Manual Integration Fixes are One-time integration events. These events 
are attached to individual files to accurately integrate an atypical sample. The results using 
these events are stored in the data file. This allows you later to reproduce the results generated 
using a manual integration event that was only necessary for a single run.

To view the Manual Integration Fixes Table, click the Manual Integration Fixes Table 
button, or choose the Data > Manual Integration Fixes command from the menu bar.

Figure 3. Manual Integration Fixes table

The Manual Integration Fixes Table contains all current Manual Integration Fixes for the 
current data file. You can add an event manually by selecting the event from the drop-down 
list in the Events field, entering an appropriate Start and Stop time and a Value for the event 
(if required). To remove an event’s effect from an analysis, yet keep the event in the table, 
click the check mark next to the event. Only events with a red check mark have an effect on 
subsequent analyses.

To remove an event entirely from the table, click the row number of the event, followed by 
the Delete key.
Thermo Scientific ChromQuest Chromatography Data System Reference Guide 3
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4

A right-hand mouse click anywhere in the table produces a menu of commands for 
manipulating cells and rows in the spreadsheet. The Insert Paste command is used to insert a 
line at the same time you paste to the location. The Insert Line command simply inserts a 
blank line where your cursor is located. 

View Preferences for Integration Events
By default the integration events toolbar appears at the bottom of the Instrument window 
when you open a data file. If you prefer to access the integration tools from the shortcut menu 
and want to maximize the chromatogram display area, you can hide the integration events 
toolbar.

When you select an integration event, a blue dialog box appears with instructions for using 
the event. The same instructions appear in the Status bar. 

Figure 4. Move Baseline instructions

This section contains these procedures:

• Hiding the Integration Events Toolbar

• Hiding the Graphical Programming Tooltips
ChromQuest Chromatography Data System Reference Guide Thermo Scientific
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View Preferences for Integration Events
Hiding the Integration Events Toolbar

To hide the integration events toolbar

1. Choose View > Preferences.

The Preferences dialog box appears (see Figure 5).

Figure 5. Preferences dialog box

2. In the Toolbar options area, select Int Event, and then clear the Show toolbar check box.

3. Click OK to accept the change and close the dialog box.
Thermo Scientific ChromQuest Chromatography Data System Reference Guide 5
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Hiding the Graphical Programming Tooltips

To hide the graphical programming tooltips

1. Choose View > Preferences.

The Preferences dialog box appears (see Figure 6).

Figure 6. Preferences dialog box

2. In the Tooltips options area, clear the Show graphical programming tooltips check box.

3. Click OK to accept the change and close the dialog box.

Required Integration Timed Events
Two Integration events are required for each run: Width, and Threshold. These events are 
used to detect peak start, stop, and apex, and to distinguish true peaks from noise. When you 
create a new method, default values are entered automatically in the method. However, if you 
clear an Integration Event Table, you must be sure to enter these events again; otherwise you 
will get an error message when you analyze the chromatogram.
ChromQuest Chromatography Data System Reference Guide Thermo Scientific
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Required Integration Timed Events

T

Width

The Width event is used to calculate a value for bunching, or smoothing, the data points 
before the integration algorithm is applied. Integration works best when there are 20 points 
across a peak. If a peak is over sampled (that is, the sampling frequency was too high), the 
Width parameter is used to average the data such that the integration algorithm sees only 
20 points across the peak. In setting a Width value graphically, the narrowest peak in the 
chromatogram should be used. 

The Width parameter is only used to correct for over-sampling. It cannot correct for data that 
was under-sampled (that is, sampling frequency too low causing fewer than 20 points 
acquired across the narrowest peak.)

A Width event is applied to a given peak as long as it occurs before or on the apex of the peak.

Threshold

This parameter is the first derivative, used to allow the integration algorithm to distinguish 
the start and stop of peaks from baseline noise and drift. When setting the Threshold value 
graphically, you select a section of baseline. The recommended Threshold value is based on 
the highest first derivative value determined in that section of the chromatogram. 

The diagram below shows examples of how incorrect values for peak Width and Threshold 
can affect the peak baseline. 

Figure 7. Required integration events: Peak Width and Threshold

Note that extreme values of both Width and Threshold (too large or too small) can result in 
peaks not detected.

Note  In most circumstances, an initial Width value based on the narrowest peak in the 
chromatogram is adequate for proper integration of all peaks. However, a new Width 
timed event should be entered every time a peak width doubles.

Fiber optic

Peak width
too narrow

Correct
peak width

Peak width
too large

Fiber optic

Threshold value
too small

Correct
threshold value

Threshold value
too large
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Optional Integration Events
The following integration timed events are available for you to program into your method to 
“customize” the integration of particular peaks or groups of peaks.

• Shoulder Sensitivity
• Integration Off
• Valley to Valley
• Horizontal Baseline
• Backward Horizontal Baseline 
• Lowest Point Horizontal Baseline
• Tangent Skim
• Front Tangent Skim 
• Minimum Area
• Negative Peak
• Disable End Peak Detection
• Reassign Peak
• Manual Baseline
• Manual Peak
• Split Peak 
• Force Peak Start /Force Peak Stop 
• Move Baseline 
• Reset Baseline
• Reset Baseline At Valley
• Adjust Retention Time Window
• Adjust Group Range
ChromQuest Chromatography Data System Reference Guide Thermo Scientific
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Optional Integration Events
Shoulder Sensitivity

This parameter is used to enable the detection of shoulders on larger peaks. A larger value 
decreases shoulder sensitivity, while smaller values increase sensitivity to shoulder peaks. 
When setting the Shoulder Sensitivity value graphically, you select a section of the baseline. 
The recommended Shoulder Sensitivity value is based on the highest second derivative value 
determined in that section of the chromatogram.

Figure 8. Shoulder Sensitivity dialog box

Click Add to Table, and the timed event is inserted in either the Integration Events Table, or 
the Manual Integration Fixes Table, depending on which of these you select. Click Cancel 
to ignore the timed event and cancel the operation. Click Analyze now to add the event to the 
table and analyze the chromatogram using the event.

Figure 9. Shoulder Sensitivity events
Shoulder Sensitivity
value set too high

Shoulder Sensitivity
value set correctly
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Integration Off

This event turns off the integration of your chromatogram during the range specified. This 
event is useful if you are not interested in certain areas of your chromatogram, and do not 
wish peaks to be reported for that section. 

Figure 10. Integration Off dialog box

Click Add to Table, and the timed event is inserted in either the Integration Events Table, or 
the Manual Integration Fixes Table, depending on which of these you select. Click Cancel 
to ignore the timed event and cancel the operation. Click Analyze Now to add the event to 
the table and analyze the chromatogram using the event.

The following example chromatograms illustrate the effect of using the Integration Off event 
to turn integration off between 0 and 5 minutes. 

Figure 11. Integration Off events
Default integration

Integration Off event 
from 0 to 5 minutes
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Optional Integration Events
Valley to Valley

This event causes the baselines of peaks that are not totally resolved (that is. do not return to 
baseline) to be drawn to the minimum point between the peaks. If this event is not used, a 
baseline is projected to the next point at which the chromatogram returns to baseline, and a 
perpendicular is dropped for peaks that do not reach baseline.

Figure 12. Valley to Valley dialog box

Click Add to Table, and the timed event is inserted in either the Integration Events Table, or 
the Manual Integration Fixes Table, depending on which of these you select. Click Cancel 
to ignore the timed event and cancel the operation. Click Analyze Now to add the event to 
the table and analyze the chromatogram using the event.

Figure 13. Valley to Valley events
Default integration

Integration with
Valley to Valley event
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Horizontal Baseline

This event allows you to project the baseline forward horizontally between the times specified 
for the event. 

Figure 14. Horizontal Baseline dialog box

Click Add to Table, and the timed event is inserted in either the Integration Events Table, or 
the Manual Integration Fixes Table, depending on which of these you select. Click Cancel 
to ignore the timed event and cancel the operation. Click Analyze Now to add the event to 
the table and analyze the chromatogram using the event.

Figure 15. Horizontal Baseline events
Integration without
Horizontal Baseline event

Integration with
Horizontal Baseline between 
1.8 and 3.6 minutes
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Optional Integration Events
Backward Horizontal Baseline 

This event is used to force a horizontal baseline in the direction of the beginning of the 
chromatogram. A backward horizontal baseline is created between the times specified by the 
event.

Figure 16. Backward Horizontal Baseline dialog box

Click Add to Table, and the timed event is inserted in either the Integration Events Table, or 
the Manual Integration Fixes Table, depending on which of these you select. Click Cancel 
to ignore the timed event and cancel the operation. Click Analyze Now to add the event to 
the table and analyze the chromatogram using the event.

Figure 17. Backward Horizontal Baseline events
Default integration

Integration after 
Backward Horizontal Baseline 
event
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Lowest Point Horizontal Baseline

This event is similar to the Horizontal Baseline event, except that the lowest point in the 
chromatogram determines the baseline. The Start Time entered for this event is the point 
from which the software searches for the lowest point. The Stop Time is the time where the 
software stops searching for the lowest point.

Figure 18. Lowest Point Horizontal Baseline dialog box

Click Add to Table, and the timed event is inserted in either the Integration Events Table, or 
the Manual Integration Fixes Table, depending on which of these you select. Click Cancel 
to ignore the timed event and cancel the operation. Click Analyze Now to add the event to 
the table and analyze the chromatogram using the event.

Figure 19. Lowest Point Horizontal Baseline events
Integration before using 
Lowest Point Horizontal Baseline 
event

Integration after using 
Lowest Point Horizontal Baseline 
event
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Tangent Skim

This event is used to integrate a small peak located on the tailing edge of a larger peak. The 
baseline of the small peak becomes a tangent drawn from the valley of the larger peak to the 
tangent point on the chromatogram.

Figure 20. Tangent Skim dialog box

Click Add to Table, and the timed event is inserted in either the Integration Events Table, or 
the Manual Integration Fixes Table, depending on which of these you select. Click Cancel 
to ignore the timed event and cancel the operation. Click Analyze Now to add the event to 
the table and analyze the chromatogram using the event.

Figure 21. Tangent Skim events
Integration without
Tangent Skim event

Integration with 
Tangent Skim event
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Front Tangent Skim 

The Front Tangent Skim event is used to force a tangential baseline for a daughter peak on the 
leading edge of a mother peak.

Figure 22. Front Tangent Skim dialog box

Click Add to Table, and the timed event is inserted in either the Integration Events Table, or 
the Manual Integration Fixes Table, depending on which of these you select. Click Cancel 
to ignore the timed event and cancel the operation. Click Analyze Now to add the event to 
the table and analyze the chromatogram using the event.

Figure 23. Front Tangent Skim events
Before 
Front Tangent Skim event

After 
Front Tangent Skim event
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Optional Integration Events
Minimum Area

This event allows you to enter an area limit for peak detection. Peaks whose areas fall below 
this minimum area is not be integrated and reported as peaks. This event is useful for 
eliminating noise or contaminant peaks from your report.

Figure 24. Minimum Area dialog box

Click Add to Table, and the timed event is inserted in either the Integration Events Table, or 
the Manual Integration Fixes Table, depending on which of these you select. Click Cancel 
to ignore the timed event and cancel the operation. Click Analyze Now to add the event to 
the table and analyze the chromatogram using the event.

Figure 25.  Minimum Area events
Integration without 
Minimum Area event

Integration with 
Minimum Area event
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Negative Peak

This event causes portions of the chromatogram that drop below the baseline to be integrated 
using the normal peak logic and reported as true peaks. This event is useful when using 
detectors such as Refractive Index types that give a negative response to certain compounds.

Figure 26. Negative Peak dialog box

Click Add to Table, and the timed event is inserted in either the Integration Events Table, or 
the Manual Integration Fixes Table, depending on which of these you select. Click Cancel 
to ignore the timed event and cancel the operation. Click Analyze Now to add the event to 
the table and analyze the chromatogram using the event.

Figure 27.  Negative Peak events
Default integration

Integration with 
Negative Peak event
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Optional Integration Events
Disable End Peak Detection

This event is used to turn off end of peak detection between the specified times, forcing the 
software to treat peaks falling within the window of the event as a single peak. This event is a 
useful way to combine the areas of a series of contiguous peaks into one area. Because the 
peaks are considered to be part of a single peak, the retention time is assigned to the time of 
the first apex after the Disable End Peak Detection event.

Figure 28. Disable End Peak Detection dialog box

Click Add to Table, and the timed event is inserted in either the Integration Events Table, or 
the Manual Integration Fixes Table, depending on which of these you select. Click Cancel 
to ignore the timed event and cancel the operation. Click Analyze Now to add the event to 
the table and analyze the chromatogram using the event.

Figure 29. Disable End Peak Detection events
Default integration

Disable End Peak Detection
between 0.4 and 2.2 minutes
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Reassign Peak

This event allows you to graphically designate a different peak as the calibrated peak in place 
of the peak that has been identified. When you use the Reassign event, the expected retention 
time of the named peak is adjusted in the Peak Table to the retention time of the designated 
peak.

Figure 30. Reassign Peak dialog box

Click Add to Table, and the timed event is inserted in the Manual Integration Fixes Table. 
Click Cancel to ignore the timed event and cancel the operation. Click Analyze Now to add 
the event to the table and analyze the chromatogram using the event. In the following 
example, Peak 2 has been reassigned to a new peak.

Figure 31. Reassign Peak events
Before 
Peak 2 reassignment

After 
Peak 2 reassignment
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Manual Baseline

This event allows you to change the way the baseline for a peak is drawn without changing the 
integration parameters. This is convenient when you want to change where a baseline is 
drawn for a peak without changing how the baseline is drawn for other peaks in the 
chromatogram.

The Manual Baseline event was used to “draw” a new baseline for the second peak. To draw 
the new baseline, choose the Manual Baseline command, and then click your mouse at the 
start of the desired baseline, and again at the end of the desired baseline.

Figure 32. Manual Baseline dialog box

Click Add to Table, and the timed event is inserted in the Manual Integration Fixes Table. 
Click Cancel to ignore the timed event and cancel the operation. Click Analyze Now to add 
the event to the table and analyze the chromatogram using the event. Manual Baseline events 
are stored in the Manual Integration Fixes table by default. 

Figure 33. Manual Baseline events
Default integration

Integration with 
Manual Baseline between 
0.765 and 1.43 minutes
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Manual Peak

This command allows you to graphically define a peak that was not previously detected. This 
is convenient when you want to force integration of a peak, but do not want to change your 
overall integration parameters. 

Figure 34. Manual Peak dialog box

Click Add to Table, and the timed event is inserted in the Manual Integration Fixes Table. 
Click Cancel to ignore the timed event and cancel the operation. Click Analyze Now to add 
the event to the table and analyze the chromatogram using the event.

In the following example, the Manual Peak event was used to force the integration of the 
smaller peak on the right. To use this event, click the Manual Peak button from the Graphical 
Integration toolbar. Click once the start of the peak to be defined. Again, click the end of the 
peak to be defined. Manual Peak events are stored in the Manual Integration Fixes table by 
default. 

Figure 35. Manual Peak events
Default integration

Small peak integration forced 
using Manual Peak event
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Optional Integration Events
Split Peak 

This event is used to force a perpendicular drop-line integration in a peak. The perpendicular 
is dropped at the point where the event is inserted.

Figure 36. Split Peak dialog box

Click Add to Table, and the timed event is inserted in the Manual Integration Fixes Table. 
Click Cancel to ignore the timed event and cancel the operation. Click Analyze Now to add 
the event to the table and analyze the chromatogram using the event.

Figure 37. Split Peak events

This event is stored in the Manual Integration Fixes table by default. 

Integration before
Split Peak event

Integration after 
Split Peak added at 
5.3 minutes
Thermo Scientific ChromQuest Chromatography Data System Reference Guide 23



1 Examples of Integration Timed Events
Optional Integration Events

24
Force Peak Start /Force Peak Stop 

These events are used to force the start or stop of the peak integration to a specific point. This 
event is stored in the Manual Integration Fixes table by default.

Figure 38. Force Peak Start dialog box

Click Add to Table, and the timed event is inserted in the Manual Integration Fixes Table. 
Click Cancel to ignore the timed event and cancel the operation. Click Analyze Now to add 
the event to the table and analyze the chromatogram using the event.

Figure 39. Force Peak Start events
Default integration

Integration after 
Force Peak Start to 
33.1 minutes
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Move Baseline 

This event allows you to move the start and stop of a baseline by clicking and dragging them 
to a new location. 

1. When you choose Move Baseline, you are prompted to click the baseline segment you 
want to modify. The start and end points of the baseline segment appears highlighted 
with boxes. See Figure 42.

2. When you move the cursor to a location within range of the start or stop point, it turns 
into an “anchor”. Left-click and drag the baseline start-point to the new location, and 
then let go. Left-click and drag the baseline stop-point to a new location, and then let go.

3. You can continue to click and drag the baseline in this manner until it is in the correct 
location. Then press the “Esc” key. A dialog box appears. See Figure 40.

Figure 40. Move BL Start dialog box

Click Add to Table, and the timed event is inserted in the Manual Integration Fixes Table. 
Click Cancel to ignore the timed event and cancel the operation. Click Analyze Now to add 
the event to the table and analyze the chromatogram using the event.

Figure 41 shows the initial start and stop times for a baseline segment (5.46 and 
5.96 minutes). Figure 42 shows the selected baseline segment. Figure 43 shows the new 
baseline segment produced by dragging the start time to the left and the stop time to the right.

By default, the move baseline events are added to Manual Integration Fixes Table. See 
Figure 44
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Figure 41. View of the initial start and stop times for a baseline segment

Figure 42. View of a selected baseline segment
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Figure 43. View of the new baseline segment (after analyzing)

Figure 44. Manual Integration Fixes table with the new baseline start and stop times
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Reset Baseline

This event causes the baseline to be reset to the point you click. Baseline segments before this 
time point are not affected. This event is functionally equivalent to performing an Integration 
Off and Integration On event at the same time.

Figure 45. Reset Baseline dialog box

Click Add to Table, and the timed event is inserted in either the Integration Events Table, or 
the Manual Integration Fixes Table, depending on which of these you select. Click Cancel to 
ignore the timed event and cancel the operation. Click Analyze Now to add the event to the 
table and analyze the chromatogram using the event.

Reset Baseline At Valley

This event causes the baseline to be reset at the next valley detected after the event. To enter 
the event graphically, click the location you want to enter the event, and then click the Reset 
Baseline at Valley button at the bottom of the window.

Figure 46. Reset Baseline at Valley dialog box

Note  The event should be placed after the start of the peak first peak in the cluster; 
otherwise the start of the peak is identified as the valley
ChromQuest Chromatography Data System Reference Guide Thermo Scientific



 1 Examples of Integration Timed Events
Optional Integration Events
Click the Add to Table button, and the timed event is inserted in either the Integration 
Events Table, or the Manual Integration Fixes Table, depending on which of these you select. 
Click Cancel to ignore the timed event and cancel the operation. Click Analyze Now to add 
the event to the table and analyze the chromatogram using the event.

Figure 47 shows an example of this event.

Figure 47. Reset Baseline at Valley events

Adjust Retention Time Window

You can use this graphical integration tool to change the retention time and the retention time 
window for a peak. Before you can use this tool, you must add the Retention Time Window 
annotation to your chromatogram.

To add the Retention Time Window annotation to your chromatogram, right-click the 
chromatogram to open the shortcut menu. Then, choose Annotations to open the Trace 
Annotation Properties dialog box. In the Trace Annotation Properties dialog box, select the 
RT Window check box.

Baseline before 
Reset Baseline at Valley 
event

Baseline after 
Reset Baseline at Valley 
event
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To use the Adj RT Window tool

1. Click the Adjust Retention Time Window button in the integration toolbar. 
Alternatively, right-click the chromatogram to open the shortcut menu. Then, choose 
Graphical Programming > Adjust Retention Time Window.

The following message appears in the Status box at the bottom of the screen: Click an 
RT Window, then move/size it. Hit <ESC> to finish.

Figure 48. Adjust Retention Time Window

2. Click the RT Time Window that you want to adjust. Move it or resize it. Then, press 
ESC.

The Adjust Retention Time Window dialog box appears.

Figure 49. Adjust Retention Time Window dialog box

3.  Verify the modified Retention Time Window. Then, do one of the following:

• Click Update RT to update the Retention Time and Window for the selected peak in 
the peak table.

• Click Analyze Now to add the event to the peak table and analyze the chromatogram 
using the updated Retention Time and Retention Time Window.

• Click Cancel to ignore the operation.
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Figure 50. Reset Retention Time window

Adjust Group Range

This graphical integration feature allows you to adjust calibrated and uncalibrated group 
ranges from the Chromatogram window.

To adjust a group range

1. Right-click a chromatogram to open the Trace Annotation Properties dialog box. Then, 
ensure that the Group Range check box is selected. 

2. Click the Adjust Group button in the integration toolbar.

3. Click the group range annotation that you want to adjust. A grab bar appears.

4. Drag the bar to resize the Group Range definition.

5. Press ESC to finish. The Adjust Group Range dialog box appears. See Figure 51.

Figure 51. Adjust Group Range dialog box
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6. Verify the modified range. Then, do one of the following:

• Click Update Group to update the definition of the group range in the Peaks/Group 
table.

• Click Analyze Now to update the definition of the group range in the Peaks/Group 
table and to analyze the chromatogram using the updated group range.

• Click Cancel to ignore the operation.

Figure 52. Adjust Group Range dialog box events
Group range before 
adjustment

Group range after 
adjustment
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Baseline Code Descriptions
Baseline codes can be included in custom reports, and can be used to annotate 
chromatograms. A baseline code consists of two letters. The first letter denotes the peak 
beginning baseline type and the second letter indicates the peak ending baseline type. 

B Baseline

f Force Peak Start or Stop (user defined)

I Peak ended by Integration Off event

N Begin negative peak

P End negative peak

H Forward horizontal

h Backward horizontal

M Manual baseline or Manual peak

m Move baseline Start/Stop

S Shoulder

T Tangent skim

V Valley

v Forced valley point

x Split peak

E End of chromatogram encountered before the end of peak was found. End of 
chromatogram used as peak end.

R Reset

LL Lowest

RN Reset Baseline at Next Valley

RB Reset Baseline
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2

Equations and Calculations

This chapter describes the equations that are used by ChromQuest 5.0 to create calibration 
curves and to calculate chromatographic performance.

Contents

• Calibration Curves

• Determining Concentrations for Uncalibrated Peaks

• Internal Standard Amounts

• Calibration Curve Calculations

• Report Calculations

• Performance Calculations
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Calibration Curves
A calibration curve relates the component amount to detector response, (or for an Internal 
Standard calibration, the amount ratio to the area or height ratio). ChromQuest fits a curve to 
the calibration points, according to the fit type, scaling, and weighting factors you select. The 
resulting calibration curve is used to calculate component concentrations in unknown 
samples, and is generally defined by a least squares calculation.

where 

ƒ = point to point

linear (with or without force through zero)

quadratic (with or without force through zero)

cubic (with or without force through zero)

average RF fit

Response Factor Definition

In ChromQuest, you can select to have response factors defined as either Amount/Area or 
Area/Amount. This selection is made in the Method Properties/Options tab and will apply 
to the entire method. The calibration curve and assignment of x and y values will differ 
depending on the response factor selection you make.

y x( )∫=
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Area/Amount Response Factor Definition

If you select Area/Amount for your response factor definition, the calibration curve (which 
can be viewed in Review Calibration) is defined where y = amount and x = area or height. 
(For internal standard calibrations, y = amount ratio and x = area or height ratio.) Figure 53 is 
an example calibration curve using Area/Amount response factor definition.

Figure 53.  Calibration Curve with Area/Amount Response Factor Definition

If you select Amount/Area for your response factor definition, the calibration curve (which 
can be viewed in Review Calibration) is defined where y = area or height and x = amount. 
(For internal standard calibrations, y = area or height ratio and x = amount ratio.) Figure 54 is 
an example calibration curve using Amount/Area response factor definition.

Figure 54.  Calibration Curve with Amount/Area Response Factor Definition
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Internal Standard vs. External Standard and Normalization

External Standard and Normalization calibration curve plots differ from Internal Standard 
calibration curves. This is because the amounts and responses in the Internal Standard 
calibration represent the ratios of the internal standard component to the amounts and 
responses of the calibrated components.

External Standard Calibration Curves

Figure 55 is an example of the External Standard and Normalization curve, the component 
Amount is plotted on the X-Axis and the component Area is plotted on the Y-Axis 
(Amount/Area Response Factor Definition):

Figure 55. External Standard Calibration Curve

The external calibration curve (for Response Factor definition Area/Amount) is calculated as:

where

ƒ = the equation of the calibration points according to the fit type you have selected 
(linear, quadratic, point to point, etc.)

Amtcal = the amount of the calibration standard

Areacal = the area of the calibration standard

Amtcal Areacal( )∫=
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Therefore the unknown is determined by:

where

Amtunk(u) = the uncorrected amount of the unknown component

ƒ = the equation of the calibration points according to the fit type you have selected

Areaunk = the area of the unknown component

To calculate the concentration of the unknown sample:

where

Conc = the concentration (in the same units used for calibration) of the unknown analyte 
of interest

Amtunk(u) = the uncorrected amount of the unknown component

Sample Amtu= the amount of the unknown sample taken from the Sequence Table or 
Single Run dialog

MF = multiplication and dilution factors applied = M1*M2*M3/D1*D2*D3

Amtunk u( ) Areaunk( )∫=

Conc
Amtunk u( )

Sample Amtu
------------------------------- MF×=
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Internal Standards

Figure 56 is an example of an Internal Standard calculation, the ratio of component amount 
to Internal Standard amount is plotted on the X-Axis and the ratio of component area to 
Internal Standard area is plotted on the Y-Axis (Amount/Area Response Factor definition):

Figure 56. Internal Standard Calibration Curve

The calibration is calculated as:

where

Amt RatioISCal = amount ratio of the calibration standard 

ƒ = equation of the calibration points according to the fit type you have selected

Area RatioISCal = area ratio of the calibration standard

Therefore the unknown is determined by:

where

Amt Ratiounk(u) = the uncorrected amount ratio of the unknown component

ƒ = the equation of the calibration points according to the fit type you have selected

Area Ratiounk = the area ratio of the unknown component

Amt RatioISCal Area RatioISCal( )∫=

Amt Ratiounk u( ) Area Ratiounk( )∫=
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The concentration of the unknown sample is calculated by:

where

Concu = Concentration (in the same units used for calibration) of the analyte of interest

AmtIS = Amount of the internal standard

Sample Amtu = Amount of the unknown sample from sequence or at start of single run 

MF = multiplication and dilution factors applied = M1*M2*M3/D1*D2*D3 entered for 
the unknown sample

Amt Ratiounk = Amount ratio value taken from the calibration curve at the given area 
ratio for the unknown sample 

Determining Concentrations for Uncalibrated Peaks
You can report concentrations for uncalibrated peaks by creating an Uncalibrated Range 
group and assigning a Manual Response Factor for this range in the Group Table. Once you 
have done this, any uncalibrated peak that falls within this range will have its concentration 
calculated using this response factor, and included in a run report that has “unnamed peaks” 
selected. Note that you can define as many uncalibrated ranges as you want for a given 
method. 

Internal Standard Amounts
The Internal Standard Amounts for any calibration run is always taken from the method 
Peak Table. Any value for Internal Standard Amount in the Sequence table or in the 
Single Run Acquisition dialog for a calibration run is ignored. 

For an unknown run, the Internal Standard Amount is entered in the Single Run Acquisition 
dialog box, or in the Sequence Table. It is used as a multiplier in calculation of the unknown 
concentration. 

Internal standard components always have an RF value of 1.00. Normally a concentration is 
reported for internal standard components using the RF value.

To force the concentration of the internal standard component to be reported as zero (so it is 
not contribute to analyte concentration totals), enter a Manual RF value of zero for the 
internal standard components in the peak table.

Concu
AmtIS

Sample Amtu
------------------------------- MF Amt Ratiounk××=
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Calibration Curve Calculations
The calibration of a method results in the creation of a “calibration curve” for each calibrated 
component. The calibration curve equation is specified by the type of “fit” selected in the 
Peak Table, the definition of response factor for the method, whether it is an internal 
standard or external standard calibration, scaling factor selected, and weighting selected.

The “Uncorrected Amount” is the amount (or amount ratio) of a component represented by 
a given response (or response ratio). The term “Uncorrected Amount” is used because factors 
such as sample amount and multiplication factors have not been applied. 

The “Response Factor” for a component is calculated from the calibration curve. It can be 
reported as either Amount/Area or Area/Amount. This is selected as part of the 
Method > Properties tab.

Point-to-Point Fit

A point-to-point calibration fit connects a series of calibration points with lines. The result for 
point-to-point calculations is the same regardless of Response Factor definition. The equation 
for calculating the uncorrected amount is:

External Standard:

Y = Uncorrected Amount (With scaling factor applied, i.e. 1/x if applicable)

a = Slope of the calibration line segment 

X = Area or height value from Y-Axis

b = Y-Axis intercept of the calibration line segment

Internal Standard:

Y = Uncorrected Amount Ratio

a = Slope of the calibration line segment

b = Y-Axis intercept of the calibration line segment

Note  When a calibration contains replicates, the average of the replicates is calculated 
prior to the fit calculation.

Y aX b+=

X
Component Area or Height

Internal Standard Area or Height
-----------------------------------------------------------------------------=
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Linear Fit

A linear calibration fit determines the best line (linear regression) for a series of calibration 
points. A minimum of two calibration points is required to determine a linear fit. The 
equation for calculating the uncorrected amount is:

For Response Factor definition Area/Amount

External Standard:

Y = Component area or height

a = Slope of the calibration line

X = Uncorrected Amount (With scaling factor applied, i.e. 1/x if applicable)

b = Y-Axis intercept of the calibration line

Internal Standard:

a = Slope of the calibration line

X = Uncorrected Amount Ratio

b = Y-Axis intercept of the calibration line

Note  For points beyond the last calibration point, the line segment between the last two 
calibration points is extrapolated. If the value falls below the lowest calibration point, then 
the line segment is constructed between zero and the first calibration point

Y aX b+=

Y
Component Area or Height

Internal Standard Area or Height
-----------------------------------------------------------------------------=
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For Response Factor definition Amount/Area

External Standard:

Y = Uncorrected Amount (With scaling factor applied, i.e. 1/x if applicable)

a = Slope of the calibration line

X = Component area or height

b = Y-Axis intercept of the calibration line

Internal Standard: 

Y = Uncorrected Amount Ratio

a = Slope of the calibration line

b = Y-Axis intercept of the calibration line

Quadratic Fit

A quadratic calibration fit determines the best quadratic curve fit for a series of calibration 
points. A minimum of three calibration points is required to determine a quadratic fit. The 
equation for calculating the uncorrected amount is:

For Response Factor definition Area/Amount 

External Standard: 

Y = Uncorrected Amount (With scaling factor applied, i.e. 1/x if applicable)

a = Calibration Curve Coefficient

b = Calibration Curve Coefficient

c = Y-Axis intercept

X = Component area or height

X
Component Area or Height

Internal Standard Area or Height
-----------------------------------------------------------------------------=

Y aX2 bX c+ +=
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Internal Standard: 

Y = Uncorrected Amount Ratio

a = Calibration Curve Coefficient

b = Calibration Curve Coefficient

c = Y-Axis intercept

For Response Factor definition Amount/Area 

External Standard:

Y = Component area or height

a = Calibration Curve Coefficient

b = Calibration Curve Coefficient

c = Y-Axis intercept

X = Uncorrected Amount (With scaling factor applied, i.e. 1/x if applicable)

Internal Standard:

a = Calibration Curve Coefficient

b = Calibration Curve Coefficient

c = Y-Axis intercept

X = Uncorrected Amount Ratio 

X
Component Area or Height

Internal Standard Area or Height
-----------------------------------------------------------------------------=

Y
Component Area or Height

Internal Standard Area or Height
-----------------------------------------------------------------------------=
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Cubic Fit

A cubic calibration fit uses a least squares calculation to determine the best curve fit for a series 
of calibration points. A minimum of four calibration points is required to determine a cubic 
fit. The equation for calculating the uncorrected amount is:

External Standard:

Y = Uncorrected Amount (With scaling factor applied, i.e. 1/x if applicable)

a = Calibration Curve Coefficient

b = Calibration Curve Coefficient

c = Calibration Curve Coefficient

d = Y-Axis intercept

X = Component area or height

Internal Standard:

Y = Uncorrected Amount Ratio

a = Calibration Curve Coefficient

b = Calibration Curve Coefficient

c = Calibration Curve Coefficient

d = Y-Axis interceptt

Note  For cubic fits, only Response Factor definition of Area/Amount applies.

Y aX3 bX2 cX d+ + +=

X
Component Area or Height

Internal Standard Area or Height
-----------------------------------------------------------------------------=
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Modified Least Squares Calculation

The following modified least squares formula is used to determine the calibration curve 
coefficients for linear fits:

where

a = the slope of the calibration line

b = the Y-Axis intercept of the calibration linet

where X = Response or Amount. This is selected as the “Weighting Method” in the peak 
table.

For Internal Standard calculations, X is the uncorrected amount ratio of the component of 
interest in the calibration sample Cu.

For External Standard calculations, X is the uncorrected amount of the component of interest 
in the calibration sample Cu.

a
b

ΣWX ΣW

ΣWX2 ΣWX

1– ΣWY
ΣWXY

×=

W is the weighting term 1
X
--- or 1

X2------ or 1 if no weighting is used,=

Y is the corrected relative area peak area
int std area
-------------------------=

Y is the corrected relative area peak area=
Thermo Scientific ChromQuest Reference Guide 47



2 Equations and Calculations
Calibration Curve Calculations

48
The modified least squares calculation can be extended to higher order fits. As an example, the 
following formula is used to determine the calibration curve coefficients for weighted 
quadratic fits:

The following formula is used to determine the R-squared value for a series of values:

where

Y is an ordinate of the least squares line.

Yi is the observed value of Y.

a
b
c

WX2∑ WX∑ W∑
WX3∑ WX2∑ WX∑
WX4∑ WX3∑ WX2∑

1–
WY∑

WXY∑
WX2Y∑

×=

R2 1

Yi Ŷi–( )
i 1=

n

∑

Yi Y–( )
2

i 1=

n

∑
-------------------------------

2

–=

Y
ΣY

n----------=
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Matrix Operations

The following example illustrates the matrix operations used to determine curve coefficients 
for quadratic calibration curve fits. 

The equation for the quadratic calibration curve is:

For a series of amount/area pairs (x, y) representing calibration points (or averaged calibration 
points):

These points produce “n” quadratic equations, which can be solved for the coefficients a, b, 
and c by writing the equations in matrix notation as follows.

or,

To ensure a square matrix, the equation is multiplied by MT to become

where 

MT is matrix M transposed

then

If the curve is forced through zero, then c=0, and M becomes a 2-column matrix which is 
solved for coefficients a and b.

y ax2 bx c+ +=

x1 y1,( ) x2 y2,( ) x3 y3,( )..... xn yn,( )

y1

y2
:

yn

x1
2 x1 1

x2
2 x2 1
:

xn
2
:
xn

:
1

a
b
c

•=

Y M Z•=

MT Y MT M Z=

x1
2 x2

2 … xn
2

x1 x2 … xn

1 1 … 1

Z MT M( )
1–

MT Y=
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Average RF

If the Average RF fit type is selected, the slope of the calibration line between each calibration 
point and zero is calculated independently. These values (the Response Factors, or RFs) are 
then averaged to give an Average RF value. The Average RF is then used to calculate the 
uncorrected amount of the unknown component as follows:

where

Cu = Area/RF if Response Factor is set to Area/Amount

Cu = Area ∗ RF if Response Factor is set to Amount/Area

The slope of each calibration line is calculated as follows:

Cu = a Y

For an External Standard and Normalization:

Cu = Uncorrected Amount (With scaling factor applied, i.e. 1/x if applicable)

a = Slope of the calibration line segment

Y = Area or height value from Y-Axis

For an Internal Standard:

Cu = Uncorrected Amount Ratio

a = Slope of the calibration line segment

ConcUnknown Average RF( ) ∗ AreaUnknown=

Y Component Area or Height
Internal Standard Area or Height
-----------------------------------------------------------------------------=
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Weighting and Scaling

There are a number ways to do averaging and weighting in ChromQuest. The following table 
summarizes the differences between these selections.

Calibration Averages

The Replace/Wt Average Calib Flags in the Peak Table allow you to select whether or not 
calibration the calibration area is averaged with previous replicates (Last Area). In general, 
when Replace is selected, the current calibration area replaces any existing calibration area or 
averaged area in the method. When WtAverage is selected, replicates are averaged, and then 
weighted with the Last Area value (if applicable).

• For External Standard calibrations:

When Wt Average is selected, the current peak area/height replicates are averaged. When 
Replace is selected, each calibration run replaces the previous value in the method.

• For Internal Standard calibrations:

When Wt Average is selected, the individual replicate ratios are calculated first, then the 
average of the ratios is taken. When Replace is selected, each calibration run replaces the 
previous value in the method. 

Selection Located In Effect or Use

Calib Flag 
(Replace/WtAverage)

Peak Table If Replace, each new calibration area replaces 
previous calibration area in the method. If 
WtAverage, replicates is averaged. Weighted 
average using Calib Weight is calculated if 
method contains a Last Area. If Auto 
Averaging is also ON, calibration replicates 
is cleared when the level is re-calibrated. 

Calib Weight 
(Value)

Peak Table A weighting factor used to calculate a 
weighted calibration average of current 
replicates with method Last Area. 

Scaling Peak Table Applied to amounts prior to creating 
calibration curve for a peak, for purpose of 
creating a relationship between area and 
amounts that can be approximated by a 
polynomial fit.

Weighting Method Peak Table LSQ Weighting Method to be used for 
calculation of least squares regression fits. 
Generally gives more importance to points 
representing smaller areas and amounts. 
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For example, for a calibration component area, U, and its associated internal standard 
component area, I, the average ratio, Y, for three replicates is calculated as follows:

Ratio 1 210 / 100 = 2.1

Ratio 2 215 / 99 = 2.172

Ratio 3 212 / 104 = 2.039

Y = Average Ratio = 2.104

If averaging, replicates for each peak level are saved in the method until they are cleared. 
Replicate 1 is the most recent replicate. 

Automatic Averaging

When you have the Automatic Averaging turned On for your method (in Method 
Properties), averaging takes place for all peaks designated with the WtAverage flag in the peak 
table. Replicates continues to save in the method until a new level is calibrated for the 
method. When a new level is encountered, the replicates for the previous level is cleared, and 
the average at that point is saved in the method as “Last Area”. 

If you want replicate areas to be continuously saved in the method, whether or not a new level 
is encountered, turn the Automatic Averaging OFF. You must then designate in your 
sequence where you want averaging to take place by designating “Average Replicates” in the 
Run Type of the sample. 

Internal Standard Replicate Area (In) Component Replicate Area (Un)

I1 = 100 U1 = 210

I2 = 99 U2 = 215

I3 = 104 U3 = 212

Note  In the Review Peak Calibration window, if you eliminate a replicate from the 
calibration curve of an internal standard peak by highlighting it with the mouse, and then 
the associated replicates for peaks using that internal standard are ignored when 
calculating the average ratio.
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Calib Weight

You can designate a “Calib Weight” in the Peak Table for the average of the replicates with 
the method Last Area. Note that a Calib Weight of 100 causes the Last Area value to be 
ignored. 

A weighted average is calculated in ChromQuest using the following equation:

where

Aw is the weighted average result

Xc is the true average of replicates (if any) with current run area/height

W is the Calib Weight / 100

Xo is the “Last area” from the method

A weighted average is calculated for the following method as follows:

Method “Last Area” 100

Current run area 101

Replicate 1 104

Replicate 2 100

Replicate 3 102

Using a Calib Weight of 60, the weighted average becomes:

Enter a weight factor of 50 to give equal weight to the “Last Area” average and the new 
calibration replicates. 

Note  For Internal Standard calibrations, each replicate represents a ratio of the 
component area/height to internal standard area/height.

Aw Xc ∗ W( ) Xo ∗ 1 W–( )[ ]+=

101 104 100 102+ + +( ) 4⁄[ ] ∗ .6 100 ∗ 1 .6–( )[ ]+
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Scaling

This parameter allows you to apply a scaling factor to the calibration curve. This factor is 
applied to the entered amounts prior to computing the calibration curve. The purpose of 
using a scaling factor is to create a relationship between areas (or heights) and amounts that 
can be approximated by a polynomial fit. A scaling factor can be applied to any fit type. The 
available scaling operations are:

• None

• 1/X

• 1/X2

• ln[X]

• 1/ln[X]

• sqrt[X]

• x2

Weighting Method (LSQ Weight)

Selecting a LSQ Weighting Method to be used for calculation of least squares regression fits, 
either 1/x or 1/x2 gives increased importance to smaller concentrations and areas. LSQ 
Weight can be applied to linear, quadratic, and cubic fits only. The following figures are 
examples of LSQ weighting.

Figure 57. Linear fit with No LSQ Weighting
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Figure 58. Linear Fit with 1/x LSQ Weighting

Figure 59. Linear Fit with 1/X2 LSQ Weighting

Report Calculations
The following calculations are used to determine the concentrations reported.

Area % Report

Area% Area of peak ∗ 100
Sum of all peak areas
------------------------------------------------=
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Normalization Report

where

Conc = Corrected Amount of component

Cu = Uncorrected Amount of component

SumCR = Sum of calibrated range groups

External Standard Report

where

Conc = Corrected Amount of component.

Cu = Amount value from calibration curve for a given unknown area

Samp. Amt. = Sample amount 

MF = multiplication and dilution factors applied = M1*M2*M3/D1*D2*D3

Internal Standard Report

where

Conc = Corrected Amount of component

ISTDu = Amount of Internal Standard 

Sample Amt. = Sample amount

MF = multiplication and dilution factors applied = M1*M2*M3/D1*D2*D3

Cu = Amount ratio taken from the calibration curve for the given area/height ratio

Conc
Cu ∗ 100

Sum of Cu for named peaks SumCR+
----------------------------------------------------------------------------------------=

Conc
Cu

Samp. Amt
-------------------------- ∗ MF=

Conc
Cu

Sample Amt.( )
----------------------------------- ∗ ISTDu ∗ MF=
ChromQuest Reference Guide Thermo Scientific



 2 Equations and Calculations
Performance Calculations
Performance Calculations
ChromQuest calculates the following values that can be used to assess overall system 
performance:

• Relative Retention

• Theoretical Plates

• Capacity Factor

• Resolution

• Peak Asymmetry

• Plates per Meter

These values can be included in a custom report. 

Figure 60 shows the parameters used to calculate these system performance values for the 
separation of two chromatographic components.

Figure 60. Separation of Two Chromatographic Components

Note  To accurately calculate suitability values, the sampling frequency (set in Acquisition 
Setup) must be set to provide at least 20 data points for the narrowest peak of interest.

ta

t1

t2

W1 W2

Time

Injection

Unretained peak
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Relative Retention (Selectivity)

where

α = Relative retention.

t2= The retention time measured from point of injection

ta = The retention time of an inert component not retained by the column, taken from 
“Unretained Peak Time” in the Performance Options section of the method.

t1 = The retention time from point of injection for reference peak defined in the peak 
table. If no reference peak is found, this value becomes zero.

Capacity Factor (k’)

where

k' = Capacity Factor

t2 = The retention time measured from point of injection

ta = The retention time of an inert component not retained by the column, taken from 
“Unretained Peak Time” in the Performance Options section of the method.

Plates/Meter

where

N = Plates per meter

n = Theoretical plates in the column

L = Column length, in meters. This value is taken from the Performance Options 
section of the method.

α
t2 ta–
t1 ta–
--------------=

k′
t2
ta
---- 1–=

N n
L
---=
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Noise Test (rms noise)

The rms noise is the standard deviation of the signal derived from n measurements.

where 

Ei = individual voltage readings 

Drift Test

The drift test measures the change in voltage over a given period.

where

y2 = voltage (μv) at time x2 (drift test start time in minutes)

y1 = voltage (μv) at time x1 (drift test stop time in minutes)

USP (United States Pharmacopia) Calculation Method

Theoretical Plates

where

n = theoretical plates

t = The retention time of the component

W = The width of the base of the component peak using tangent method.

rms noise
Ei E–( )2

i 1=

n

∑
n 1–

-------------------------------

1 2⁄

=

E = the average of n measurements

drift
y2 y1–
x2 x1–
----------------=

n 16 t
W
-----⎝ ⎠

⎛ ⎞ 2
=
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Peak Asymmetry (Tailing Factor)

where

T = Peak asymmetry, or tailing factor

W0.05 = The distance from the leading edge to the tailing edge of the peak, measured at a 
point 5% of the peak height from the baseline

f = The distance from the peak maximum to the leading edge of the peak at the position 
of 5% peak height

Figure 61. Asymmetric Peak

Resolution

where

R = Resolution between a peak of interest (peak 2) and the peak preceding it (peak 1)

t2 = The retention time measured from point of injection of peak 2

t1 = The retention time measured from point of injection of peak 1

W2 = The width of the base of the component peak 2

W1 = The width of the base of the component peak 1

Note  For peak asymmetry at 10%, the values for W and f are measured at 10% of 
peak height.

T
W0.05

2f
-------------=

W
f

0.05 0.05h

hPeak
front

Peak
tail

Peak maximum

R
2 t2 t1–( )
W2 W1+
----------------------=
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EMG (Exponential Modified Gaussian) Calculation Method

Theoretical Plates

where

N = The number of theoretical plates

t = The retention time of the component

W0.1 = The width of the peak at the position of 10% peak height

a0.1 = The width of the first half (start to top) of peak at the position of 10% peak height

b0.1 = The width of the second half (top to end) of peak at the position of 10% of peak 
height

Peak Asymmetry (Tailing Factor)

where

T = Peak asymmetry, or tailing factor

W0.05 = The distance from the leading edge to the tailing edge of the peak, measured at a 
point 5% of the peak height from the baseline

f = The distance from the peak maximum to the leading edge of the peak at the position 
of 5% peak height

Note  For peak asymmetry at 10%, the values for W and f are measured at 10% of 
peak height.

N 41.7

t
W0.1
-----------

2

b0.1
a0.1
-------- 1.25+
-------------------------×=

T
W0.05

2f
-------------=
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Resolution

where

R = Resolution between a peak of interest (peak 2) and the peak preceding it (peak 1)

t2 = The retention time measured from point of injection of peak 2

t1 = The retention time measured from point of injection of peak 1

W0.1 = The width of peak at the position of 10% peak height

Wp0.1 = The width of previous peak at the position of 10% peak height

DAB (German Pharmacopia) Calculation Method

Theoretical Plates

where

N = Theoretical plates

t = The retention time of the component

W0.5 = Width of peak at the position of 50% peak height

R 2.15
t2 t1–( )

W0.1 Wp0.1+
-------------------------------×=

Note  This calculation equation is also called the BP (British Pharmacopia), EP (European 
Pharmacopia), and ASTM.

N 5.54 t
W0.5
-----------×

2
=
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Peak Asymmetry (Tailing Factor)

where

T = Peak asymmetry, or tailing factor

W0.05 = The distance from the leading edge to the tailing edge of the peak, measured at a 
point 5% of the peak height from the baseline

f = The distance from the peak maximum to the leading edge of the peak at the position 
of 5% peak height

Resolution

where

R = Resolution between a peak of interest (peak 2) and the peak preceding it (peak 1)

t2 = The retention time measured from point of injection of peak 2

t1 = The retention time measured from point of injection of peak 1

W0.5 = The width of the component peak at 50 % peak height

Wp0.5 = The width of the previous component peak at 50 % peak height

Japanese Pharmacopoeia (JP) Calculation Method

Theoretical Plates

where

N = Theoretical plates

t = The retention time of the component

W0.5 = Width of peak at the position of 50% peak height

Note  For peak asymmetry at 10%, the values for W and f are measured at 10% of 
peak height.

T
W0.05

2f
-------------=

R 1.18
t2 t1–( )

W0.5 Wp0.5+
-------------------------------×=

N 5.55
t

W0.5
-----------×

2

=
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Peak Asymmetry (Tailing Factor)

where

T = Peak asymmetry, or tailing factor

W0.05 = The distance from the leading edge to the tailing edge of the peak, measured at a 
point 5% of the peak height from the baseline

f = The distance from the peak maximum to the leading edge of the peak at the position 
of 5% peak height

Resolution

where

R = Resolution between a peak of interest (peak 2) and the peak preceding it (peak 1)

t2 = The retention time measured from point of injection of peak 2

t1 = The retention time measured from point of injection of peak 1

W0.5 = The width of the component peak at 50 % peak height

Wp0.5 = The width of the previous component peak at 50 % peak height

Note  For peak asymmetry at 10%, the values for W and f are measured at 10% of 
peak height.

T
W0.05

2f
-------------=

R 1.18
t2 t1–( )

W0.5 Wp0.5+
-------------------------------×=
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Area/Height Calculation Method

Theoretical Plates

where

N = theoretical plates

t = The retention time of the component

W = The width of the base of the component peak.

W = 4 × σ

where

A= Peak area

H= Peak height

Peak Asymmetry (Tailing Factor)

where

T = Peak asymmetry, or tailing factor

W0.05 = The distance from the leading edge to the tailing edge of the peak, measured at a 
point 5% of the peak height from the baseline

f = The distance from the peak maximum to the leading edge of the peak at the position 
of 5% peak height

Note  For peak asymmetry at 10%, the values for W and f are measured at 10% of 
peak height.

N 16 t
W
-----

2
×=

σ
1
2π
---------- A

H
----×=

0.399 A
H
----×=

T
W0.05

2f
-------------=
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Resolution

where

R = Resolution between a peak of interest (peak 2) and the peak preceding it (peak 1)

t2 = The retention time measured from point of injection of peak 2

t1 = The retention time measured from point of injection of peak 1

W2 = The width of the base of the component peak 2

W1 = The width of the base of the component peak 1

6-Sigma rms Noise Method 

where

Peak Height = the standard peak height determined during integration.

Noise = the standard deviation of the signal derived from n measurements.

where 

Ei = data point 

f ( Ei ) = the point on the linear regression line of all the data points.

The n measurements are made between the time limits entered.

R
2 t2 t1–( )
W2 W1+
----------------------=

Signal-to-Noise Peak Height
rms Noise
---------------------------=

Noise 6
E i Ei( )∫–( )

2

i 1=

n

∑

n 1–
----------------------------------------

×

1 2⁄

=
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ASTM LOD (Limit of Detection) Calculation

This is a per peak result. The purpose of an LOD parameter is to determine whether the peak 
being evaluated is within the Limits of Detection as previously determined experimentally for 
that Method.

where 

SN = S/N ratio for LOD entered in Peak Table

SNM = Calculated S/N ratio

H = Peak height

ND = Measured noise level

C = Concentration result of peak being evaluated

ASTM LOQ (Limit of Quantitation) 

This is a per peak result and should calculated and report as such. The purpose of a LOQ 
parameter is to determine is the peak being evaluated is within the Limits of Quantitation as 
previously determined experimentally for that Method.

where

SN = S/N ratio for LOQ entered in Peak Table

SNM = Calculated S/N ratio

H = Peak height at concentration C

ND = Measured noise level

C = Concentration result of peak being evaluated

SNM H ND⁄=

LOD C ∗ SN SN⁄ M=

SN H ND⁄=

LOQ C ∗ SN SN⁄ M=
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Savitsky-Golay Smoothing

A 9-point digital filter is applied as a sliding filter to the data points as shown in the following 
example for data points a1 through a3.

where 

a1….ax = the data points

f1…fx = the filtering factors

norm = the normalization factor. The filtering factors and normalization factor are given 
below.

f0: -21

f1: 14

f2: 39

f3: 54

f4: 59

f5: 54

f6: 39

f7: 14

f8: -21

The normalization factor is 231.0.

a1f1 a2f2 …a9f9+ +
norm

----------------------------------------------
a2f1 a3f2 …a10f9+ +

norm
------------------------------------------------ ,

a3f1 a4f2 …a11f9+ +
norm

------------------------------------------------,
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User Programs and Custom Parameters

User Programs and Custom Parameters are available to provide a seamless link between 
ChromQuest and user-provided programs that do specific calculations and applications that 
may be required by the laboratory.

User Programs
User Programs are programs that are run before an acquisition, or before or after an analysis. 
These programs are meant to synchronize actions between ChromQuest and an instrument or 
another data processing program you may be running. A User Program may be an executable 
(.EXE) or a dynamic link library (.DLL) file. 

Because ChromQuest runs in the Windows 2000/Windows XP environment, if the User 
Program is an executable (.exe) program, the program is launched by ChromQuest, and 
ChromQuest waits until the program is finished. No data is passed to an executable program. 

If the User Program is a .DLL, it has access to all data and parameters of ChromQuest. This is 
the recommended method for User Programs. A User Program .DLL should implement the 
“RunUserProg” function. 

Custom Parameter Programs
Custom Parameters are used to calculate specific values that are of interest to you, but are not 
normally calculated by ChromQuest. This feature gives you access to the entire database of 
named and detected peaks for a ChromQuest application (Method Development, 
Instrument 1, etc.). Custom parameters programs are called after all other analysis is finished.

Because ChromQuest runs in the Windows 2000/Windows XP environment, the Custom 
Parameter Program must be a .DLL, and should implement the “EvaluateCustomParam” 
function. Custom Parameter .DLL’s have access to all data and parameters of ChromQuest. 

Contents

• User Programs

• Custom Parameter Programs
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Data and Graphics Export

ChromQuest allows you to export a wide variety of information for use in other applications. 
Data export involves two steps. First, you must choose what information you want to export 
and assign a destination for the exported data. Second, you must turn on the data export 
option in your method so that the data is exported as the method is used.

Contents

• Data Export

• Automatic Export to Microsoft Excel

• ODBC Export to Microsoft Access 

• Graphics Export
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Data Export
The Method > Advanced Method Options > Export function allows you to save results 
automatically in an ASCII file after each analysis is completed. You select the type of data to 
export: Peaks, Groups, Standard Reports, or Chromatogram. For Peaks and Groups, you can 
choose the parameters you want to export. When you export Standard Reports, only the 
contents of the report is exported.

When you choose the Method > Advanced > Export tab, a dialog box appears. You then 
select what type of data export you want.

Figure 62.  Advanced Method Options dialog box
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Export Enabled

Select the Export Enabled checkbox to turn data export on for the method. While this option 
is enabled, data export occurs after each Analysis of the data. Since the export of data occurs 
when the data is analyzed automatically at the end of a run and each time the data is manually 
analyzed, you should turn this option off while you are developing methods.

Select the type of information to export from the drop-down list. For each type of export 
chosen, you can select parameters for export. If you have defined any Custom Parameters, 
they appear in the appropriate list of items you can choose to export.

Exporting Peaks

When you select Peaks to be exported, a list of available peak export parameters is displayed. 
Select a parameter for export by double-clicking on it, or clicking on it to highlight it, then 
click the Green (Top) arrow button to move it to the list of export items in the right-hand 
box. To remove an item from the export box, highlight it, and then click the Red (bottom) 
arrow button.

Exporting Groups 

If you select Groups for export, a list of group parameters is presented in the left-hand box. 
To select an item for export, double-click it, or click it to highlight it, then click the Green 
(Top) arrow. To remove an item from the export list, highlight it, and then click the Red 
(Bottom) arrow.

Exporting Standard Reports

When you choose to export Standard Reports, a list of available standard reports is displayed. 
Choose a report to export by double-clicking it, or highlighting it with the mouse, then 
clicking the Green (Top) arrow button.

Exporting Chromatograms

If you select Chromatograms to be exported, you are given the option to export in either/or 
AIA (*.CDF) file format, or in ASCII format.

Selecting the AIA option causes ChromQuest to create a *.CDF (Chromatograph Data File) 
in the standard format specified by the Analytical Instrument Association (AIA). AIA Level 2 
file export is supported. This includes the raw chromatogram, and integration results. This is 
also called ANDI file format (Analytical Data Exchange). This allows ChromQuest results to 
be read by other chromatography data systems.

Note  AIA Level 2 support is for export only. Import of AIA files is supported only at 
Level 1 (raw data).
Thermo Scientific ChromQuest Reference Guide 73



4 Data and Graphics Export
Data Export

74
Export Options

• Field Separator

Select the type of separator you want to include between data fields in your export file. 
Choices include Tab, Space, and Comma. Your choice is determined by what you wish to 
do with your exported file. If you want to import the file into a Microsoft Excel 
spreadsheet, for example, choose Tab.

• Path for export files

Enter a path name for the directory where you want to save your export files. If you do 
not know the name of the directory, you can select it from existing paths by clicking the 
File button adjacent to the field.

ODBC Enabled

Select this box if you want to use ODBC format for your data export. Open Database 
Connectivity (ODBC) is an industry-standard method of sharing data between databases and 
other programs. ODBC drivers use the standard Structured Query Language (SQL) to gain 
access to data. 

Data source name

Enter the name of the database you are using. To select the name from a list of available 
sources, click Open. The SQL Data Sources dialog box appears where you can select the data 
source for your export.

Figure 63. SQL Data Sources dialog box

To create a new data source, click New. The Add Data Source dialog box appears.

Note  Microsoft Data Access Components (MDAC) 2.5 or higher is required for ODBC 
export. A version of this is on the ChromQuest CD-ROM under \Updates.
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Figure 64.  Add Data Sources dialog box

Table name

Enter the name of the table you wish to use for your data export.

Export Files

Data exported using ChromQuest are saved in files using the following conventions.

Peak and Group Export Files

For each parameter selected, a file is created containing that value for each named peak, along 
with file and method name information. Each time the method is used to acquire or process 
data, a row is appended to the file containing the new calculated value for that file. Each file is 
saved with the method name, with an extension representing the type of value selected. For 
example, Figure 65 is an example of a file created for export of area for five runs.

Figure 65. Export file

Note  If you export data as part of a sequence, and you want to view the export file in 
another application while data is being acquired, you must make a copy of the file and 
save it with another name before you use it. Otherwise, a file sharing violation might 
occur when ChromQuest tries to update the file with data from a new run.
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Standard Report Export Files

When you select a Standard Report option, a file is created each time an analysis is run. The 
file contains the information in the selected report.

Unlike peak and group export, Standard Report Export files are not appended with 
information from additional runs. Each time the method is used for acquisition or processing, 
a new file is created. The new file name is based on the data filename and it uses the export 
extension given below for the type of export data selected.

Figure 66 shows an example of a file created for Standard Export of an External Standard 
report.

Figure 66. Standard Export of an External Standard report
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ChromQuest automatically names the files used to save exported data. Each data export 
option uses a specific file naming convention, as follows. 

Peak and Group Parameter Export Files

Filename = [method name]-[channel name].[short parameter name]

Example: 

 Method Name - multi level.met

 Data File - calib std 3.dat

 Channel - TCD

Custom Export Option Custom Export Filename

(Uses the method filename followed by the extension.)

Retention Time multi level-tcd.apex

Area multi level-tcd.area

Area % multi level-tcd.areaperc

Height multi level-tcd.height

Height % multi level-tcd.heightperc

ESTD multi level-tcd.estdconc

ISTD multi level-tcd.istdconc

NORM multi level-tcd.normconc

Width multi level-tcd.width

Relative RT multi level-tcd.relativert

Theoretical Plates multi level-tcd.TPlates

Plates / Meter multi level-tcd.TPlatesPerMeter

Capacity Factor multi level-tcd.capacity 

Resolution multi level-tcd.resolution

Peak Asymmetry multi level-tcd.asymmetry

Custom Parameters multi level-tcd.custom parameter1..x

Note  For Group export files, the file naming convention is as described above, except that 
each file begins with a "G". In the example above, the group export file for NORM 
becomes Gmulti level-tcd.normconc.
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Standard Report Export Files

Filename = [data file name][data file extension]-[channel name].[data type]

Example: 

 Method Name - multi level.met

 Data File - calib std 3.dat

 Channel - TCD

The following is an example of the format for an exported chromatogram file. The numbers 
at the end of the file are the individual data points from the chromatogram, with channel 1 
data first, followed in order by data from additional channels if present.

Figure 67. Format for an exported chromatogram file

The format for ASCII data files to be imported into ChromQuest must follow the example 
shown above. If data from more than one channel are involved, they are appended to the 
string. In this example, channel B starts at data point 2649.

Standard Export Option Standard Export Filename

(Uses the data filename followed by the extension.)

Area% calib std 3 dat-tcd.are

ESTD calib std 3 dat-tcd.ESD

ISTD calib std 3 dat-tcd.ISD

NORM calib std 3 dat-tcd.NOM

Performance calib std 3 dat-tcd.PER

Chromatogram Export

AIA calib std 3 dat-tcd.CDF

ASCII calib std 3.dat.ASC
ChromQuest Reference Guide Thermo Scientific



 4 Data and Graphics Export
Automatic Export to Microsoft Excel
Automatic Export to Microsoft Excel
ChromQuest provides a user program, ExcelExport.dll that can be used to open a 
user-supplied Excel worksheet and run a user-supplied macro within that worksheet. The 
macro can be written by the user to open an exported file from ChromQuest and perform 
operations on the content. To set up and use this program, follow the directions outlined 
below.

Select Parameters to Export

Select the parameters to export by choosing the Method > Advanced Method Options 
command, and then the Data Export tab. Make sure the Export Enabled checkbox is 
selected, and then designate the parameters you want to export by double-clicking on each 
desired parameter listed in the left-hand box. The selected parameters appears in the 
right-hand box.

The Field Separator must be set to Tab, and the Path for export files must contain a valid 
path. Figure 68 shows an example for exporting “Area” and “Area Percent” parameters.

Figure 68. Data Export page of the Advanced Method Options dialog box
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Set up Excel Export User Program

Next, you must set up the user program to run. From the Advanced Method Options dialog 
box, select the Files tab. Select the After analysis box, then select the ExcelExport.dll 
program. The ExcelExport.dll is located in the ChromQuest program folder.

The Additional Parameters field must contain entries that specify the following items (in the 
order specified), each in quotation marks, separated by a comma:

• Path of exported ChromQuest data

• Parameter Name

• Excel Macro File

• Excel Macro Name

Figure 69. Files page of the Advanced Method Options dialog box
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Figure 70. Location of ExcelExport.dll file

The Parameter Name entry may be repeated to specify additional parameters. All parameters 
must be enclosed in quotes, and must be separated by spaces and/or commas. For example, to 
export “Area” and “Area Percent” from the C:\ChromQuest\Export directory, and then run 
the “FormatData” macro from the C:\excel\xlstart\personal.xls spreadsheet, the entry would 
look like the following:

“C:\ChromQuest\export”,”Area”,”AreaPerc”,”C:\excel\xlstart\personal.xls”,”Form atData”

The data is organized in excel as follows: each parameter is in a separate Excel workbook and 
each wavelength channel of a parameter is in a separate sheet of a workbook.

Note  The names of the parameters are not the same as the names shown on the Export 
tab. Instead, the names used must be the same as the name used for the file extension for 
the exported parameter file. For example, “Area Percent” becomes “AreaPerc”. For a list of 
these file extensions see File Extensions Used for Data Export in help or in the “File 
Extensions Used for Data Export” on page 77 of the manual.
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ODBC Export to Microsoft Access
To export data to a Microsoft Access database

1. Install Microsoft Access on your Windows 2000/XP Server.

2. Update the Data Access components drivers on your Server by running the mdac_typ.exe, 
which is located in the Updates\MDAC directory on the ChromQuest CD-ROM. 

3. On the Server, open Microsoft Access.

4. Create a new database: 

a. Select the Blank Database option button, then click OK to open the File New 
Database dialog box.

Figure 71.  Microsoft Access dialog box

Note  Microsoft Data Access Components (MDAC) 2.5 or higher is required for ODBC 
export. A version of this is on the ChromQuest CD-ROM under Updates.
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Figure 72.  File New Database dialog box

Access automatically creates a database file named db*.mdb, but you can enter your 
own database name if you prefer. 

b. In the File New Database dialog box, click Create. 

Access creates a new blank database and display the following screen.

Figure 73. Microsoft Access – Blank database window

c. Close the new database and exit Microsoft Access.

5. On the Server, set up the ODBC protocol:

a. From the Control Panel, double-click the 32bitODBC icon to open the ODBC 
Data Source Administrator.
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Figure 74. Control Panel window

b. From the ODBC Data Source Administrator dialog box, click the System Data 
Source Name (DSN) tab.

Figure 75. ODBC Data Source Administrator – System DSN dialog box

c. In the System DSN page, click Add to open the Create New Data Source dialog box.

d. From the Create New Data Source list box, select the Microsoft Access Driver. Then, 
click Finish.
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The ODBC Microsoft Access Setup dialog box opens.

Figure 76. Create New Data Source dialog box

e. In the ODBC Microsoft Access Setup dialog box, type a unique Data Source Name 
in the Data Source Name text box.

Figure 77. ODBC Microsoft Access 97 Setup dialog box
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f. Click Select to open the Select Database dialog box.

Figure 78. ODBC Microsoft Access 97 Setup dialog box

g. In the Select Database dialog box, select the .mdb file that you created earlier. Then, 
click OK to return to the ODBC Microsoft Access Setup dialog box.

Figure 79. Select Database dialog box
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h. Enter a description, if desired, (helpful for later use), and click OK to return to the 
System DSN page of the set up.

Figure 80. ODBC Microsoft Access 97 Setup dialog box

Figure 81. ODBC Data Source Administrator dialog box

The New System Data source has now been created, and appears in the list of System 
Data Sources in the System DSN page.

i. In the System DSN page, click OK to exit the ODBC setup on the Server.
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6. On the client PC, launch ChromQuest. Then, open the instrument that is networked to 
the above Server.

7. Create a method that exports data to Microsoft Access:

a. From the Instrument window, choose Method > Peaks/Groups and ensure that the 
method has a peak table.

b. Choose Method > Advanced, and then click the Data Export tab.

c. In the Export page, select the Export Enabled checkbox.

d. Select your export parameters.

e. In the Path for Export Files list box, browse to the appropriate directory on your 
Server. The Server name is listed in the Instrument Configuration.

f. Select the Enable ODBC checkbox.

g. Select the Data Source Name that you created on the Server in step 5.

h. Type a name in the Table Name text box where you want the export parameters to be 
entered. 

If this table does not exist in your database, it is created during export. For details, see 
the “ODBC Export to Microsoft Access” on page 82 and Help. 
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Figure 82. Data Export page of the Advanced Method Options dialog box

Once you save the method, each time you analyze a data file using this method, the 
parameters specified is automatically exported to your Access database.

8. To view the exported parameters after the data file has been analyzed:

a. Open Microsoft Access.

b. Use Explorer to locate the appropriate folder.

c. Locate the *.mdb file you selected for Data Source Name. (In the above example, this 
is db4.mdb, associated with Data Source Name Hank 2.)

d. Open this database file.
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Figure 83. Microsoft Access – Database window

A list of existing tables in your database appears. In Figure 83, Hank4 was the table 
name used to export parameters.

e. Select the appropriate table, and then click Open to view the exported parameters.

Figure 84. Microsoft Access – Table window
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Graphics Export
Graphics export is a new feature provided in ChromQuest 5.0. Using this feature, you can 
export images of 

To export graphics

1. In the Instrument window, choose Method > Advanced. Then click the Graphics 
Export tab.

2. The Graphics Export page appears. See Figure 85.

Figure 85. Graphics Export page of the Advanced Method Options dialog box
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3. Select the traces to be exported as WMF files each time a data file is analyzed with the 
method.

a. In the spreadsheet, select the Export check box and then type the filename to be used 
for the export.

b. Follow the instructions below the spreadsheet. 

The graphics window displays the current graphic for export.  To change the graphic, 
right-click the window and make a selection from the shortcut menu.

4. Select the path to be used for export of the graphics file. 

ChromQuest saves the  exported graphics with the file name <Data file name> + “ _ “ + 
<Export Name> + “.wmf”. See Figure 86.

Figure 86. Viewing the WMF file
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ASCII Sequence File Format

An ASCII sequence suitable for importing into ChromQuest consists of lines of text (each 
line terminated with a newline character). The first line of the text file must be: “ASCII 
Sequence n” where n is the version number of the ASCII sequence. Currently, this number 
must be set to “1” (one), so the first line of the file should be “ASCII Sequence 1”.

Contents

• Sequence Header

• Sequence Records

• Action Record

• Example of ASCII Sequence File

• Example of ASCII Dual Tower Sequence File
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Sequence Header
The next part of the text file contains sequence “header” information of the form:

<keyword>=<value>

For example:

DATAPATH=C:\CHROMQUEST\DATA

The following keywords are recognized as elements of the sequence header (Keywords are case 
sensitive and should be typed as shown below):

CREATIONDATE=

LASTCHANGEDATE=

METHODPATH= (128 characters maximum)

PRINTREPORTS= (YES or NO)

DATAPATH= (128 characters maximum)

PRETREATPATH= (128 characters maximum)

SUMMARYPATH= (128 characters maximum)

DESCRIPTION=

None of these keywords are mandatory; if a keyword does not exist in the text file, a default 
value is used.
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After all sequence header elements have been specified, the rest of the text file consists of lines 
specifying the records of the sequence table. 

Record Elements

The records contain comma-delimited elements detailing the operation of that line of the 
sequence. These lines are of the form:

RECORD = a,b,c,d,e,f,g,h,i,j,k,l,m,n,o,p

where

a = Sample ID (63 characters maximum)

b = Method name (63 characters maximum)

c = File name (63 characters maximum)

d = Calibration level (0 - x, 0 = no calibration)

e = Sample amount (real number > 0)

f = Internal standard amount (real number > 0)

g = Dilution factor (a.k.a. "Mult."; real number > 0)

h = Injection vial

i = Injection volume

j = Pretreatment file name 

k = Fraction collector file name 

l = Reserved; do not specify anything between the commas

m = Run type (see “Run Types” on page 96)

n = Action (Leave blank. Not used in ChromQuest)

o = Run description 

p = Repetitions per vial (1 - 9)

Note  If you wish to use a delimiter other than the comma, set the List Separator field in 
the International settings in the Control Panel to the character that you wish to use. This 
setting is consulted before the ASCII sequence is read in. You may only specify a single 
character, such as the semicolon or the dash. You may use the space or tab character, but 
remember that any character that is used for the separator can not be recognized as a 
record element.
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Run Types

Decimal Hex  Name

4 0x0000004 UnSpiked

8 0x0000008 Spiked

16 0x0000010 Spike 1 of 2

32 0x0000020 Spike 2 of 2

64 0x0000040 Duplicate 1

128 0x0000080 Duplicate 2

256 0x0000100 System Suit Start

512 0x0000200 System Suit End

1024 0x0000400 System Suit Std.

2048 0x0000800 Shutdown

4096 0x0001000 Begin Calibration

8192 0x0002000 End Calibration

16384 0x0004000 QC Standard

32768 0x0008000 Summary Start

65536 0x0010000 Summary End

131072 0x0020000 Summary Run

262144 0x0040000 Clear All Response Factors

524288 0x0080000 Clear Response Factors for this Level

1048576 0x0100000 Print Response Factors

2097152 0x0200000 Average Replicates

4194304 0x0400000 Clear Replicates

8388608 0x0800000 Begin Loop

16777216 0x1000000 End Loop
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Action records relate to the previous Sequence Record only. Form:

ACTION=a,b,c,d,e

where

a = CONDITION:
0 Any Condition
1 Calibration
2 QC
3 System Suitability
4 Hardware Status
5 Conc. Limit

b = RESULT:
0 Pass
1 Fail
2 Below Limit
3 Above Limit

c = ACTION:
0 Abort
1 Pause
2 Reinject
3 Run User Program
4 Run Shutdown
5 Alarm
6 Goto
7 Restart System Suit

d = PARAMETER 1:

For Reinject and Goto - Rep Count
For Run User Program - Program Path and Name

e = PARAMETER 2:

For Goto - Goto Record Number

Note  Regarding method name, file name, pretreat name and fraction collector file name: 
If these items do not have path names embedded, the appropriate path from the header 
used (fraction collector files are assumed to reside in the pretreatment file path). All 
elements of the record line MUST be present; however, any record element not of interest 
can be skipped by specifying nothing in-between the commas. If you are creating the 
ASCII file using Microsoft Excel, save the file in the *.CSV format. Sample ID must be in 
the same cell as RECORD= to prevent a comma after the (=). Method and data paths 
must be selected manually using Sequence Properties because the .CSV adds a comma to 
the path.
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Example of ASCII Sequence File
The following is an example of an ASCII Sequence file:

ASCII Sequence 1

CREATIONDATE=

LASTCHANGEDDATE=

METHODPATH= D:\System\Methods

PRINTREPORTS= NO

DATAPATH= D:\System\data

PRETREATPATH=  

SUMMARYPATH=

DESCRIPTION= The description of this ASCII Sequence.

RECORD=Samp,MULTICAL.MET,Multical001.dat,0,1.2,2.91,1.1,1,12,,,,16384,1,,3

RECORD=Samp,MULTICAL.MET,Multical002.dat,0,1.2,2.91,1.1,2,12,,,,,2,Record 
Desc,3

RECORD=Samp,MULTICAL.MET,Multical003.dat,3,1.2,2.91,1.1,1,12,,,,16384,,,3

ACTION   = 1,1,3,D:\CHROM\Program.EXE

ACTION   = 1,0,2,4

RECORD=Samp,MULTICAL.MET,Multical004.dat,0,1.2,2.91,1.1,2,12,,,,,4,Record 
Desc,3

RECORD=Samp,MULTICAL.MET,Multical005.dat,0,1.2,2.91,1.1,1,12,,,,16384,,,3

ACTION   = 3,1,6,7 ,2

ACTION   = 3,0,2,4
ChromQuest Reference Guide Thermo Scientific



 5 ASCII Sequence File Format
Example of ASCII Dual Tower Sequence File
RECORD=Samp,MULTICAL.MET,Multical006.dat,6,1.2,2.91,1.1,2,12,,,,16384,3,,3

RECORD=Samp,MULTICAL.MET,Multical007.dat,0,1.2,2.91,1.1,1,12,,,,,2,,3

RECORD=Samp,MULTICAL.MET,Multical008.dat,0,1.2,2.91,1.1,2,12,,,,76,,Record 
Desc,3

ACTION   = 4,1,5

ACTION   = 4,0,2,4

RECORD=Samp,MULTICAL.MET,Multical009.dat,9,1.2,2.91,1.1,1,12,,,,16384,1,,3

RECORD=Samp,MULTICAL.MET,Multical010.dat,0,1.2,2.91,1.1,2,12,,,,16384,2,,3

Example of ASCII Dual Tower Sequence File
The following is an example of an ASCII Dual Tower Sequence file:

ASCII Sequence 1 

CREATIONDATE= 

LASTCHANGEDDATE=

METHODPATH = \\Qa-glisowski01\transfer 

PRINTREPORTS = 

NO DATAPATH = \\Qa-glisowski01\transfer\public 

PRETREATPATH = 

SUMMARYPATH = 
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DESCRIPTION = The description of this ASCII Sequence. 

TOWER=0 

RECORD=Front Samp 1,HP6890 FRONT 

JL01.MET,FrontMultical001.dat,0,1.2,2.91,1.1,1,1,,,,16384,1,,3 

RECORD=Front Samp 2,HP6890  FRONT 

JL01.MET,FrontMultical002.dat,0,1.2,2.91,1.1,2,1,,,,,2,Record Desc,3 

RECORD=Front Samp 3,HP6890 FRONT 

JL01.MET,FrontMultical003.dat,3,1.2,2.91,1.1,3,1,,,,16384,,,3 

ACTION = 1,1,3,D:\CHROM\Program.EXE 

ACTION = 1,0,2,4 

RECORD=Front Samp 4,HP6890 FRONT

JL01.MET,FrontMultical004.dat,0,1.2,2.91,1.1,4,1,,,,,4,Record Desc,3 

RECORD=Front Samp 5,HP6890 FRONT

JL01.MET,FrontMultical005.dat,0,1.2,2.91,1.1,5,1,,,,16384,,,3 

ACTION = 3,1,6,7 ,2 

ACTION = 3,0,2,4 

RECORD=Front Samp 6,HP6890 FRONT 

JL01.MET,FrontMultical006.dat,6,1.2,2.91,1.1,6,1,,,,16384,3,,3 

RECORD=Front Samp 7,HP6890 FRONT 

JL01.MET,FrontMultical007.dat,0,1.2,2.91,1.1,7,1,,,,,2,,
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RECORD=Front Samp 8,HP6890 FRONT 

JL01.MET,FrontMultical008.dat,0,1.2,2.91,1.1,8,1,,,,76,,Record Desc,3 

ACTION = 4,1,5, 

ACTION = 4,0,2,4, 

RECORD=Front Samp 9,HP6890 FRONT 

JL01.MET,FrontMultical009.dat,9,1.2,2.91,1.1,9,1,,,,16384,1,,3, 

RECORD=Front Samp 10,HP6890 FRONT

JL01.MET,FrontMultical010.dat,0,1.2,2.91,1.1,10,1,,,,16384,2,,3, 

TOWER=1 ASCII Sequence 1 

CREATIONDATE= 

LASTCHANGEDDATE= 

METHODPATH = \\Qa-glisowski01\transfer 

PRINTREPORTS = 

NO DATAPATH = \\Qa-glisowski01\transfer\public 

PRETREATPATH =

SUMMARYPATH = 

DESCRIPTION = The description of this ASCII Sequence. 

RECORD=Rear Samp 1,REAR 

JL01.MET,RearMultical001.dat,0,1.2,2.91,1.1,11,1,,,,16384,1,,3 

RECORD=Rear Samp 2,HP6890 REAR 

JL01.MET,RearMultical002.dat,0,1.2,2.91,1.1,12,1,,,,,2,Record Desc,3 

RECORD=Rear Samp 3,HP6890 REAR 

JL01.MET,RearMultical003.dat,3,1.2,2.91,1.1,13,1,,,,16384,,,3 
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ACTION = 1,1,3,D:\CHROM\Program.EXE 

ACTION = 1,0,2,4 

RECORD= Rear Samp 4,HP6890 REAR 

JL01.MET,RearMultical004.dat,0,1.2,2.91,1.1,14,1,,,,,4,Record Desc,3 

RECORD=Rear Samp 5,HP6890 REAR 

JL01.MET,RearMultical005.dat,0,1.2,2.91,1.1,15,1,,,,16384,,,3 

ACTION = 3,1,6,7 ,2 

ACTION = 3,0,2,4 

RECORD=Rear Samp 6,HP6890REAR 

JL01.MET,RearMultical006.dat,6,1.2,2.91,1.1,16,1,,,,16384,3,,3 

RECORD=Rear Samp 7,HP6890 REAR 

JL01.MET,RearMultical007.dat,0,1.2,2.91,1.1,17,1,,,,,2,,3 

RECORD=Rear Samp 8,HP6890 REAR 

JL01.MET,RearMultical008.dat,0,1.2,2.91,1.1,18,1,,,,76,,Record Desc,3 

ACTION = 4,1,5 

ACTION = 4,0,2,4 
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RECORD= Rear Samp 9,HP6890 REAR 

JL01.MET,RearMultical009.dat,9,1.2,2.91,1.1,19,1,,,,16384,1,,3 

RECORD=Rear Samp 10,HP6890 REAR 

JL01.MET,RearMultical010.dat,0,1.2,2.91,1.1,20,1,,,,16384,2,,3 
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ChromQuest System Suitability

ChromQuest provides a System Suitability module that allows you to automatically calculate 
suitability parameters as a part of your general data acquisition and processing tasks.

System Suitability Overview
System suitability testing, originally conceived by the pharmaceutical industry to determine if 
a chromatographic system is suitable for a particular analysis, is now used routinely in 
laboratories where quality of results is important. While system suitability testing is not the 
same as method validation, they are often used to provide a complete picture of laboratory 
quality and reproducibility of results. 

System suitability basically involves running a mixture containing the analytes you are 
running in your samples and examining various parameters that describe the ability of the 
chromatograph and column to separate those analytes. The chromatographer, based on the 
method and analysis to be performed, must determine the importance or need to examine any 
given parameter. Some important suitability parameters are described briefly below. 
Calculations used in the system suitability test are given at the end of this manual.

Resolution

This checks the ability of the column to separate one analyte from others in the mixture. Two 
peaks are considered resolved if the calculated R factor is greater than 1.5.

Contents

• System Suitability Overview

• ChromQuest System Suitability Module

• System Suitability Setup

• Running a Suitability Test

• Suitability Reports 
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Repeatability

Injection of the same sample multiple times lets you determine if your chromatograph is 
providing reproducible results. Generally, 5 to 6 repeatability samples are necessary to provide 
adequate data for meaningful results. Repeatability can be determined through examination 
of the % relative standard deviation (%RSD) for such parameters as peak area, height, or 
concentration.

Peak asymmetry (Tailing)

The quantitative values for peak asymmetry are important, especially when dealing with trace 
components. In addition, since asymmetry can vary through the life of a column, it can be 
important to track this data on an ongoing basis.

Theoretical Plates

Calculation of plate count is an important indication of column efficiency. Many 
chromatographers like to monitor plate count as an indication of when to replace the column.

Noise and Drift

Particularly important to trace analyses, the noise and drift values for your chromatograph 
indicate the limits of detection and quantification. Three types of noise calculations are 
available: RMS noise, ASTM noise, and 6-sigma noise.

ChromQuest System Suitability Module
ChromQuest System Suitability module includes the ability to do automatic System 
Suitability calculations for experimental variables such as efficiency, capacity, resolution, and 
reproducibility. The package includes four choices of calculation methods, including USP 
(United States Pharmacopia), EMG (Exponential Modified Gaussian), Area/Height method, 
and DAB (German Pharmacopia). DAB calculation is also used for JP (Japanese 
Pharmacopia), BP (British Pharmacopia), and EP (European Pharmacopia). The user can set 
acceptance ranges for each peak individually. Suitability Test can be programmed as part of a 
sequence of runs, with automatic printout of System Suitability Report indicating pass/fail on 
a per-peak and per-run basis.
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To run a suitability test 

1. Complete the System Suitability Setup dialog. For each peak of interest, select one or 
more Parameters, and set Min, Max, and % RSD values for each. Additionally, set Noise 
test and/or Drift test, enter start and end times for the test, along with threshold values. 

2. Enter values for parameters such as Unretained Peak Time, required for calculation of 
performance options. Select a method for calculation of the performance values. This is 
done by choosing the Method > Advanced Method Options > Performance command. 
Select Calculate Performance Parameters to enable the suitability calculations.

3. Create and run a sequence where system suitability standards are included at the 
beginning of the sequence. For example, following USP protocols, five replicate standards 
are run at the beginning of the sequence. These are designated as system suitability 
standards in the sequence. At the end of the sequence, suitability calculations are made 
and ChromQuest generates a system suitability report.

System Suitability Setup
Before ChromQuest can make System Suitability calculations, you must enter the required 
acceptance ranges for the peaks of interest information about your chromatographic column.

This section contains the following topics:

• Setting Up a System Suitability Report

• Entering the Performance Parameters 

Setting Up a System Suitability Report

There is one System Suitability Setup dialog box for each detector in your instrument 
configuration. 

Note  If you are performing a multi-wavelength analysis with one detector (UV2000, 
UV3000, UV6000, Surveyor PDA, or Surveyor PDA Plus), you might want to label your 
peaks (in the Peak Table) with additional information pertaining to their analysis 
channels.
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To set up a system suitability report

1. Choose the Method > System Suitability command to open the System Suitability 
Setup dialog.

Figure 87. System Suitability Setup dialog box

2. Select the first peak to be used for calculations by highlighting it with the mouse in the 
Compound list. 

3. In the adjacent spreadsheet click the first field in the Parameter column. A drop-down 
list of available parameters is displayed. Select a parameter from the list. If you do not 
wish to perform a suitability test on any given peak, simply leave the Parameter fields 
blank. Similarly, if you do not wish to have one of the test criteria used (for example, 
%RSD), leave it blank. Some parameters have a choice of calculation methods. These 
parameters have the calculation method displayed after the parameter in parenthesis. (for 
example, Plates/Meter (JP) indicates Plates/Meter calculated using the Japanese 
Pharmacopoeia calculation.) For details on these calculations, see the equations section.

4. For each parameter selected, enter a minimum value (Min), maximum value (Max), and 
maximum allowed percent relative standard deviation (%RSD).

5. If you want a noise test to be performed, click the lower spreadsheet in the column 
labeled Test. Select one of the noise calculations Noise (rms)/ ASTM Noise (rms), or 
6-sigma Noise (rms) from the drop-down list. If you select this box, you must enter a 
Start and Stop time for the test, and a Threshold value to determine acceptable limit. 
The RMS noise value for the portion of chromatogram between the Start and Stop times 
are calculated and compared to the Threshold value to determine whether the test Passed 
or Failed. Note that the times you enter for the noise test should be representative of a 
baseline area of your chromatogram where no peaks elute.

6. If you want a drift test to be performed, click the lower spreadsheet in the column labeled 
Test. Select Drift (mV/min) from the drop-down list. If you select this box, you must 
enter a Start and Stop time for the test, and a Threshold value (in μV/Min) for the 
acceptable limit. 
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7. After highlighting sections of the spreadsheet that you want to copy, press:

• CTRL+C to copy the highlighted section of the spreadsheet to the clipboard.

• SHIFT+INSERT to paste the clipboard item to where the cell is highlighted.

• SHIFT+ARROWS highlights the spreadsheet cells, and can move them.

8. When you have completed the System Suitability Setup, close the dialog box.

Entering the Performance Parameters

System Suitability calculations require information about your chromatography column. 
These parameters are entered in the Method > Advanced > Performance dialog box. The 
information in this dialog box pertains to one detector. If you are performing a multi-detector 
analysis, select an Analysis Channel, and then enter the appropriate information for the 
selected detector.

To enter your column parameters

1. Choose Method > Advanced. Click the Performance tab to open the 
Column/Performance page.

2. Enter your column information. 
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Figure 88. Column/Performance page of the Advanced Method Options dialog box

3. Select the Calculate performance parameters for this channel check box to enable the 
suitability calculations for the method. 

4. Select a method for the calculation of the performance values.

Choices include USP, EMG (Exponential Modified Gaussian), DAB, JP, and AOH 
(Area/Height) method. The calculations used are given in the equations section. For BP, 
EP, and ASTM methods, choose DAB.

5. When you have completed the dialog box, exit to accept the parameters.

Note  If you are performing a multi-detector analysis, you can select a different 
calculation method for each detector.
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After completing the System Suitability Setup and Performance dialogs, create a Sequence 
or modify an existing Sequence to include one or more system suitability runs according to 
the needs and SOP’s of your laboratory. If you want the System Suitability Report to print 
automatically at the end of the sequence, you must also select the Print Sequence Reports 
option from the Sequence Properties dialog box.

For example, following USP standards, five replicate standards are run at the beginning of the 
sequence. These are designated as system suitability standards in the sequence. At the end of 
the sequence, suitability calculations are made, and ChromQuest generates a system 
suitability report.

Figure 89. Sequence Suitability report

Run Type is selected by clicking on the Run Type field, then selecting the appropriate sample 
type from the choices provided.
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Figure 90. Sample Run Type(s) dialog box

The first sample in your suitability set should be designated as Begin System Suitability. 
Additional suitability standards should be designated as System Suitability Standards, and 
the final sample in your suitability set should be designated as End System Suitability. 
Multiple run types can be selected for a given sample.

A System Suitability Report is generated at the end of the set of suitability standards when the 
sequence is run. 

To view the Suitability Report on screen, choose Reports > View > Sequence Custom 
Report from the menu bar. The System Suitability Report appears in a list of available 
Sequence Custom Reports. 

To print the Suitability Report, choose Reports > Print > Sequence Custom Report, and 
select the System Suitability Report choice. Note that in order to have your report printed 
automatically at the end of the sequence, you must have selected the Print Sequence Reports 
option in the Sequence Properties dialog.
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Suitability Reports
ChromQuest provides a default suitability report template. This report template can be used 
as-is, or it can be customized in the Sequence Custom Report editor.

Figure 91. Default suitability report 
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Standard Reports

ChromQuest has a very powerful custom report editor. However, it is not necessary to create 
a custom report in order to print results. The following standard report templates are 
provided with the system to enable you to print any type of report you wish. However, these 
report templates can be modified by the user from the Custom Report editor.

Contents

• Error Condition Flags

• Area % Report 

• External Standard Report

• Internal Standard Report

• Normalization Report

• Summary Report

• Calibration Report 

• QC Check Standard Report

• Duplicate Report

• Spike 1 Report

• Spike 2 Report

• System Suitability Report
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Error Condition Flags
Whenever an error condition occurs for a calculated value, an “error flag” is printed that 
indicates the nature of the problem. These flags are used in reports, exported data, and for 
certain annotations. 

In cases where “0.00” is reported, the “0.00” is reported because the nature of the error 
prevents further calculation. 

Area % Report 
This is an example of the Area % (Area%.srp) report template output.

0.00 BDL Below detection limit

0.00 ISTD Problem with ISTD peak

0.00 STD Problem with standard peak

0.00 FIT Problem with curve fit

<conc> CAL Currently calibrating, <conc> = peak table conc. for current level

0.00 NEG Negative concentration

<conc> LC Low conc, <conc> = calculated conc.

<conc> HC High conc, <conc> = calculated conc.
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External Standard Report
This is an example of a report using the External Standard (External Standard.Srp) template.

Internal Standard Report
This is an example of a report using the Internal Standard (Internal Standard.Srp) template 
output.
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Normalization Report
This is an example of the Normalized Report (Normalization.Srp) template output.

Summary Report
This is an example of a Sequence Summary (Summary.brp) report template output. This 
template is included for compatibility with ChromQuest 2.x versions only.
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Calibration Report 
This is an example of the Calibration (Calibration .brp) report template output.

QC Check Standard Report
This is an example of the Check Standard (QC Check Std.brp) template output.
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Duplicate Report
This is an example of the Duplicate (Duplicate.brp) report template output.

Spike 1 Report
This is an example of the Spike/Unspike (Spike 1.brp) report template output.
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Spike 2 Report
This is an example of the Spike 2 of 2 (Spike 2.brp) report template output.

System Suitability Report
This is an example of the System Suitability (SysSuit.brp) report template output.
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Spectral Options

ChromQuest provides special features to optimize your chromatographic analyses when 
collecting UV-Visible scanning data from the UV3000 high-speed scanning detector, the 
UV6000LP photodiode array detector (PDA), the Surveyor PDA, or the Surveyor PDA Plus 
detector. The features are collectively referred to as Spectral Analysis. These features include 
peak purity assessment for determining the presence of co-eluting impurities and spectral 
library searches for confirming the identity of an analyte. 

With a standard UV-Vis detector, the absorbance is measured at one wavelength (or 
sometimes two wavelengths). The two-dimensional array of data plotted as absorbance versus 
time is commonly called a chromatogram. The UV3000 scanning detector measures the 
absorbance at multiple wavelengths in a fraction of a second. The photodiode array detectors 
measure the absorbance at multiple wavelengths, simultaneously. Therefore, these detectors 
can produce a 3-dimensional plot of absorbance versus time and wavelength.

Contents

• Spectral Method Setup

•  Spectral Views

• Custom Report

• Peak Table

• Spectral Analysis and Calculations

• Library Search Calculations

• Ratio Chromatogram Calculation

• Similarity Calculations

• Lambda Max/Min Calculations

• Peak Purity Calculations
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Spectral Method Setup
In addition to the instrument control parameters that control the operation of your scanning 
detector, the method contains spectral options for the scan data. These include setting up 
libraries, spectral filtering, defining multiple wavelengths for multi-wavelength display and 
calibration, and setting up the Ratio view. These options are available from the Instrument 
window by choosing Method > Spectral Options to open the Spectral Options dialog box. 
The Spectral Options dialog box contains the following pages:

• Library

• Purity

• Spectrum

• Multi-Chromatogram

• Ratio 

Library

On the Library page of the Spectral Options dialog box, you can enter library parameters for 
the spectral library searches that is performed automatically as part of your method. When 
you perform a spectral library search “using method parameters”, these parameters are used.

Figure 92. Spectral Options – Library dialog box
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Parameter Description

Library/Enabled Enter the spectral library to be searched or select from available libraries by clicking the 
Library field followed by clicking on the file button . You can select more than one 
library. To enable the library for searching, select the Enabled checkbox. If this list is 
empty, or no library is enabled, no hits are returned when a search is performed.

Search parameters Enter the parameters to use for the search.

Wavelength range Enter the wavelength range to search.

Wavelength step Enter a step number for the search. Larger numbers makes the search faster, but if you use 
too large of a step, spectral details might not be picked up. Because the spectral comparison 
program compares spectra on a per wavelength basis, it is best to collect the library spectra 
with a step size of one.

Max hits Specify the number of hits that are reported in the results of a library search. Note that this 
works in conjunction with the Similarity Threshold parameter to limit the number of hits 
reported.

Similarity threshold Enter a number for threshold of similarity. The library search results only displays matches 
whose similarity to the unknown exceeds this value.

The options in this group allow you to specify search pre-filters that is performed on library 
spectra prior to the test for similarity. All pre-filters are optional.

Pre-filters

Retention time range When values are entered in these fields, ChromQuest limits its search to library spectra 
obtained from peaks whose apex are within the specified retention time range. This 
pre-filter is optional and may be left blank.

Lambda max When one or more of these values is specified, library search is restricted to those library 
entries containing lambda max value(s) within 5nm of all of the specified values. Entries 
without matching lambda max value(s) are automatically excluded from the search (no 
similarity calculation is made). Entering values for lambda max is optional.

Compound name filter If you are searching only for spectra that contain a certain name, enter the name here. Only 
spectra containing that name is searched.
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Purity

The Purity page allows you to set the parameters necessary to perform manual peak purity 
calculations and peak purity calculations that occur automatically as part of analysis.

Figure 93. Spectral Options – Purity dialog box
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Parameter Description

Purity calculations The Purity calculations group box contains the following parameters:

Wavelength range Specify the wavelength range over which the purity calculations is performed, for example, 
from 200nm to 400nm.

Wavelength step Specify the wavelength spacing (in nm) used for purity calculations.

Scan threshold This value is the minimum absorbance value that a spectrum must have to be included in 
the purity calculations

Peak coverage The Peak Coverage parameter indicates the fraction of the peak used for purity calculations. 
It is possible to allow the calculation to be done over the entire width of the peak (100%), 
which ensures the greatest possibility of detecting an impurity. However, this has the 
disadvantage of including data that has a relatively low signal to noise ratio, and for which 
spurious results might be calculated. The default value is a peak coverage of 95%.

Background 
compensation

Selecting this checkbox causes spectra to be corrected for background baseline absorbance 
using the peak baseline prior to being used in the calculation of purity.

Per-peak spectrum 
calculations

The result of these calculations is available in reports and as chromatogram annotations. 

Deselecting these checkboxes speeds up analysis. If a checkbox is not selected and the field 
appears in a run report, it is reported as zero.

Total purity Selecting this checkbox causes total peak purity to be calculated on a per-peak basis during 
analysis. The result of this calculation is available in reports and as chromatogram 
annotations. If this box is not selected and a report contains the field, a value of zero is 
reported.

3 point purity Checking this box causes 3-point peak purity to be calculated on a per-peak basis during 
analysis. The result of this calculation is available in reports and as chromatogram 
annotations. If this box is unchecked and a report contains the field, a zero is reported.
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Spectrum

The Spectrum page allows you to specify the types of filtering and processing to be performed 
on spectra that are extracted from the 3D data during analysis as well as to spectra displayed in 
the Spectrum View.

Figure 94. Spectral Options – Spectrum dialog box

Note  The processing specified on this page is performed prior to any use of the spectra in 
the software, including display, searching and reporting.
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Parameter Description

Spectral filtering In this group box, you designate how spectral filtering is performed.

Filtering type Select the type of filtering for the spectral plot. Choices are: None, Smooth, 1st Derivative, 
and 2nd Derivative.

Background correction If this checkbox is selected, a correction for the spectral background is made, for the 
following features: 

• Library search

• Adding a spectrum from the current file to a library

• Per-peak similarity calculations

• Spectral confirm

The background correction is accomplished as follows:

1. The spectra from the baseline start and baseline stop times for the peak are extracted 
from the data.

2. For each spectrum in the peak, a corresponding background spectrum is generated by 
linear interpolation between the baseline start and baseline stop spectra. 

3. This background spectrum is subtracted from the original spectrum. 

Note  The baseline start and stop times that are used in calculating background 
compensation are based on the detected peaks for the channel currently selected.

Interpolate spectra Select this check box to automatically perform 10:1 interpolation of spectra displayed in the 
spectrum window using a cubic spline curve fit. This interpolation is performed after the 
applying any spectral filtering option (1st derivative, 2nd derivative or smooth) to the display 
spectrum.

Note  Interpolated spectra may not be stored or added to a library.

The peak spectrum 
is defined as

The parameters contained in this group box specify if and how spectra extracted from the 
3D data are averaged before being exported or used in the Spectrum Report. 

The peak apex 
spectrum

When this checkbox is selected, the spectrum at the apex of the peak is used, without 
averaging.

The avg. of 
the upslope, apex and 
downslope spectra

When this checkbox is selected, three spectra (the spectra at the upslope inflection point, 
the apex and the downslope inflection point) are averaged. 

The avg. of 
every n spectra across 
the peak

When this checkbox is selected. Every nth spectrum from the peak is extracted, beginning at 
the start of the peak and continuing to the end of the peak. These extracted spectra are 
averaged and become the spectrum that is reported or exported. 
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Per-peak spectrum 
calculations

Selecting any of these checkboxes allows the indicated value to be calculated on a per-peak 
basis during analysis. The result of this calculation is then available in reports and as 
chromatogram annotations. 

Deselecting options that are not of interest speeds up analysis. If a checkbox is not selected 
and the field appears in a run report, it is reported as zero

Similarity Checking this box causes the Peak Apex Similarity to the reference spectrum to be 
calculated on a per-peak basis during analysis. The result of this calculation is then available 
in reports and as chromatogram annotations. If this box is unchecked and a report contains 
the field, a zero is reported.

Peak Apex Similarity applies only to named peaks and its use requires that a reference 
spectrum be included in the peak table. 

Up slope similarity Checking this box causes upslope similarity to be calculated on a per-peak basis during 
analysis. Upslope similarity compares the peak apex spectrum to the spectrum at the peak 
inflection point on the upslope side (to the left of the apex). The result of this calculation is 
then available in reports and as chromatogram annotations. If this box is unchecked and a 
report contains the field, a zero is reported.

Down slope similarity Checking this box causes downslope similarity to be calculated on a per-peak basis during 
analysis. Downslope similarity compares the peak apex spectrum to the spectrum at the 
peak inflection point on the downslope side (to the right of the apex). The result of this 
calculation is then available in reports and as chromatogram annotations. If this box is 
unchecked and a report contains the field, a zero is reported.

Lambda max Checking this box indicates causes the lambda max (wavelength at which the highest 
absorbance occurs) to be computed for each peak of each multi-chromatogram extracted 
from the 3D data during analysis. The result of this calculation is then available in reports 
and as chromatogram annotations. If this box is unchecked and a report contains the field, a 
zero is reported.

Parameter Description
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Multi-Chromatogram

The Multi-Chromatogram page allows you to specify wavelength channels within the 3D data 
for integration and quantitation. In addition, it allows you to select wavelengths to display in 
the Multi-Chromatogram view. To create a Multi-Chromatogram channel, select an Enabled 
checkbox. Then, type a wavelength in the Wavelength text box and a bandwidth in the 
Bandwidth text box. The wavelength must be part of the scan data. After you have set up a 
multi-chromatogram channel, you can disable it temporarily by deselecting the Enabled 
checkbox. Choosing View > Spectral View > Multi-Chromatogram displays The 
Multi-Chromatogram view. The Multi-Chromatogram view is not functional unless one or 
more valid wavelengths are enabled in the Multi-Chromatogram Definition tab.

Figure 95. Spectral Options – Multi-Chromatogram dialog box

The multi-chromatogram data is an average of the absorbances monitored at each wavelength 
in the wavelength range. The wavelength range is equal to the selected wavelength +/- one half 
of the bandwidth.

Parameter Description

Enabled To enable a wavelength, click the checkbox. To disable a 
wavelength, click the checkbox again to remove the checkmark. 
Only enabled wavelengths appears in the multi-chromatogram 
view.

Wavelength Enter the wavelength you want to view or use as an analysis 
channel or both.

Bandwidth Specify the nm range to be averaged in generating the analog 
signal for each channel.

Subtract baseline 
chromatogram

To enable baseline subtraction, select this check box, and then 
type a baseline wavelength in the Wavelength box and a 
bandwidth for this wavelength in the Bandwidth box.
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Ratio 

The Ratio page allows you to set the displays of the Ratio Plot View. The Ratio View displays 
two PDA wavelength channels and the ratio of those two channels. These may be viewed 
during real-time acquisition as well as during post-run analysis. The flat tops on the ratio 
peaks are a preliminary indication of peak purity. 

Figure 96.  Spectral Options – Ratio dialog box

Parameter Description

Ratio plot These controls specify the wavelength of the ratio multi-chromatogram channels. The 
extracted chromatograms is centered about the specified wavelength.

Channel 1, 
Channel 2

• Wavelength

Enter the wavelength of the chromatogram channel.

• Bandwidth

Enter the nm range to be averaged in generating the chromatogram channel.

Threshold Enter the ratio threshold. The threshold is the minimum absorbance value required in the 
chromatograms of both channels for calculation of the ratio. It is a method of eliminating 
ratio calculation at low absorbance values to prevent calculation for baseline noise. If the 
threshold value is not met, the ratio plot is zero.

Max Plot Lambda 
Max Range

This allows the user to restrict the wavelength range over which the Spectrum Max Plot is 
calculated. The default is the detector acquisition range.
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 Spectral Views
The Spectral Views menu provides a variety of ways to view the scan data. This menu is 
accessed by choosing View > Spectral View from the Instrument window menu, or by 
clicking on Views in the Spectral View window menu bar. A right-mouse click within any of 
the view windows provides a unique menu of options for that view. The following views are 
available:

• Mixed View

• Chromatogram View

• Max Plot

• Multi-Chromatogram View

• Spectrum View

• Ratio View

• 3D View

• Contour View
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Mixed View

This first, second, and third quadrants of this view display the Contour, Chromatogram, and 
Spectrum views, respectively. By default, the fourth quadrant of this view displays the peak 
purity view. You can change the view in the fourth pane by choosing a view from the Options 
menu that is accessed by clicking on Options in the Mixed View toolbar.

Figure 97. Spectral View – Mixed View window

To zoom in on a portion of the contour plot, chromatogram or spectrum, hold the left mouse 
button down, move the mouse over the plot until the area of interest is highlighted, and 
release the mouse button. 

To quickly move to the previous level of zoom, double-click the plot.

To unzoom to the full plot after multiple zooming operations, use CTRL+Z, or use 
SHIFT + double-click in the window, or click the right-mouse button anywhere in the 
window and select Full Unzoom from the pop-up menu.

Mixed View Synchronize Button

You can synchronize the axis and zoom limits with the other two plots using the Synchronize 
button on the Spectral toolbar. When the contour plot is zoomed, the time range of the 
chromatogram and the wavelength range of the spectrum plot are automatically adjusted to 
the same range as the contour. When synchronized zooming has been performed, the x-axis 
plot limits for the chromatogram and spectrum plot are changed. To unzoom these plots to 
the limits of the data, you must select Full Unzoom from the contour plot context menu.
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Mixed View Actions Button

Figure 98. Mixed View – Actions button

This button presents the following actions:

• Search Library

Opens the Spectral Library Search window.

• Overlay Spectra

Allows you to select a spectrum to overlay in the Spectrum view pane.

• Select Peak for Purity Display

Enables you to select a peak for display in the Purity view pane.

Mixed View Options Button

Figure 99. Mixed View – Options button

This button presents options that enable you to toggle the view for the lower right pane of the 
mixed view.

Spectral Peak Purity Plot

The peak purity plot appears when you choose the Mixed View. A peak purity plot only 
appears if the method Spectral options have specified purity information, and the data has 
been analyzed.

Select Peak

To select the reference spectrum for the purity calculation, make sure the data has been 
analyzed. (If you are not sure, click the analyze button on the toolbar.) Then, click Actions > 
Select Peak for Similarity / Purity Display from the Mixed View toolbar. A dialog appears 
that instructs you to select a peak by holding down the Ctrl button and then clicking on a 
peak on the Contour Plot or the Chromatogram view. The retention time of the reference 
spectrum is displayed along with a value indicating peak purity.
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Figure 100. Select Peak for Similarity / Purity Display dialog box

You can continue to select or change the peak. When you are finished, click Close.

The Peak Purity view displays the purity profile for a chromatogram extracted from the 3D 
data. The view displays purity information for the peak that has been chosen as well as the 
peak data itself. The shape of the purity profile (“hat”) indicates the presence or absence of 
impurity in the peak of interest. For example, the less flat the profile is the more likely there is 
an impurity present. However, a symmetrical profile, mostly flat in the middle, but steeply 
falling off at the edges can indicate a fairly pure peak. The fall off at the edges is due to the 
lower signal-to noise ratio of the spectra there. The pane is blank until the data has been 
analyzed, and a peak has been selected for the purity calculation.

Figure 101. Peak Purity view
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Chromatogram View

The Chromatogram View can be displayed alone or as part of the Mixed View display. 
Generate a chromatogram from the Contour plot as described in the section on contour plot.

Right-click within the chromatogram window to display the pop-up menu. This menu 
contains the same options as the basic chromatogram window for all detector types, and in 
addition enables you to overlay chromatograms from different wavelengths and change the 
Gallery view.

Overlay Chromatograms

When this option is available when you have a chromatogram view and a contour plot 
displayed simultaneously (Mixed View). Select Overlay Chromatograms to add 
chromatograms from different wavelengths to the view whenever you slide the wavelength 
selection cursor on the contour plot to a new wavelength. 

Max Plot

A Max Plot is a chromatogram with each point plotted at its maximum absorbance. This plot 
gives an indication of the appearance of the chromatogram when the wavelengths are 
optimized for each peak.

Figure 102.  Max Plot view
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Multi-Chromatogram View

This displays multiple chromatographic plots of absorbance versus time, each at a different 
wavelength. Maximize the Spectral display and choose View > Spectral Views > 
Multi-Chromatogram (or use the Spectral toolbar/Views) to display all of the 
chromatograms in their respective channels that were specified in the Method > Spectral 
Options > Multi-Chromatogram tab.

Right-click within the window to display the pop-up context menu.

Figure 103. Multi-Chromatogram view

Spectrum View

This view displays the spectrum associated with a time point on the chromatogram. The 
spectrum displayed can be changed from the Mixed View by dragging the X-axis handle 
across the Contour plot. 

Figure 104. Spectrum view
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Right-clicking in the Spectrum view opens a shortcut menu that includes the following 
options:

• Spectrum Properties

Right-click in the Spectrum view to display a shortcut menu. Then, choose properties to 
access the Data Graph Properties dialog box. The Data Graph Properties dialog box 
enables you to add another trace to the view, or change scaling. It also lets you selectively 
remove overlaid traces from the view.

• Spectrum Background Correction 

Select the right mouse click/Operations menu item to toggle the background correction 
on and off.

If the current spectrum has been extracted from an integrated peak, select this option to 
correct the displayed spectrum for background based on the working chromatogram. 
Refer to the “Spectral Analysis and Calculations” on page 168 for details on how this 
calculation is performed.

Background Correction may only be performed once on a spectrum. If a second 
background correction is attempted on an already corrected spectrum, a message box is 
displayed and the operation ignored.

If the current spectrum has not been extracted from an integrated peak of the working 
chromatogram, selecting this menu item will have no effect on the spectrum.

Background subtraction must always be the first operation performed on a spectrum. If a 
background correction is attempted on a spectrum after another operation has already 
been performed (including operation specified in the Spectrum tab of Spectral Options), a 
message box is displayed and the background correction request ignored.

• Interpolate Spectrum 

Select the right-mouse click > Operations menu item to toggle the interpolate option 
on and off.

Selecting this menu item causes a 10:1 interpolation to be performed on the spectrum. 
Refer to the “Spectral Analysis and Calculations” on page 168 for details on how the 
values are computed.

• Export

Selecting this menu item will display a File Save As dialog. When a valid filename is 
entered and Ok is pressed, the currently displayed spectrum is exported as an ASCII data 
file. Refer to Chapter 4, “Data and Graphics Export,” for details on the data file format.

• Overlay Spectra 

You can overlay spectra using the Actions > Overlay Spectra command from the 
Mixed View toolbar. When you select this option, a dialog appears where you can enter 
the retention time from which you want to extract a spectrum. You can also overlay 
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spectra quickly by moving the wavelength cursor in the Contour or Chromatogram view 
to the desired wavelength. To remove the spectra you have added to the view, use the 
Clear Overlays command from the right mouse click menu in the Spectrum view. You 
can also clear selected spectra using the Trace Setup dialog accessed by doing a right 
mouse click in the view and then selecting Properties.

Figure 105. Overlay Spectra dialog box

Ratio View

The Ratio view displays two spectral wavelength channels and the ratio of those two channels. 
These may be viewed during real-time acquisition as well as during post-run analysis. The flat 
tops on the ratio peaks are a preliminary indication of peak purity. The ratio wavelengths and 
parameters are set in the Method >Spectral Options > Ratio tab.

The Y-axis of the ratio chromatogram is auto-scaled to 1. 

Figure 106. Ratio Plot view

Right-click within the window to display the pop-up context menu. The context menu is the 
same as for a standard chromatogram graph window.
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3D View

The 3D View provides a three-dimensional view of absorbance versus time and wavelength. 
Wavelengths of appreciable absorbance and interference, which may be invisible in a single 
wavelength plot, are easy to locate with the 3D View. The plot can be elevated and rotated 
around its axis for display from any angle.

Figure 107. 3D view 

Right-click inside the 3D view to display the pop-up menu that gives you access to plot 
rotation and axis setup features. 

3D Plot movement selections

Click the type of plot movement you wish to use (elevate, roll, rotate, rotate XYZ, or spin). A 
checkmark appears next to the selected movement option. Once you have selected one of the 
options, you is returned to the plot and the cursor indicates the type of movement selected.

Figure 108. 3D Plot view

Hold down the left mouse button and move the cursor in the direction you wish to move the 
plot. The plot moves as you move the cursor. The movement option remains in effect until 
you turn it off. When finished, click the right mouse button, and de-select the movement 
option. If you wish to return to the original view, select the Reset command.

Note  During a run, the user must manually refresh this display. It does not update 
automatically.
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3D Properties

This dialog allows you to set the properties of the 3D plot.

Figure 109.  3D Data Graphic Properties – General dialog box

Note  These values can be viewed or changed using the 3D > Properties dialog.
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Parameter Description

Style

Color or Grayscale Select Color or Grayscale for the plot. 

Wire Mesh Checking the Wire Mesh box causes the data to be rendered as a wire frame plot, rather 
than as a solid fill plot.

Colors

Range Select how you want the coloration on the plot to appear. When Light & Dark Range is 
selected, alternating light and dark bands are used. When Full Spectrum is selected, then a 
continuous color spectrum is used.

Background Select the color for the background of the plot.

Axes Select the color for the plot axes.

Display This specifies the relative quality of the displayed contour plot. Lower Display Detail results 
in faster drawing of the plot.

Print This specifies the relative quality of the printed contour plot. Lower Print Quality results in 
faster printing.

Viewing Use these fields to view current rotation settings, or to set them manually.

Light source Selecting this option causes the plot to be shaded as if an external light source were shining 
upon it. 

Rotation This reports the current level of rotation (front to back) in the aspect position of the plot. 
When a new value is entered, the plot is redrawn to reflect the new value upon exiting the 
dialog. 

Elevation This reports the current level of tilt (forward or backward) in the aspect position of the plot. 
When a new value is entered, the plot is redrawn to reflect the new value upon exiting the 
dialog.

Roll This reports the current level of roll (side to side) in the aspect position of the plot. When a 
new value is entered, the plot is redrawn to reflect the new value upon exiting the dialog.

Zoom This reports the current level of magnification in the plot. When a new value is entered, the 
plot is redrawn to reflect the new value upon exiting the dialog.

Performance

Use zoom/rotate 
bounding box

When this box is checked, the plot is temporarily replaced by a box during zoom and 
rotation operation. When the operation is completed, the plot is redrawn. Checking this 
box increases performance on computers with slower graphic subsystems.
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Figure 110. 3D Properties – Zoom/rotate bounding box

3D Properties Axis

This dialog lets you set up axis limits for your 3D plot.

Figure 111.  3D Data Graphic Properties – Axis Setup dialog box
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3D Plot Rotation Options

A right-click the 3d plot provides a menu containing various rotation options. When you 
select one of these rotation options, a checkmark appears next to the option and that rotation 
option becomes active on the plot. 

Figure 112. 3D Plot Rotation Options menu

The cursor changes to indicate the option is in effect.

Parameter Description

Limits Enter the limits for the 3D plot.

Time Select the Autoscale checkbox if you want to have the software 
automatically scale the time axis to the maximum values. To enter 
a manual range, de-select the autoscale box, and add your own 
limits, or click the Get Limits button to enter the limits displayed 
on the current 3D graph.

Wavelength Select the Autoscale checkbox if you want to have the software 
automatically scale the wavelength axis to the maximum values. 
To enter a manual range, de-select the autoscale box, and add 
your own limits, or click the Get Limits button to enter the limits 
displayed on the current 3D graph.

Absorbance Select the Autoscale checkbox if you want to have the software 
automatically scale the absorbance axis to the maximum values. 
To enter a manual range, de-select the autoscale box, and add 
your own limits, or click the Get Limits button to enter the limits 
displayed on the current 3D graph.

Labels You can customize the labeling of the 3D plot using the 
parameters in this area. You can select font, size, color and style 
using the selections provided.
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Figure 113. 3D Plot rotation 

While the option is active, you can move the plot in the designated way by holding down the 
left mouse button and moving the mouse in the desired direction on the plot. When you have 
the plot in the desired position, click the right mouse button and turn off the option by 
selecting it again (checkmark removed). If you want to return to the original plot view, click 
the right mouse button and select Reset.

Contour View

The Contour Plot (also referred to as an Isoabsorbance Plot) provides an aerial view of the 
absorbance of the sample at each wavelength versus time. The contour view supplies quick 
and easy-to-assimilate information about those wavelengths at which the sample exhibits 
appreciable absorbance. With contour view, it is also possible to generate a Chromatogram 
View for an individual wavelength and a Spectrum View for a given point in time.

Figure 114. Contour view

Right-click inside the window to display the pop-up menu. Select Properties to display the 
Contour Properties dialog box.
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To generate a chromatogram view from contour view of Mixed View or 
Mixed View w/ 3D

1. Choose View > Spectral Views > Mixed View to display the Contour Map, 
Chromatogram, and Spectrum.

2. Move the cursor to the triangle-shaped handle located on the left- hand wavelength axis 
of the Contour Map and press the left mouse button.

3. Drag the cursor up or down to the desired wavelength and release the mouse button.

4. The chromatogram associated with the specified wavelength is displayed in the 
Chromatogram View. 

To generate a spectrum view from contour view of Mixed View or Mixed View w/ 3D

1. Choose View > Spectral Views > Mixed View to display the Contour Map, 
Chromatogram, and Spectrum.

2. Move the cursor to the triangle-shaped handle located on the time axis of the Contour 
Map and press the left mouse button.

3. Drag the cursor to the desired peak and release the mouse button.

The Spectrum associated with the specified retention time value is displayed in the 
Spectrum View.
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Contour Properties

A right mouse click anywhere on the contour plot, followed by selecting the Properties 
button displays a dialog where you can select the way the contour plot is displayed.

Figure 115.  Contour Graph – General dialog box
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Parameter Description

Style Select how you want the plot to appear, Grayscale or Color. 

Colors

Range Use this to select how the coloration of the plot is to be displayed. 
When Light & Dark Range is selected, alternating light and dark 
bands are used. When Full Spectrum is selected, then a 
continuous color spectrum is used.

Background Select the color to be used for the background of the plot.

Display

Detail This specifies the relative quality of the displayed contour plot. 
Less Display Detail results in faster rendering of the plot.

Print

Quality This specifies the relative quality of the printed contour plot. 
Coarse Print Quality results in faster printing.

Cursors The values in these boxes reflect the current contour cursor 
positions. When you change the values, the cursors on the plot is 
changed when you exit the dialog or when you click the Apply 
button.

Time This specifies the time position (X Value) of the cursor. When a 
value is entered, the X cursor is updated to the new position upon 
exiting the dialog.

Wavelength This specifies the wavelength position (Y Value) of the cursor. 
When a value is entered, the Y cursor is updated to the new 
position upon exiting the dialog.

Bandwidth This control specifies the wavelength band that is averaged when a 
chromatogram is extracted from the contour plot. The extracted 
chromatogram is an average of the absorbances at each wavelength 
in the wavelength band. The wavelength band is equal to the 
selected wavelength (see above) +/- one half of the bandwidth.
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Contour Axis Setup

You can change the setup of the axes for the contour plot using this dialog. If the Autoscale 
box is selected, the software automatically sets the axis parameter. If you want to enter the 
parameter manually, de-select the Autoscale box, then enter the range values, or click the Get 
Limits button to bring in the limits from the current view.

Figure 116. Contour Graph – Axis Setup dialog box
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Spectral Utilities

The Utilities menu allows displayed spectra to be printed, copied, saved or exported. The 
Utilities menu is available from the right mouse click menus of various Spectral views.

• Print

Select Print to automatically print the currently displayed spectra. 

• Copy to Clipboard 

Select Copy to Clipboard to copy the displayed spectra to the Clipboard. The contents of 
the Clipboard may then be pasted into other software.

• Save trace 

Select Save trace to save the spectrum to a file with an .spc extension for later inclusion in 
a library or report.

Parameter Description

Limits

Time Select the Autoscale checkbox if you want to have the software 
automatically scale the time axis to the maximum values. To enter 
a manual range, de-select the autoscale box, and add your own 
limits, or click the Get Limits button to enter the limits displayed 
on the current contour graph.

Wavelength Select the Autoscale checkbox if you want to have the software 
automatically scale the wavelength axis to the maximum values. 
To Contour Axis Setup

Absorbance Select the Autoscale checkbox if you want to have the software 
automatically scale the absorbance axis to the maximum values. 
To enter a manual range, de-select the autoscale box, and add 
your own limits, or click the Get Limits button to enter the limits 
displayed on the current contour graph.

Labels You can customize the labeling of the contour plot using the 
parameters in this area. You can select font, size, color and style 
using the selections provided.
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Spectrum Similarity Table

The Spectrum Similarity table is displayed in the PDA Mixed View when the Options Mode 
is set to Show Spectrum Similarity Table. Spectra are automatically added to and deleted from 
this table whenever a spectrum is added to and deleted from the Spectrum pane of the 
Mixed View.

Figure 117.  Spectrum Similarity table

Parameter Description

Spectrum Name This column displays identifications for each of the spectra added 
to the table. For spectra extracted from the 3D data, the 
identification includes the time. For spectra extracted from a 
chromatogram based on a peak name, the identification includes 
the peak name. For spectra loaded from a file, the identification 
includes the retention time.

A check mark next to the colored line for a spectrum indicates that 
the spectrum serves as the Reference Spectrum for the similarity 
calculation.

Spectra may be added to the table in the Mixed View by selecting 
the Add to Similarity Table from the Actions button menu.

Similarity This column displays the similarity of the spectrum on that row 
relative to the Reference Spectrum. The Reference Spectrum is 
determined by double-clicking on a row of the table or by 
highlighting a row and pressing the ‘Set Reference’ button.

Until a reference spectrum has been selected the similarity for all 
spectra in the table is zero.

Refer to the “Spectral Analysis and Calculations” on page 168 
for details on how this calculation is performed.
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Similarity Table Properties

Enter the wavelength range and data point spacing (in nm) for similarity calculations.

Figure 118.  Similarity Table Properties dialog box

Spectrum Source This column displays the source of the spectrum. (Current Data) 
refers to working spectra extracted form the current 3D data. 
When spectra come form a stored data file, this column displays 
the source filename.

Set Reference Pressing this button designates the spectrum in the currently 
highlighted row of the table as the new reference spectrum. The 
similarities for all of the rows is recalculated based on the new 
reference spectrum.

Print Pressing this button outputs a simple text report representation of 
the table to the default printer.

Properties Pressing this button displays a dialog with parameters related to 
the calculation of similarity.

Parameter Description

Note  During analysis, it is possible that a portion of this wavelength range is outside the 
range of the acquired data. In that case, the wavelength range is truncated to the limits of 
the acquired data.
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Spectral Library Definition

This window appears when you choose the File > Spectral Library > New command. It is 
used to define a spectral library that can be used with the Library Search option. In order to 
define a library, you must have spectrum files (.spc) on your datasystem PC or you can create 
a library from the spectra obtained during the current run.

Figure 119.  Spectral Library Definition dialog box
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Parameter Description

Spectrum Data Source Click the arrow  in this field to select Current Data, 
Spectrum File, or Named Peak.

To add a spectrum from a spectrum file, the spectrum must have 
been previously saved as a file with an .spc extension. You can 
create spectrum files from your current data file by choosing the 
Utilities > Save Trace command from the pop-up menu in the 
Spectrum pane.

If you chose to enter a spectrum from the current data file, a 
dialog appears where you must type the retention time from 
which you want the spectrum extracted.

Component Name Enter the chemical name or description of the spectrum. This 
field is used for display and search pre-filter purposes.

Lambda Max From ... 
To

The wavelength range of the spectrum over which the software 
calculates the lambda (absorbance) max value is displayed in these 
columns.

Retention time When the spectrum was extracted from a chromatographic run, 
the software automatically identifies the retention time of the 
spectrum and enters the value in this field. When desired, the 
value in this field may be edited. This field can also be used as a 
search pre-filter.

Comment Enter any descriptive information desired related to the spectrum. 
This field is used only for display and documentation purposes.

Library notes This field is used to document relevant information about the 
library as a whole, e.g., documentation about run conditions or 
general sample information.

Note  Fields in existing library entries may be edited by selecting the fields with the cursor. 
Right-click a row in the library table to display a pop-up menu used to cut, paste, copy, 
and insert and delete lines from the library as necessary.
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Spectrum Information

If you chose to enter a spectrum into your library from the current data file, this dialog 
appears where you must select the retention time at which you wish to select the spectrum.

Figure 120. Spectrum Information – Spectrum at Retention Time dialog box

Figure 121.  Spectrum Information – Named peak dialog box

How to Collect Spectra for a Library

To collect spectra for a library

1. Perform an acquisition using a sample with known components or standards to be placed 
in the library.

2. Perform an analysis using the appropriate integration parameters. (Ideally, Spectral 
Background Correction would be checked in the Method > Spectral Options > 
Spectrum tab.)

3. Using the contour plot in the Mixed View window, drag the vertical cursor to the apex of 
a peak to display the corresponding spectrum in the spectrum view (Figure 122). See also 
“Contour View” on page 146.

4. Right-click within the spectrum view to display the Spectrum pop-up menu, choose 
Utilities > Save Trace, and enter a file name in the dialog box. Repeat this procedure for 
each spectrum to be added to the library. Files are saved automatically with the .spc 
extension.

Note  To add the 1st or 2nd Derivative of a spectrum to the library, select the appropriate 
filter in the Method > Spectral Options > Spectrum tab and repeat steps 3 and 4.
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How to Add Spectra to a Library

To add spectra to a library

1. When all of the spectra are saved as .spc files, choose File > Library > New to display the 
Library Definition dialog box and create a new library. Alternatively, choose 
File > Library > Open to add spectra to an existing library.

2. Click in the Spectrum File cell of row 1 to display the Open dialog box. Double-click the 
appropriate .spc file in the list box. The .spc file name is entered into that cell and the 
associated spectrum is simultaneously displayed. A component name and comment may 
be entered in the appropriate columns. Repeat this procedure with subsequent rows in the 
table until all spectrum files are entered into the library. 

3. Choose File > Library > Save As and enter a name for the library. The .lib extension is 
automatically appended.

How to Perform a Manual Library Search

To perform a manual library search

1. In the Contour map of the Mixed View window, drag the vertical cursor to the apex of 
the peak of interest to display the corresponding spectrum in the spectrum pane.

2. Choose Actions > Search library. Click either Method to use the library parameters 
from the method, or Quick to enable you to modify the search parameters. Before you do 
the search, make sure you have either selected a library in your method, or have opened a 
library to do a quick search.

Click Search Now to display the Library Search Results window, showing the three 
closest matches in the specified library. When appropriate, click the >> or << button to 
display additional matches.
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Spectral Library Search

This window appears when you choose the Actions > Search Library command from the 
Mixed View window. It allows you to perform a library search on a spectrum you have 
selected in the contour map, and also lets you select a spectrum from the current data or 
stored spectrum file to search.

Figure 122.  Spectral Library Search – Params dialog box

Parameter Description

Hits Displayed Select the number of hits you wish to display. Hits is displayed in order of similarity.

Search Select Method if you want to use the parameters from the current method for your search. 
Select Quick if you want to enter or change the parameters yourself before the search.

Search Now When you click this button, a library search is performed on the selected spectra using the 
parameters, and the number of hits requested is displayed.

Display Parameters Click this button if you want to display the parameters. If you always use the method 
parameters, you may not wish to display them when you search.

Search Spectrum Click the arrow to select a new spectrum to search on. You can choose from the current 
data, or from a stored spectrum file. The current spectra source is displayed.
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Search Parameters This tab contains search parameters. If you have elected to use the Method search 
parameters, the parameters displayed are those in your current method in the Spectral 
Options > Library tab. If you have elected to do a Quick search, the parameters are default 
parameters.

• Wavelength range

These specify the wavelength range over which the library search is performed.

• Wavelength step

This specifies the data point spacing to be used when a library search is performed.

• Max hits

This specifies the number of hits that is reported in the results of a library search. Note 
that this works in conjunction with the Similarity Threshold parameter to limit the 
number of hits reported.

• Similarity threshold

Specifying a value for this control will cause the library search results to only display 
matches whose similarity to the unknown exceeds this value. Note that this control 
works in conjunction with the Max Hits parameter to limit the number of hits reported.

• Library

Displays the library from the method or for Quick enables you to select a library to be 
used.

Parameter Description
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Custom Report
A variety of spectral information can be placed in a custom report. These items are inserted in 
the report by placing the cursor at the location where you want to insert the item, then do a 
right mouse click to access the custom report menus.

Spectral Insert Graph Items

The Insert Graph menu has the following additional items available when the Spectral 
Option is enabled: 3D Data Graph, and Contour Graph.

3D Data Graph

The 3D View provides a three-dimensional view of absorbance versus time and wavelength. 
Wavelengths of appreciable absorbance and interferences, which may be invisible in a single 
wavelength plot, are easy to locate with the 3D View. Select this function to automatically 
enter the 3D map into the report. Click the right-mouse button within the 3D map and select 
Properties to display the 3D Properties dialog box and enter appropriate changes

The 3D map can be elevated and rotated around its axis for display from any angle. These 
functions work the same as in the 3D view window. 

Pre-Filters When Quick is selected as the Search Mode, the items on this tab allow the user to specify 
search pre-filters that is performed on library spectra prior to the test for similarity. All 
pre-filters are optional. If Method is selected as the Search Mode, the items on this tab are 
read-only and reflect the parameters values on the Library tab of Spectral Options.

• Retention time range

When a Retention Time Range is specified, library search is restricted to those library 
entries whose retention time is within the specified range. Entries outside this range are 
automatically excluded from the search (no similarity calculation is made). Entering a 
value for this is optional.

• Lambda max

When one or more of these values is specified, library search is restricted to those library 
entries containing a lambda max within 5 nm of one of the specified values. Entries 
without a matching lambda max are automatically excluded from the search (no 
similarity calculation is made). Entering values for this is optional.

• Compound name filter

When a Compound Name Filter is specified, library search is restricted to those library 
entries whose name contains the specified string as a case-insensitive sub-string. Entries 
without a matching sub-string are automatically excluded from the search (no similarity 
calculation is made). Entering a value for this is optional.

Parameter Description
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A data file containing Spectral data may include a Contour Plot in a custom report. The 
contour view (also referred to as Isoabsorbance plot) provides an aerial view of the absorbance 
of the sample at each wavelength vs. time. The contour view supplies quick and 
easy-to-assimilate information about those wavelengths at which the sample exhibits 
appreciable absorbance. 

Changing parameters for the contour graph in a custom report works exactly as in the 
Contour view. 

Spectral Insert Report Items

When the Spectral option is enabled, the following report items are available to insert into a 
custom report: Library Search Report, Purity Report, and Spectrum Report.

Library Search Report

To insert a Library Search Report, right-click in the custom report. Then choose Insert 
Report > Library Search Report from the popup menu. This command inserts a table of 
library search results in your custom report. 

To modify the parameters of the report, right-click in the Library Search Report table, and 
select Properties. Figure 123 is an example of the dialog box that appears.

Figure 123.  Library Search Report Properties dialog box
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Parameter Description

Search Libraries for This specifies what peaks should be searched for the report. 

Apex spectra of peaks When selected, the Specific Spectrum button is disabled. 

• Detected on

This allows the user to select the channel or channels from 
which peaks are detected.

• Limit to named peaks only

This allows the user to restrict the peak selection (made 
above) to a time range. When checked, only peaks within the 
specified time range is searched When this box is unchecked, 
the Time Range edit fields are disabled. 

• Limit to time range

This allows the user to restrict the peak selection (made 
above) to a time range. When checked, only peaks within the 
specified time range is searched. When this box is unchecked, 
the Time Range edit fields are disabled.

• Time range

This allows the user to restrict the peak selection (made 
above) to a time range. When the Limit to time range box is 
unchecked, these fields are disabled.

A specific spectrum When selected, the other controls of this group are disabled. 

Pressing this button displays a menu allowing the user to specify 
the spectrum to be searched. The menu allows you to specify a 
spectrum based on one of the following choices: Current Data, 
Named File, or Spectrum Peak.

Spectral display The in this group specify the layout of the search results graphs.

Graph height This specifies the relative height of a search results graph. A value 
of 100% corresponds to a standard sized graph. A larger value may 
be selected to provide more a detailed plot.

Graph Properties Pressing this button displays the graph properties dialog as found 
on the standard Spectrum graph. 
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Selecting this option inserts a Library Definition Report into your custom report. To specify 
parameters for the report, do a right-click in the report table, and then select Properties. 
Figure 124 is an example of the dialog box that appears.

Figure 124. Library Definition Report Properties dialog box

Enter or select the library you wish to include in the report, and then click OK.

Purity Report

Selecting this option inserts a Purity Report into your custom report. To specify parameters 
for the report, do a right-click in the report table, and then choose Properties. Figure 125 is 
an example of the dialog box that appears.

Figure 125. Purity Report Properties dialog box
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Parameter Description

Report peak purity

Detected on This allows you to select the channel or channels from which 
peaks are detected.

Limit to named peaks 
only

This allows you to restrict the peak selection (made above) to a 
time range. When checked, only peaks within the specified time 
range is searched When this box is unchecked, the Time Range 
edit fields are disabled. 

Limit to time range This allows the user to restrict the peak selection (made above) to 
a time range. When checked, only peaks within the specified time 
range is searched. When this box is unchecked, the Time Range 
edit fields are disabled.

Time range This allows the user to restrict the peak selection (made above) to 
a time range. When the Limit to time range box is unchecked, 
these fields are disabled.

Graph

Graph Properties Pressing this button displays the graph properties dialog as found 
on the standard graph. 

Height This specifies the relative height of a search results graph. A value 
of 100% corresponds to a standard sized graph. A larger value may 
be selected to provide more a detailed plot.
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The Spectrum report displays a table showing spectra extracted from peaks of the 
chromatogram. Based on the selection on the Spectrum tab of Spectral Options, the report 
contains either the apex spectrum, an average of the upslope, apex and downslope spectra, or 
several averaged spectra. To set parameters for this report, right-click the table. Then, choose 
Properties. Figure 126 is an example of the dialog box that appears.

Figure 126.  Spectrum Report Properties dialog box

Parameter Description

Report peak spectra

Detected on This allows you to select the channel or channels from which 
peaks are detected.

Limit to named peaks 
only

This allows you to restrict the peak selection (made above) to a 
time range. When checked, only peaks within the specified time 
range is searched When this box is unchecked, the Time Range 
edit fields are disabled. 

Limit to time range This allows the user to restrict the peak selection (made above) to 
a time range. When checked, only peaks within the specified time 
range is searched. When this box is unchecked, the Time Range 
edit fields are disabled.

Time range This allows the user to restrict the peak selection (made above) to 
a time range. When the Limit to time range box is unchecked, 
these fields are disabled.
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Report information Checking any of these controls indicates that the indicated value is 
calculated and printed to the right of the graph. Deselecting 
options that are not of interest speeds up analysis.

Peak area Checking this indicates that the peak area should be printed to the 
right of the spectrum graph.

Lambda max Checking this indicates that the three largest lambda max values 
should be printed to the right of the spectrum graph.

Lambda min Checking this indicates that the three largest lambda min values 
should be printed to the right of the spectrum graph.

Purity Checking this indicates that total peak purity should be printed to 
the right of the spectrum graph.

3 Point Purity Checking this indicates that 3-point peak purity should be printed 
to the right of the spectrum graph. 

Similarity Checking this indicates that peak apex similarity to the reference 
spectrum should be printed to the right of the spectrum graph. 
The use of this value requires that a reference spectrum be 
included in the peak table. See Spectral Analysis and Calculations 
for details. 

Spectral display The controls in this group specify the content and labeling of the 
spectrum graphs.

Show lambda maxima Checking this box annotates each spectrum graph with the three 
largest lambda max absorbance.

Show lambda minima Checking this box annotates each spectrum graph with the three 
largest lambda minima absorbance.

Background correction Checking this option causes each apex spectrum to be corrected 
for background using the chromatographic baseline prior to being 
used elsewhere in analysis. Refer to “Spectral Analysis and 
Calculations” on page 168 for details on the formula used. 

Filtering type This allows the user to specify a mathematical filtering function to 
be performed on all spectra extracted from the 3D data during 
analysis. Refer to “Spectral Analysis and Calculations” on 
page 168 for details on the formula used for each filter.

Graph height This specifies the relative height of the spectrum graph. A value of 
100% corresponds to a standard sized graph. A larger value may 
be selected to provide more a detailed plot.

Graph properties Pressing this button displays the graph properties dialog as found 
on the standard Spectrum graph. 

Parameter Description
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Peak Table
When using the Spectral option, certain columns are added to the peak table that enable you 
to analyze peaks from the PDA or scanning detector.

There is one Peak/Group Table per detector. To analyze a peak at multiple wavelengths, you 
must enter the peak multiple times in the Peak Table, and then select the appropriate Analysis 
Channel for each entry. 

For convenience, you might want to label each entry for a peak with a distinguishing label 
that helps you identify its associated Analysis Channel.

Figure 127. Peak table

Parameter Description

Detection Select the basis for the identification of the peak. If you select Ret Time, only the retention 
time is used for identification of the peak. If you select Ret Time with Spectral Confirm, 
the Similarity of the peak’s spectrum to that of a designated reference spectrum is used in 
addition to the retention time as the basis of peak identification. 

Spectrum If you want Similarity to be used as a basis for peak identification, then click the arrow to 
the right of this field to specify the stored reference spectrum to be used for comparison. 
During identification, this reference spectrum is compared to the peak apex spectrum and a 
similarity index is computed. A peak is considered identified if this calculated similarity 
index is at least the value specified in the Similarity column of the peak table. 

If Similarity is not specified as a basis for peak identification, then this field is ignored.

Similarity If Similarity is specified as a basis for peak identification, then this field specifies required 
minimum similarity index for a peak to be considered identified. During identification, the 
reference spectrum (see previous section) is compared to the peak apex spectrum and a 
similarity index is computed. A peak is considered identified if the calculated similarity 
index is at least the value in this field.

If Similarity is not specified as a basis for peak identification, then this field is ignored.
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Spectral Analysis and Calculations
This section describes the various types of calculations that are related to spectral data and 
how the data is analyzed.

General

In order to maintain accuracy during the application of multiple operations, all calculations 
are performed using double-precision floating-point numbers.

Chromatograms Extracted from the 3D Data

Two types of chromatograms may be extracted from the 3D data:

• Multi-Chromatogram Channels

One or more chromatograms defined on the Multi-Chromatogram tab of Spectral Options.

• Working Chromatogram

A single chromatogram extracted from the Contour plot on the Mixed View display. 
(This chromatogram is displayed in the Chromatogram View).

Specific Analysis-related capabilities for these chromatograms are detailed below.

Analysis Channel Specify which wavelength channel is to be used for analysis of the peak. The choices are 
those specified in method for the detector and shown in the Analysis Channel list box. For 
the PDA detectors, you can analyze data on any of the multi-chromatogram channels 
within the scan range, as well as the three discrete channels.

The following detectors are capable of performing scans:

• SpectraSYSTEM UV3000 scanning detector

• SpectraSYSTEM UV6000 photo-diode array detector

• Surveyor PDA detector

• Surveyor PDA Plus detector

Parameter Description
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Multi-Chromatogram Channels

The following apply to multi-chromatogram channels:

• In the Channel Selection drop down list, each multi-chromatogram channel has a unique 
identifier that includes the wavelength and bandwidth of the channel.

• Each Multi-Chromatogram Channel has a separate Integration Events Table and Manual 
Integration Fixes Table associated with it.

• All Multi-Chromatogram Channels and discrete channels share a common peak and 
group table, a common Export tab, and a common Column/Performance tab. Within the 
peak and group tables, any channel can be selected as the analysis channel for quantitative 
information.

• When an analysis is performed, all multi-chromatogram channels are automatically 
analyzed.

• Each multi-chromatogram channel is an average of the absorbances monitored at each 
wavelength in the wavelength range. The wavelength range is equal to the selected 
wavelength +/- one half of the bandwidth. 

Working Chromatogram

The following apply to the working chromatogram:

• In the Channel Selection drop down list, a single entry is added that identifies the 
channel as applying to the working chromatogram.

• This channel has a separate Integration Events Table and Manual Integration Fixes 
Table.

• When an analysis is performed, the working chromatogram is automatically analyzed.

• The working chromatogram is an average of the absorbances monitored at each 
wavelength in the wavelength range. The wavelength range is equal to the selected 
wavelength +/- one half of the bandwidth. 

• The working chromatogram is not available as a trace in Custom Reports.

Spectra Extracted from the 3D Data

Two types of spectra may be extracted from the 3D data:

• Analysis Spectra

One or more spectra automatically extracted from the 3D data during analysis and used 
for peak identification, similarity and/or library search. 

• Working Spectrum

A spectrum extracted from the Contour plot on the Mixed View display. (This 
chromatogram is displayed in the Spectrum View)
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Specific Analysis-related capabilities are for these spectra are detailed below.

Analysis Spectra

The following applies to the analysis spectra:

Prior to being used elsewhere, all spectra extracted from the 3D data are filtered according to 
the settings on the Spectrum tab of Spectral Options. 

Working Spectrum

The following apply to the working spectrum:

Working spectra extracted from the 3D data are never filtered according to the settings on the 
Spectrum tab of Spectral Options. 

The working Spectrum is not available as a trace in Custom Reports. 

Spectrum Operations

The following table describes what operations can be done on what type of spectra.

Background Correction

Background Correction may only be performed on a spectrum by using the settings on the 
Spectrum tab of Spectral Options, or the settings on the Purity tab of Spectral Options, by 
selecting Operations > Background Correction from the Spectrum View context menu or 
by setting the properties of the Spectrum Report.

Background subtraction is always the first operation performed on a spectrum. If a 
background correction is attempted on a spectrum after another operation has already been 
performed (including an operation specified in the Spectrum tab of Spectral Options), a 
message box is displayed and the background correction request ignored.

Available Operations
Raw Spectra 
(no filtering or 
operations)

Smoothed, 
1st Derivative and 
2nd Derivative Spectra 

Interpolated 
Spectra

Search against Libraries Yes

Similarity Yes

Peak Identification using 
spectral confirmation

Yes, but generate an error if the operations that were performed 
on the reference spectrum do not match the current method.

Appear in Reports Yes Yes, but label must include what operations 
were performed

Purity Yes No

Add to Spectrum Library Yes No
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Background subtraction can only be performed once on a spectrum. If a second background 
correction is attempted on a spectrum after the operation has already been performed 
(including the operation specified in the Spectrum tab of Spectral Options), a message box is 
displayed and the background correction request ignored.

To perform background correction

1. The spectra from the baseline start and baseline stop times for the peak are extracted from 
the 3D data. The Max Plot is used to determine the peak that is used. 

2. For each spectrum in the peak, a corresponding background spectrum is generated by 
linear interpolation between the baseline start and baseline stop spectra. 

3. These background spectra are subtracted from the original spectra. 

Spectrum Interpolation

Spectrum interpolation can be performed on a spectrum by choosing the appropriate settings 
on the Spectrum tab of Spectral Options or by choosing Operations > Interpolate from the 
Spectrum View context menu.

Interpolation can only be performed once on a spectrum. If a second interpolation is 
attempted on a spectrum after the operation has already been performed (including the 
operation specified in the Spectrum tab of Spectral Options), a message box is displayed and the 
interpolation request is ignored.

Interpolated spectra can not be stored in spectrum libraries. 

The calculation is performed by doing a 10:1 interpolation of the spectrum data points using 
a cubic spline curve fit. This interpolation is performed after the applying any spectral 
filtering option (1st derivative, 2nd derivative or smooth) to the spectrum.

Spectrum Smoothing

Spectrum smoothing can be performed on a spectrum by choosing the appropriate settings on 
the Spectrum tab of Spectral Options or by choosing Operations > Smooth from the Spectrum 
View context menu.

Interpolation can be performed repeatedly on a spectrum. 

The calculation is performed by doing a 9-point Savitsky-Golay smooth on the spectrum data 
points. 

Spectrum Derivatives 

Calculation of the 1st and 2nd derivatives of a spectrum can be performed on a spectrum by 
choosing the appropriate settings on the Spectrum tab of Spectral Options or by choosing 
Operations > Smooth from the Spectrum View context menu.

Derivatives can be computed repeatedly on a spectrum. 
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The absorbance values of the 1st derivative of a spectrum are computed by calculating the 
differences between adjacent absorbance values to create a new spectrum. The 2nd derivative 
of a spectrum is defined as the 1st derivative of the 1st derivative of the spectrum.

Upslope and Downslope Spectra

The upslope and downslope spectra of a peak are identified by calculating the second 
derivative of the portion of the chromatogram containing the peak. The two times at which 
the second derivative plot crosses zero are known as the inflection points. For normal peaks 
(i.e. non-Negative peaks), the Upslope Spectrum is the spectrum at the time represented by 
the first inflection point, while the Downslope Spectrum is the spectrum at the time 
represented by the second inflection point.

Library Search Calculations

General

During analysis, if one or more search libraries are defined on the Library tab of Spectral 
Options, then an automated library search is performed on every integrated peak of every 
spectral analysis channel.

In this section, a Query Spectrum is defined the unknown spectrum that is being searched. A 
Reference Spectrum is defined as a spectrum from a spectrum library file.

During a search, the apex spectrum of the peak (the query spectrum) is compared to each 
spectrum contained in the libraries (reference spectra) to determine the similarity of the query 
spectrum to the reference spectrum. The similarity is quantified through the calculation of a 
Similarity Index for each query/reference pair. The Similarity Indices are used to generate a 
hit list of the best matching entries. A perfect match will have a Similarity Index of 1.0000. 
Similarity indices less than 1 indicate differences in the spectral patterns. 

If the query spectrum and the reference spectrum have different wavelength ranges, then the 
intersection of the two ranges is used in the similarity calculation.

If the query spectrum and the reference spectrum have different wavelength steps, then the 
higher resolution spectrum is de-resolved to match the other spectrum before being used in 
the similarity calculation.

Note  Unless a Library Search Results object is part of the method custom report, no 
automated library searching will done when analysis is performed.
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A pre-filter is a criterion on a reference spectrum that must be met before that spectrum is 
used in similarity calculations. One or more pre-filters may be specified in the search 
parameters. When multiple pre-filters are specified, a reference spectrum must meet all of the 
individual pre-filters in order to be considered for similarity calculations.

Reference spectra that do not meet all of the pre-filter criteria are automatically excluded from 
calculations and from being a candidate for a hit list. No similarity calculation is performed 
on these spectra.

The following pre-filters are supported:

• Retention Time Range

When a Retention Time Range is specified, a reference spectrum is excluded unless the 
retention time for the spectrum in the library is within the specified range.

• Lambda Max

Up to three Lambda Max values may be specified. When one or more Lambda Max 
values are specified, a reference spectrum is excluded unless all of the specified maxima are 
within 5 nm of a maxima for the spectrum in the library.

• Compound Name

When a Compound Name is specified, a reference spectrum is excluded unless the 
specified string is a case-insensitive sub-string of the compound name for the spectrum in 
the library.

Ratio Chromatogram Calculation
The ratio chromatogram plot consists of data points calculated as follows:

where

abs1 = the absorbance in chromatogram 1 at this wavelength

abs2 = the absorbance in chromatogram 2 at this wavelength

If the absorbance of any point in chromatogram 1or chromatogram 2 is less than the 
threshold, the Ratio Pt. for that wavelength is set to 0.

Ratio Pt. abs1 ⁄ sqrt abs1 ∗ abs1 abs2 ∗ abs2+( )=
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Similarity Calculations
The Similarity Index (SI) compares two spectra across the wavelength range defined in 
Method > Spectral Options > Library. A Library Search is performed using the Similarity 
Index, determined as follows:

where 

Ci = (Si – Avg(S)) / StdDev(S) 

C’i = (S’i – Avg(S’)) / StdDev(S’)

n is the number of points, S is one of the spectra, and S’ is the other spectrum.

Note that each spectral data point is first reduced by the amount of the average of all data 
points in the spectrum. This is called mean-centering. Each data point is also divided by the 
standard deviation of all data points in the spectrum, which has the effect of normalizing the 
resulting values (scaling them to the range of zero to one). So, in the above equations, C and 
C’ are the normalized mean-centered spectra.

Lambda Max/Min Calculations
A lambda max (min) is defined as a local maximum (minimum) of the absorbance values of a 
spectrum. The user must define the wavelength range over which the calculation should be 
performed.

To compute n lambda max (min) values for a spectrum, the software finds the n local maxima 
(minima) with the largest (smallest) absorbance values. 

Peak Purity Calculations
The purity of a peak is calculated by comparing the every spectrum to the apex spectra using 
the similarity calculation. Only those spectra that meet the Threshold and Peak Coverage 
criteria selected in the settings on the Purity tab of Spectral Options is used for the calculation 
of peak purity. The lowest value is reported as the peak purity value.

If the peak is pure, or at least homogenous, all spectra across the peak should be identical after 
normalization. In this case, the peak purity value would be 1.000. Normally “pure” peaks 
have a peak purity value of 0.990 to 1.000, but this is only a probability as the purity value 
depends on a number of factors. These factors include the similarity of the spectra of the 
compound of interest and any impurity, the concentration levels of each impurity, the 
resolution between possible peak components and the accuracy of the integration as well as 
the relative molar absorbtivity of between the compound and each impurity.

Similarity Sum Ci ∗ C,
i( ) ⁄ n 1–( )=
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Peaks with purity values below 0.950 have a high probability of being impure. Peaks with 
values between 0.950 and 0.990 can be suspected of being impure, but more experiments are 
needed. Peaks with values above 0.990 are probably pure, subject to the limitations of the 
technique.

Background Correction

Background Correction may only be performed on a spectrum by using the settings on the 
Spectrum tab of Spectral Options, or the settings on the Purity tab of Spectral Options, by 
selecting Operations > Background Correction from the Spectrum View context menu or 
by setting the properties of the Spectrum Report.

Background subtraction is always the first operation performed on a spectrum. If a 
background correction is attempted on a spectrum after another operation has already been 
performed (including an operation specified in the Spectrum tab of Spectral Options), a 
message box is displayed and the background correction request ignored.

Background subtraction may only be performed once on a spectrum. If a second background 
correction is attempted on a spectrum after the operation has already been performed 
(including the operation specified in the Spectrum tab of Spectral Options), a message box is 
displayed and the background correction request ignored.

To perform background correction

1. The spectra from the baseline start and baseline stop times for the peak are extracted from 
the 3D data. The Max Plot is used to determine the peak that is used, if there is on other 
relevant trace. For the Spectrum view, the peaks are taken from the current working 
chromatogram that appears in the Chromatogram pane. For the Spectrum Report, the 
trace that is specified in the report properties is used.

2. For each spectrum in the peak, a corresponding background spectrum is generated by 
linear interpolation between the baseline start and baseline stop spectra. 

3. These background spectra are subtracted from the original spectra. 

Note  While compensation for background provides more precise purity calculations, it 
can slow down re-analysis of large data files.
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Calculating Total Purity

To calculate total purity

1. Each spectrum in the peak is evaluated to see if it meets the peak threshold and peak 
coverage criteria.

2. A similarity index is calculated on all the spectra that pass step 1 compared to the apex 
spectraum.

3. The lowest similarity index value is determined. 

4. That value is reported as the purity index.

5. The purity index has a range of between 0.000000 and 1.000000

Three Point Purity

Three Point Purity is calculated by comparing the spectrum at the apex of a peak (Point 1) 
with the spectra at the up-slope (Point 2) and down-slope (Point 3) of the peak. The up-slope 
spectrum is defined as the spectrum located 20% of the peak width from the peak start. The 
down-slope spectrum is defined as the spectrum located 20% of the peak width from the peak 
end.

Similarity indices are generated for the up-slope and down-slope spectra, relative to the apex. 
Since spectra taken at different points along a pure peak will look identical, they will have 
high similarity indices. The closer the Similarity Index is to 1.0000, the more similar or more 
pure the peak is deemed to be.

Timeup Timestart Timeapex Timestart–( ) ∗ 1 5⁄+=

Timedown Timeapex Timeend Timeapex–( ) ∗ 4 5⁄+=
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Converting PC1000 Archive Files to 
ChromQuest Files

In every PC1000 sequence (either one injection or more than one), there is a result file (.res), 
which is basically a pointer file which denotes the files which contain the actual data for the 
sequence.

These files are as follows:

• Acquisition method file (.aqm)

• Aalculation method file (.cam)

• Report method file (.rpm)

• Acquisition result file (raw data) for each injection (.aqr)

• Calculation result file for each injection (.car)

• and possibly a spectra library file (.slb)

When the PC1000 data is archived into an .arc file, all these various files are put inside one 
large file, for ease in transporting the data.

By contrast in ChromQuest, the data files (.dat) is associated with only one injection, and the 
conditions used to collect the data are also embedded in the file. Additionally, there are 
method files (.met) and spectral library files (.lib); the library files contain spectral files (.spc).

This organizational difference requires you to specify a particular PC1000 injection within 
the .arc archive file, when you perform the data conversion to ChromQuest.

Contents

• Data Conversion

• Data Conversion with Calculation Result

• Method Conversion

• Spectra Library Conversion

• PC1000 Archive File Run-Time Exception Handling

• Important Note on Data Conversion
Thermo Scientific ChromQuest Reference Guide 177



9 Converting PC1000 Archive Files to ChromQuest Files
Data Conversion

178
Data Conversion
To convert the original discrete channel and scan data (located in an .aqr file located inside 
the PC1000 .arc-file), to a ChromQuest  .dat file, simply go to the Open Data dialog box, 
select the desired archive file, and click Open. The Select Injections dialog box appears 
showing all available injections in the selected archive file.

You may highlight an item, double click it or press the Select button. ChromQuest displays 
acquisition results of the chosen injection. The figure shown below in ChromQuest is the 
converted data of an injection (one .aqr file) with scan data on the top and data from discrete 
channels displaying at the bottom. If your original .aqr file has only scan or discrete data, then 
only the data you have in the file, scan or discrete, are converted and displayed.

Figure 128.  Select Injections dialog box

Data Conversion with Calculation Result
If you open an archive file with Original Results selected in the Open Data dialog box, then 
chromatograms from the sequentially selected injection are opened with original PC1000 
calculation results (located in .car file), such as peak names, retention times, etc

Method Conversion
To access your calculation and acquisition method developed with PC1000, go to the 
Open Data dialog box (not the Open Method dialog box), select the archive file which 
contains the method, and check the Open with Method check box. You may select any 
injection from the Select Injections dialog box. Your original calculation method (in .cam 
file), such as peak names and expected retention times are displayed in Peak / Group Tables. 
The instrument setup (in .aqm file) is merged into the Instrument Setup property sheets.

Note  If your LC system configuration does not have all the modules in your acquisition 
method, you will see the following type of message box.
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Figure 129. Instrument Setup property sheet

Consequently, the portion of the method which is associated with those missing modules, will 
not be opened. To complete your acquisition method conversion, you need to reconfigure 
your LC system by adding the missing modules. Once you are satisfied with the opened 
method, make sure to save it as a ChromQuest method (.met) file for future use.

Spectra Library Conversion
To convert a spectra library (located in .slb file), go to the Open Library dialog box, select the 
archive file which contains a spectral library. The spectral library are displayed. When you 
save it in ChromQuest library format (.lib), your original library name is suggested as the 
default name.

However, if the selected archive file has no spectra library in it, you will see the following 
message boxes:

Figure 130.  Spectra Library Conversion - Missing message 

Figure 131. Spectra Library Conversion - Invalid version message
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PC1000 Archive File Run-Time Exception Handling
When you try to convert a problematic archive file, ChromQuest informs you with message 
boxes reporting errors it has encountered when reading the archive.

You can continue to work on other tasks, for instance, convert another PC1000 archive, after 
these error messages.

Important Note on Data Conversion
The intention of this conversion routine is for PC1000 users to view and then convert their 
data, methods, and libraries to ChromQuest format. If you only want to see what an archive 
file contains, simply open, examine, and close it without saving. However, if you wish to 
manipulate your data, such as add traces from another data file and so on, you need to save 
your file into ChromQuest format and then work on the new file. The conversion covers 
archives generated with PC1000 releases version from the current version (PC1000 Ver 3.5.1) 
back to version PC1000 Ver 2.5. 
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Advanced Reporting Formulas

This chapter gives details on formulas available in the spreadsheet engine used in the 
Advanced Reports of ChromQuest. 

 Spreadsheet Formulas
Formulas are the backbone of the spreadsheet, establishing and calculating mathematical 
relationships between elements of the spreadsheet. Whereas numeric entries remain the same 
until you change them, cells defined by formulas are automatically changed to reflect changes 
in referenced cells - even where there are complex interdependencies among cells.

Spreadsheet formulas can calculate with numbers, text, logical values, cell references, and 
other formulas. For example, you can easily calculate the sum of a series of cells, the total of 
values in a column, a minimum or maximum value within a range, the rounded result of 
another formula, or the absolute value of a cell entry. Formulas can express complex 
interdependencies among cells, and they can define constraints on the calculation, such as 
limits on acceptable values or specific conditions under which a calculation should take place.

Once entered in a cell, formulas are hidden behind the scenes, perform their work in the 
background, and display only the result of their calculation. To view the formula in a cell, 
simply select the cell. Spreadsheet also provides an option that lets you make all formula 
expression visible (via CGXGridParam::m_nDisplayExpression).

Spreadsheet also provides a wide array of functions that perform certain tasks. Functions can 
be used alone or in conjunction with formulas and other functions. Spreadsheet provides 
many specialized functions in addition to those that are found in typical financial 
spreadsheets.

Contents

•  Spreadsheet Formulas

• Built-in Functions

• Quick-Reference Guide to Built-in Functions

• Using Spreadsheet Built-in Functions

• Spreadsheet Error Messages
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Formula Syntax

The general form of a Spreadsheet formula is:

= expression ; constraint expression // comment

where expression defines the calculations needed to generate the cell's value, constraint 
expression places limits on acceptable values or the circumstances under which the calculation 
should take place, and comment is any text you want to attach to the cell.

The expression part of Spreadsheet formulas looks just like an algebraic formula; it contains 
values and operators that define the relationships between values.

Spreadsheet uses the following conventions for formulas:

• A formula must begin with an equal (=) sign. When you begin typing into a cell, 
Spreadsheet automatically assumes that you are typing a formula if you start with one of 
the following characters:

0 1 2 3 4 5 6 7 8 9 . - @ =+

• Formulas can have as many as 511 characters. You can type spaces if you wish, but the 
spreadsheet automatically removes them.

Formula Values

Formulas can contain any or all of the following types of values:

• Numbers, such as 123, -123, 12.3.

• Addresses of single cells, such as A1, D5, Z100.

• Addresses of cell ranges such as B12..G29, A1..D5.

• Absolute cell references denoted with dollar signs before the fixed coordinate ($A$1, $A1, 
or A$1), which is not updated when the referencing cell is moved or copied.

• Spreadsheet functions, such as @SUM or @RADIANS, with their arguments.

• Text surrounded by double quotation marks, such as "The sum is " or "Total".

• User-defined cell names or cell range names, such as TOTALS or PROJECT1
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Formula Operators

Spreadsheet supports all the arithmetic, boolean and logical operators available in the 
C programming language. It does not support the C address operators or the operators that 
have side effects, such as ++. Spreadsheet provides two operators, exponentiation (**) and 
percent (%), that are not available in the C language.

Spreadsheet Formulas can contain the following operators to define relationship between 
values.

 Operator Precedence Definition

% 14 Unary percent

** 13 Exponentiation

+ 12 Unary plus

- 12 Unary minus

~ 12 Bitwise complement (integer)

! 12 Logical not

* 11 Multiplication

/ 11 Division

% 11 Remainder (integer)

+ 10 Addition

- 10 Subtraction

<< 9 Shift left (integer)

>> 9 Shift right (integer)

< 8 Less Than

> 8 Greater Than

<= 8 Less Than or Equal

= 8 Greater Than or Equal

== 7 Equal

!= 7 Not Equal

& 6 Bitwise And, or String Concatenation

^ 5 Bitwise Exclusive-Or (integer)

| 4 Bitwise Or

&& 3 Logical And

|| 2 Logical Or

?: 1 Conditional
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In formulas with more than one operator, Spreadsheet evaluates operators in the order of 
precedence presented above, with highest precedence first. That is, AND/OR/NOT operators 
are evaluated after inequality operators in a logical expression, and multiplication/division 
operations are performed before subtraction/addition operations in an arithmetic expression. 
Operators at the same precedence level are evaluated from left to right.

The precedence of operators can be overridden by using parentheses to explicitly specify the 
order of evaluation.

Here are some special notes about Spreadsheet operators:

• The operators marked ``(integer)'' on the table above automatically convert their 
operands to integers.

• The & operator performs double duty: as a bit-wise ``and'' if the operands are numbers 
or as a string concatenation operator joining two strings together if the operands are text.

• The % operator also performs double duty: as the ``percent'' operator when appended to 
a number or numeric expression, or as the C-style ``modulus'' operator when applied 
between two integer expressions.

• Operators that define equality/inequality relationships (such as == and < ) can be used to 
compare text strings lexically (alphabetically). In comparing mixed strings lexically, 
Spreadsheet considers string operands to be lower than numeric operands.

• The conditional operator returns its second operand if its first operand evaluates True 
(non-zero) and returns its third operand if it evaluates False, (zero).

• In formulas with conditional operators, the second and third operands may be any type 
the spreadsheet supports, including ranges. For example, the expression

=@SUM(A1 ? B1..C20 : C10..D15)

returns the sum of B1..C20 if A1 evaluates to non-zero; otherwise it returns the sum of 
C10..D15.

• Spreadsheet accepts most arithmetic operators used in other spreadsheets like MS Excel, 
but there are a few differences in syntax and precedence.

Referencing Other Cells in Formulas

The real power of Spreadsheet lies in its ability to calculate relationships among different cells 
in the spreadsheet by typing the row/column coordinates, or address, in the formula.

To reference a cell by address

Type the row and column coordinates of the cell in the formula. For example, to reference 
Row 5 in Column D, type D5.
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To reference a contiguous group of cells by address

Type the row and column coordinates of two cells in opposite corners of the block to be 
referenced, with two periods ( .. ) between the coordinates. For example, to reference the 
first five columns and the first five rows of the spreadsheet, type A1..E5.

Cell Referencing in Spreadsheet

Spreadsheet differentiates between relative, absolute, and indirect references. The latter is 
unique to Spreadsheet.

Relative Reference

Spreadsheet tracks the referenced cell by considering its position relative to the formula cell, 
not by its address. For example, if the formula in cell A1 references cell B2, Spreadsheet 
remembers that the referenced cell is one row down and one column right. If you copy the 
formula in cell A1 to another location (e.g., D17), the formula will reference the cell one row 
down and one column right of the new location (e.g., E18).

Absolute Reference

Absolute references remain the same, no matter where you move or copy the original formula. 
For example, if the formula in cell A1 references cell B2, and you copy the formula in cell A1 
to another location (e.g. D17), the formula still references cell B2. 

To specify an absolute cell address

Insert a dollar sign ($) before the address coordinate to be fixed, or before both 
coordinates if the row and column coordinates are to be fixed. For example: $B$2.

To specify all or part of a cell address to be absolute

Insert a dollar sign ($) before the address coordinate to remain fixed For example:

• B$5 makes the complete address absolute.

• B5 makes the column coordinate (B) absolute, the row coordinate (5) relative.

• B$5 makes the column coordinate (B) relative, the row coordinate (5) absolute.

Cell ranges are also relative, so when you move a cell range, references in formulas within that 
range are updated to reflect their new location.

To specify an absolute range reference

Insert dollar signs ($) before the coordinates in the formula. For example, to make the 
range A1..D5 absolute, type the reference as $A$1..$D$5.
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To specify part of a cell range to be absolute

Insert dollar signs only before the coordinates to remain absolute. For example, $A1..$D5 
fixes the column coordinates of cell references but adjust the row coordinates to reflect the 
new location.

To reference a cell or range by name

Type the pre-assigned name of the cell or cell block into the formula.

To assign a name to a cell or range of cells

Use the SetRangeName command.

Current Cell Reference

Certain expressions within the context of Spreadsheet require a means to express the 
current cell.

Examples include the conditional statistical functions described in "Built-In Worksheet 
Functions", and constraint expressions described in Section Constraint Expressions.

The current cell is identified in any expression with a pound sign (#). References to cells in the 
neighborhood of the current cell are made with offset values enclosed in braces ( {} ) following 
the #.

The offsets tell Spreadsheet where to look, in relation to the current cell, for the cell being 
referenced.

The format is as follows:

#{column offset, row offset}

If you include only one value in the offset, Spreadsheet assumes that it is a column offset. For 
example, the offset reference #{-1} tells Spreadsheet to look to the column just left of the 
current cell.

The offset values may be constants or expressions.
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Examples:

• 0,-1} refers to the cell above the current cell.

• 2} refers to the cell two columns left of the current cell.

• 1} refers to the cell to the right of the current cell.

• 0,1} refers to the cell below the current cell.

• CSUM(C4..C100, #{-1} == "Joe") calculates the sum of all the values in the range 
C4..C100 for which the cell in the column to the left contains the string ``Joe.''

• CCOUNT(C4..C100, # #{0,-1}) counts all the cells in the range C4..C100 whose value 
is greater than the contents of the cell immediately above.

• XVALUE("master.xs3", #) returns the value of the same cell reference in which this 
function is stored from the sheet indicated.

• verb/#-1+2/ adds 2 to the cell value from the cell to the left.

Constraint Expressions

Constraints are limitations or conditions placed on the variables in your spreadsheet. They are 
expressed as algebraic statements appended to formulas. You can attach a constraint 
expression to any formula, by typing a semicolon (;) and the constraint conditions after the 
formula.

Constraint expressions establish conditions under which a formula operates or boundaries for 
valid results of the formula. Constraint expressions may be simple equality/inequality 
relationships, or they can be arbitrary formulas. Any valid Spreadsheet expression which 
returns a numeric value is also a valid constraint expression. However, unlike the expression 
that defines a cell value, a constraint expression can reference the cell in which it resides, using 
the symbol #.

For example, the formula

=A1 + A2 ; #2 && #<=B5 || #==C7

means, ``the value of the current cell is the sum of cells A1 and A2, and that value must 
be either greater than 2 and less than or equal to the value of cell B5, or equal to the value 
of cell C7.''

Constraint expressions are used for example in the conditional statistical functions.

The benefit of constraint expressions is maximized when combine with current cell reference 
support

(#) as indicated in the above example.
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Explicit Dependency

There may be instances where you need to force a recalculation when certain cell values 
change, when there is no implicit dependency in the formula that would trigger an automatic 
recalculation. This option is indicated by appending a backslash (\) to the end of the 
dependent formula. For example, the formula:

=@SUM(A1..A20)\D50

instructs Spreadsheet to recalculate @SUM(A1..A20) whenever the contents of D50 
change. This feature is particularly important when you have a constraint expression 
containing an offset reference that produces a cell reference outside the cell range 
referenced in a dependent formula. Under these circumstances, Automatic Recalculation 
would not necessarily be triggered. Take for instance, the example from above.

@CCOUNT(C4..C100, # #{0,-1})

counts all the cells in the range C4..C100 whose value is greater than the contents of the 
cell immediately above. In order for C4 to be evaluated, it must be compared to C3 - 
which is not part of the explicit range, C4..C100. Without indicating an explicit 
dependency, C4 would never be evaluated properly. So, in this case, we would indicate 
the dependency as follows:

@CCOUNT(C4..C100, # #{0,-1})\C3..C99

which tells Spreadsheet to recalculate whenever any cell in the range C3..C99 changes.

Built-in Functions
Spreadsheet functions are predefined formulas supplied with the program. They offer a 
shortcut approach to accomplishing the work of long, complex formulas. Mathematical and 
statistical functions are often used to sum a column of numbers, compute an average, 
determine a minimum or maximum value, or round the results of a formula. Other functions 
are used for more specialized purposes such as computing the future value of an investment or 
the product of multiplying one cell range by another range. Some functions perform 
calculations that arithmetic operators cannot handle such as text-string manipulations.

Spreadsheet functions fall into the following categories:

• Mathematical
• Statistical
• Conditional Statistical
• String
• Logic
• Digital Logic
• Financial
• Date and Time
• Miscellaneous
• Embedded Tools
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Mathematical Functions

Mathematical Functions perform calculations such as determining absolute value, finding the 
integer portion of a number, or establishing the value of a constant. Although you could 
accomplish these tasks with a formula, using a function saves time and trouble.

Spreadsheet also provides a full range of trigonometric functions including sine, cosine, 
tangent, arc sine, hyperbolic sine, hyperbolic arc sine as well as vector and matrix arithmetic 
and manipulation.

Mathematical functions perform calculations with numeric values as arguments, returning 
numeric values.

Statistical Functions

Statistical Functions perform aggregation operations such as calculating means, minimums, 
maximums, and averages.

Spreadsheet also provides more sophisticated statistical test functions that perform operations 
on a group of values expressed as a list of arguments. These include the F-test, T-tests, 
correlation coefficient, deviations, and all common averages.

Statistical functions return numeric values.

Conditional Statistical Functions

Conditional Statistical Functions operate much like statistical aggregation functions, except 
that the last argument is a constraint expression that Spreadsheet evaluates for each cell in the 
argument list.

Only cells that meet constraint criteria are included in the calculation. The constraint 
expression may be any Spreadsheet expression that evaluates to a numeric result.

Conditional Statistical Functions return a numeric value.

String Functions

String Functions manipulate and evaluate character strings. For example, string functions can 
return the length of a string, find the first occurrence of a string in a range, change a string 
from upper to lower-case and vice versa, or replace one string with another.

String functions return strings or numeric values.
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Logic Functions

Logic Functions return one value if an argument meets certain criteria, another value if it 
does not.

Logic functions are used as an adjunct to conditional statements.

Logic functions return the value 1, 0, or a value.

Digital Logic Functions

Digital Logic Functions perform digital logic operations such as AND, OR, NOT, etc.

Digital logic functions return the values 0, 1, or -1 (unknown). Any value whose integer 
portion is not equal to 0 or 1 is considered unknown. Unknown input values may cause 
unknown output values.

Financial Functions

Financial Functions perform common financial calculations, such as calculating the future 
value of an annuity at a given interest rate, straight-line depreciation, double-declining 
depreciation, or the payment term for a given investment. The financial functions in 
Spreadsheet cover annuities, cash flows, assets. bonds, and Treasury Bills.

Financial functions are most useful for solving cash flow calculations where you know all but 
one variable. For example, if you know the present value of an investment, interest rate, and 
periodic payment, you can use the @FV function to calculate the future value of the 
investment. If you know the future value and other variables, but need to know the present 
value, you can use the @PV function.

Many financial functions require specifying a Day Count Basis. A Day Count Basis indicates 
the way in which the days in a month and the days in a year are to be counted. Most of the 
financial functions in securities involve 4 different Day Count Basis: 30/360, actual/actual, 
actual/360 and actual/365. 30/360 Day Count Basis assumes 30-day months and 360-day 
years (12 months x 30 days). Spreadsheet also follows the ``End-of-Month'' rule which 
assumes that a security pays interest on the last day of the month and will always make its 
interest on the last day of the month. Special rules are followed when calculating the days 
between two dates on 30/360 Day Count Basis.

For example, let Start_Date = D1/M1/Y1, End_Date = D2/M2/Y2.

1. If D1=31, Spreadsheet uses 30 for D1.

2. If D2=31, Spreadsheet uses 31, unless D1=30 or D1=31. In this case, Spreadsheet 
uses 30.

3. If D1 is the last day of February (D1=28 or 29 in a leap year), Spreadsheet uses 30 for D1.
ChromQuest Reference Guide Thermo Scientific



 10 Advanced Reporting Formulas
Built-in Functions
4. If D2 is the last day of February (D2=28 or 29 in a leap year) and D1 is also the last day 
of February, Spreadsheet uses 30 for D2.

The special arguments used by Spreadsheet financial functions are defined in Table TODO:

Financial functions use the arguments defined in Table interest rate The interest rate to be 
used in the calculations. The rate may be specified as annual, monthly or quarterly, but it 
must agree with the increment you use for periods. By default the interest rate is an annual 
rate.

Functions related fixed income securities usually require special dates as arguments: issue date, 
settlement date, first coupon date, last coupon date, maturity date of a security. When 
specified, the following constraints should be followed:

issue settlement maturity

issue first coupon maturity

issue last coupon maturity

present value The present value of an investment, representing the amount 
already received from or committed to an investment.

period The number of periods over which the loan, investment or 
depreciation is to be calculated. The periods may be defined in 
months, quarters or years, but must agree with the increment used 
to define interest rate.

future value The future value of an investment, given a certain present value, 
interest rate, and number of periods.

cost The original cost of a depreciable capital asset.

salvage value The remaining value of a capital asset after the depreciation period 
has expired.

allowable life The allowable life of a depreciable item.

yield The interest rate that makes the present value of the expected 
future cash flows equal to the price of the financial instrument.

price The present value of the expected future cash flows where the 
discount rate is equal to the yield of the financial instrument.

coupon rate The annual coupon rate of a security.

frequency The number of coupon payments in a year.

basis The day count basis to be used in calculation.
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Date and Time Functions

Date and Time Functions return values corresponding to the specified date, month, year, 
hour, minute or second. You can also use date/time functions to enter the current system time 
and date in a cell.

These functions open up many possibilities for managing accounts receivable and calculating 
test times.

Spreadsheet internally stores date and time information using the same convention as other 
popular spreadsheet programs:

• Dates are represented as an integer equal to the number of days since December 31, 
1899, so

January 1, 1900 equals 1.

• Times are represented as fractions of a day, starting at midnight. For example, 6:00 AM is 
stored as 0.25 (a quarter of a 24-hour day).

Using this convention, date and time values may be used together. For example, the 
date/time value

1.25 corresponds to 6:00:00 AM, January 1, 1900.

Miscellaneous Functions

Miscellaneous Functions perform a variety of calculations, such as returning a reference to 
specific cells or ranges or returning the Nth argument from a list of arguments.

Embedded Tools

Embedded Tools are a powerful feature in Spreadsheet. Their power derives in part from their 
ability to return a set of data, not just a single value. This function makes non-scalar 
operations such as matrix multiplication and "live" recalculation as easy to use as an ordinary 
spreadsheet function.

Embedded tools store values in a group of adjacent cells. These adjacent cells are set to 
constant formulas with explicit dependencies on their neighboring cells. For example, an 
embedded tool in cell

B2 might produce the formula =1.3459\B2 in cell B3. This formula indicates that the cell 
currently contains the constant 1.3459 but that its value depends on the contents of cell B2 
(the cell containing the embedded tool).

This notion of explicit dependencies is important for recalculation. It guarantees that any cell 
that references B3 is not recalculated until after cell B2 is recalculated. This ensures that data 
generated by the embedded tool is always current.
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Embedded tools look like normal functions, and they can be copied, moved and formatted 
just as any other formula in the spreadsheet. However, you must follow one important 
guideline: DO NOT combine embedded tools with other embedded tools in a single 
formula. For example, the formula

@INVERT(@MMUL(A1..C4,F1..I3))

is not allowed.

Quick-Reference Guide to Built-in Functions

Mathematical Functions

Formula Functions

@ABS(X) The absolute value of X.

@ACOS(X) The arc cosine of X.

@ASIN(X) The arc sine of X.

@ATAN(X) The 2-quadrant arc tangent of X.

@ATAN2(X, Y) The 4-quadrant arc tangent of Y/X.

@CEIL(X) The smallest integer greater than or equal to X.

@COS(X) The cosine of X.

@COSH(X) The hyperbolic cosine of X.

@DEGREES(X) Converts the angle expressed in radians to degrees ( ).

@DET(M) The determinant of the matrix range M, which must be a 
square matrix.

@DOT(R1, R2) The dot product of the vectors R1 and R2.

@EXP(X) e raised to the X power.

@FACT(N) The value of N!.

@FLOOR(X) The largest integer less than or equal to X.

@FRAC(X) The fractional portion of X.

@GAMMA(X) The value of the gamma function evaluated at X.

@GRAND A 12th-degree binomial approximation to a Gaussian 
random number with zero mean and unit variance.

@INT(X) The integer portion of X.

@LN(X) The natural log (base e) of X.

@LNGAMMA(X) The log base e of the gamma function evaluated at X.
hermo Scientific ChromQuest Reference Guide 193



10 Advanced Reporting Formulas
Quick-Reference Guide to Built-in Functions

194
@LOG(X) The log base 10 of X.

@LOG10(X) The log base 10 of X.

@LOG2(X) The log base 2 of X.

@MOD(X, Y) The remainder of X/Y.

@MODULUS(X, Y) The modulus of X/Y.

@PI The value of p.

@POLY(X, ...) The value of an Nth-degree polynomial in X.

@PRODUCT(X, ...) The product of all the numeric values in the argument 
list.

@RADIANS(X) Converts the angle expressed in degrees to radians ( ).

@RAND A uniform random number on the interval [0,1).

@ROUND(X, n) X rounded to n number of decimal places (0 to 15).

@SIGMOID(X) The value of the sigmoid function.

@SIN(X) The sine of X.

@SINH(X) The hyperbolic sine of X.

@SQRT(X) The positive square root of X.

@SUMPRODUCT(R1, R2) The dot product of the vectors R1 and R2, where R1 and 
R2 are of equal dimension.

@TAN(X) The tangent of X.

@TANH(X) The hyperbolic tangent of X.

@TRANSPOSE(M) The transpose of matrix M.

@VECLEN(...) The square root of the sum of squares of its arguments.

Formula Functions
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Statistical Functions

Formula Functions

@AVG(...) The average (arithmetic mean) of its arguments.

@CORR(R1, R2) Pearson's product-moment correlation coefficient for the 
paired data in ranges R1 and R2.

@COUNT(...) A count of its non-blank arguments.

@F(M, N, F) The integral of Snedecor's F-distribution with M and N 
degrees of freedom from minus infinity to F.

@ERF(L[, U]) Error function integrated between 0 and L; if U specified, 
between L and U.

@ERFC(L) Complementary error function integrated between L and 
infinity.

@FORECAST(...) Predicted Y values for given X.

@FTEST(R1, R2) The significance level ( ) of the two-sided F-test on the 
variances of the data specified by ranges R1 and R2.

@GMEAN(...) The geometric mean of its arguments.

@HMEAN(...) The harmonic mean of its arguments.

@LARGE(R, N) The Nth largest value in range R.

@MAX(...) The maximum of its arguments.

@MEDIAN(...) The median (middle value) of the range R1.

@MIN(...) The minimum of its arguments.

@MODE(...) The mode, or most frequently occurring value.

@MSQ(...) The mean of the squares of its arguments.

@PERCENTILE(R, N) The value from the range R which is at the Nth percentile 
in R.

@PERCENTRANK(R, N) The percentile rank of the number N among the values in 
range R.

@PERMUT(S, T) The number of T objects that can be chosen from the set 
S, where order is significant.

@PTTEST(R1, R2) The significance level ( ) of the two-sided T-test for the 
paired samples contained in ranges R1 and R2.

@QUARTILE(R, Q) The quartile Q of the data in range R.

@RANK(E, R[, O]) The rank of a numeric argument E in the range R.

@RMS(...) The root of the mean of squares of its arguments.

@SMALL(R, N) The Nth smallest number in range R.
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Conditional Statistical Functions

@SSE(...) The sum squared error of its arguments. It is equivalent 
to @VAR(...) @COUNT(...). 

@SSQ(...) The sum of squares of its arguments.

@STD(...) The population standard deviation (N weighting) of its 
arguments.

@STDS(...) The sample standard deviation (N-1 weighting) of its 
arguments.

@SUM(...) The sum of its arguments.

@T(N, T) The integral of Student's T distribution with N degrees of 
freedom from minus infinity to T.

@TTEST(R, X) The significance level of the two-sided single population 
T-test for the population samples contained in range R.

@TTEST2EV(R1, R2) The significance level ( ) of the two-sided dual population 
T-test for ranges R1 and R2, where the population 
variances are equal.

@TTEST2UV(R1, R2) The significance level ( ) of the two-sided dual population 
T-test for ranges R1 and R2, where the population 
variances are not equal.

@VAR(...) The sample variance (N weighting) of its arguments.

@VARS(...) The sample variance (N-1 weighting) of its arguments.

@VSUM(...) The ``visual sum'' of its arguments, using precision and 
rounding of formatted cell values.

Formula Functions

Formula Functions

@CAVG(..., C) Conditional average.

@CCOUNT(..., C) Conditional count.

@CMAX(..., C) Conditional maximum.

@CMIN(..., C) Conditional minimum.

@CSTD(..., C) Conditional sample standard deviation (N weighting).

@CSTDS(..., C) Conditional sample standard deviation (N-1 weighting).

@CSUM(..., C) Conditional sum.

@CVAR(..., C) Conditional population variance (N weighting).

@CVARS(..., C) Conditional population variance (N-1 weighting).
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String Functions

Formula Functions

@CHAR(N) The character represented by the code N.

@CLEAN(S) The string formed by removing all non-printing 
characters from the string S.

@CODE(S) The ASCII code for the first character in string S.

@EXACT(S1, S2) Returns true (1) if string S1 exactly matches string S2, 
otherwise returns 0.

@FIND(S1, S2, N) The index of the first occurrence of S1 in S2.

@HEXTONUM(S) The numeric value for the hexadecimal interpretation 
of S.

@LEFT(S, N) The string composed of the leftmost N characters of S.

@LENGTH(S) The number of characters in S.

@LOWER(S) S converted to lower case.

@MID(S, N1, N2) The string of length N2 that starts at position N1 in S.

@NUMTOHEX(X) The hexadecimal representation of the integer portion 
of X.

@PROPER(S) The string S with the first letter of each word capitalized.

@REGEX(S1, S2) Returns true (1) if string S1 exactly matches string S2; 
otherwise returns false (0). Allows ``wildcard'' 
comparisons by interpreting S1 as a regular expression.

@REPEAT(S, N) The string S repeated N times.

@REPLACE(S1, N1, N2, S2) The string formed by replacing the N2 characters starting 
at position N1 in S1 with string S2.

@RIGHT(S, N) The string composed of the rightmost N characters of S.

@STRCAT(...) The concatenation of all its arguments.

@STRING(X, N) The string representing the numeric value of X, to 
N decimal places.

@STRLEN(...) The total length of all strings in its arguments.

@TRIM(S) The string formed by removing spaces from the string S.

@UPPER(S) The string S converted to upper case.

@VALUE(S) The numeric value represented by the string S; otherwise 
0 if S does not represent a number.
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Logic Functions

Digital Logic Functions

Formula Functions

@FALSE The logical value 0.

@FILEEXISTS(S) 1 if file S can be opened for reading; otherwise 0.

@IF(X, T, F) The value of T if X evaluates to on-zero, or F if X 
evaluates to zero.

@ISERROR(X) Returns 1 if X ``contains'' an error, otherwise 0.

@ISNUMBER(X) 1 if X is a numeric value; otherwise 0.

@ISSTRING(X) 1 if X is a string value; otherwise 0.

@TRUE The logical value 1.

Formula Functions

@AND(...) 0 if any arguments are 0; 1 if all arguments are 1; 
otherwise -1.

@NAND(...) 0 if all arguments are 1; 1 if any arguments are 0; 
otherwise -1.

@NOR(...) 0 if any arguments are 1; 1 if all arguments are 0; 
otherwise -1.

@NOT(X) 0 if X=1; 1 if X=0; otherwise -1.

@OR(...) 0 if all arguments are 0; 1 if any arguments are 1; 
otherwise -1.

@XOR(...) 1 if any of the arguments are not 0 or 1; otherwise 0 if the 
total number of arguments with the value 1 is even; 1 if 
the total number of arguments with the value 1 is odd.
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Financial Functions

Formula Functions

@ACCRINT(I, Ft, S, R, P, F[, B]) Accrued interest for a security that pays 
periodic interest.

@ACCRINTM(I, S, R, P[, B]) Accrued interest for a security that pays 
interest at maturity.

@COUPDAYBS(S, M, F[, B]) The number of days between the 
beginning of the coupon period to the 
settlement date.

@COUPDAYS(S, M, F[, B]) The number of days in the coupon 
period that the settlement date is in.

@COUPDAYSNC(S, M, F[, B]) The number of days between the 
settlement date and the next coupon 
date.

@COUPNCD(S, M, F[, B]) The next coupon date after the 
settlement date.

@COUPNUM(S, M, F[, B]) The number of coupon payments 
between the settlement date and 
maturity date.

@COUPPCD(S, M, F[, B]) The previous (most recent) coupon date 
before the settlement date.

@CTERM(R, FV, PV) The number of compounding periods 
for an investment.

@CUMIPMT(R, NP, PV, S, E, T) The cumulative interest on a loan 
between start period S and end period E.

@CUMPRINC(R, NP, PV, S, E, T) The cumulative principal paid on a loan 
between start period S and end period E.

@DB(C, S, L, P[, M]) Fixed- declining depreciation allowance.

@DDB(C, S, L, N) Double- declining depreciation 
allowance.

@DISC(S, M, P, R[, B]) The discount rate for a security.

@DOLLARDE(FD, F) Converts a dollar amount expressed as a 
fraction form into a decimal form.

@DOLLARFR(DD, F) Converts a dollar amount expressed as a 
decimal form into a fraction form.

@DURATION(S, M, R, Y, F[, B]) The Macauley duration of a security 
assuming $100 face value.
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@EFFECT(NR, NP) Returns the effective annual interest 
rate.

@FV(P, R, N) Future value of an annuity.

@FVSCHEDULE(P, S) The future value of an initial investment 
after compounding a series of interest 
rates.

@INTRATE(S, M, I, R[, B]) The interest rate for a fully invested 
security.

@IPMT(R, P, NP, PV, FV[, T]) The interest payment for a specific 
period for an investment based on 
periodic, constant payments and a 
constant interest rate.

@IRR(G, F) The internal rate of return on an 
investment. (See also @XIRR and 
@MIRR.)

@MDURATION(S, M, R, Y, F[, B]) The modified Macauley duration of a 
security assuming $100 face value.

@MIRR(CF, FR, RR) The modified internal rate of return for 
a series of periodic cash flows.

@NOMINAL(ER, NP) The nominal annual interest rate.

@ODDFPRICE(S, M, I, FC, R, Y, RD, F[, B]) The price per $100 face value of a 
security with an odd (short or long) first 
period.

@ODDFYIELD(S, M, I, FC, R, PR, RD, F[, B]) The yield per of a security with an odd 
(short or long) first period.

@PMT(PV, R, N) The periodic payment for a loan.

@PPMT(R, P, NP, PV, FV, T) The payment on the principal for a 
specific period for an investment based 
on periodic, constant payments and a 
constant interest rate.

@PRICE(S, M, R, Y, RD, F[, B]) The price per $100 face value of a 
security that pays periodic interest.

@PRICEDISC(S, M, D, RD[, B]) The price per $100 face value of a 
discounted security.

@PRICEMAT(S, M, I, R, Y[, B]) The price per $100 face value of a 
security that pays interest at maturity.

@PV(P, R, N) The present value of an annuity

Formula Functions
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@RATE(FV, PV, N) The interest rate required to reach future 
value FV.

@RECEIVED(S, M, I, D, [, B]) The amount received at maturity for a 
fully vested security.

@SLN(C, S, L) The straight-line depreciation 
allowance.

@SYD(C, S, L, N) The ``sum-of-years-digits'' depreciation 
allowance.

@TBILLEQ(S, M, D) The bond-equivalent yield (BEY) for a 
Treasury Bill.

@TBILLYIELD(S, M, D) The yield on a Treasury bill.

@TERM(P, R, FV) The number of payment periods for an 
investment.

@VDB(C, S, L, S, E) Fixed- declining depreciation allowance 
between two periods.

@XIRR(G, V, D) Internal rate of return for a series of cash 
flows with variable intervals.

@XNPV(R, V, D) Returns the net present value for a series 
of cash flows with variable intervals.

@YIELD(S, M, R, PR, RD, F[, B]) Yield of a security that pays periodic 
interest.

@YIELDMAT(S, M, I, R, PR[, B]) Annual yield of a security which pays 
interest at maturity.

Formula Functions
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Date and Time Functions

Formula Functions

@DATE(Y, M, D) The date value for year Y, month M, and day D.

@DATEVALUE(S) The corresponding date value for a given string S.

@DAYS360(S, E) The number of days between two dates, based on a 
30/360 day count system.

@DAY(DT) The day number in the date/time value DT.

@EDATE(S, M) The date/time value representing number of months 
(M) before or after start date (S).

@EOMONTH(S, M) The date/time value representing the last day of the 
month M months after S, if M is positive, or M 
months before if M is negative.

@HOUR(DT) The hour value (0-23) of date/time value DT.

@MINUTE(DT) The minute value (0-59) of date/time value DT.

@MONTH(DT) The number of the month in date/time value DT.

@NETWORKDAYS(S, E[, H]) The number of whole working days, starting at S and 
going to E, excluding weekends and holidays.

@NOW The date/time value of the current system date and 
time.

@SECOND(DT) The seconds value (0-59) of the date/time value DT.

@TIME(H, M, S) The time value for hour H, minute M, and second S.

@TIMEVALUE(S) The corresponding time value for a given string value 
S.

@TODAY The date value of the current system date.

@WEEKDAY(D) The integer representing the day of the week on 
which the day D falls. 1 is Sunday, 7 is Saturday.

@WORKDAY(S, D[, H]) The day that is D working days after S, if D is 
positive, or before S, if D is negative, excluding 
weekends and all holidays specified as dates in range 
H.

@YEAR(DT) The year value of date/time value DT.

@YEARFRAC(S, E[, B]) The portion of the year represented by the number of 
days between start date (S) and end date (E).
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Miscellaneous Functions

Spreadsheet does not include these indirect references in determining the pattern of 
recalculation.

Plan carefully before using these functions. See the section, Computed Cell References at the 
end of this chapter for more information.

Formula Functions

@CELLREF(N1, N2) A reference to the cell in column N1 and row 
N2.

@CHOOSE(N, ...) The Nth argument from the list.

@COL(C) The column address of the cell referenced by C.

@COLS(R) The number of columns in the specified range R.

@HLOOKUP(X, S, R) The value of the cell in range S that is R number 
of rows beneath X.

@INIT(X1, X2) The first argument on the first recalculation pass 
and the second argument on all subsequent 
recalculation passes when Spreadsheet is 
performing iterative calculations.

@INTERP2D(R1, R2, N) The interpolation value for a 2-dimensional 
vector.

@INTERP3D(R, X, Y) The interpolation value for a 3-dimensional 
vector.

@MATCH(V, R[, T]) The relative position in range R of value V based 
on positioning criteria T.

@N(R) The numeric value of the top left cell in range R.

@RANGEREF(N1, N2, N3, N4) A reference to the range defined by coordinates 
N1 through N4.

@ROW(C) The row address of the cell referenced by C.

@ROWS(R) The number of rows in the specified range R.

@S(R) The string value of the top left cell in range R.

@VLOOKUP(X, S, C) The value of the cell in range S that is C number 
of columns to the right of X.

IMPORTANT  Some Spreadsheet functions return a result that is a range or cell reference.
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Embedded Tools

Formula Functions

@DFT(R) The Discrete Fourier Transform of the range R.

@EIGEN(M) The eigenvalues of the matrix M.

@FFT(R) The Discrete Fourier Transform of the range R using a 
fast Fourier Transform algorithm.

@FREQUENCY(R, B) Returns a frequency distribution for values R with a set of 
intervals B.

@INVDFT(R) The inverse of the Discrete Fourier Transform of the 
range R.

@INVERT(M) The inverse of matrix M.

@INVFFT(R) The inverse of the Discrete Fourier Transform of the 
range R using a fast Fourier Transform algorithm.

@LINFIT(X, Y) The straight line least squares fit. This function is 
equivalent to @POLYFIT(X, Y, 1).

@LLS(A, Y) The linear least squares solution X to the over-determined 
system of equations AX=Y.

@MMUL(M1, M2) The product of multiplying matrix M2 by matrix M1.

@PLS(X, Y, d) Analyzes the least squares polynomial model Y=P(X), 
where P is a polynomial of degree d.

@POLYCOEF(X, Y, d) The least squares coefficients for the polynomial fit 
Y=P(X), where P is a polynomial of degree d.

@TRANSPOSE(M) The transpose of matrix M.

@TREND(NX, KX, KY) The y values for new x values given existing x and y values.

Note  Embedded tools should not be contained within other functions or arithmetic 
operations in a single formula. You may, however, copy, move and format embedded 
tools just as any other function.
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Using Spreadsheet Built-in Functions
You enter a function in a cell in the same way you enter a formula or any other entry, with a 
few additional guidelines.

• Type in the function name. Spreadsheet recognizes the string as a function. Function 
names are abbreviations that indicate what the function does. For instance, ABS 
computes absolute value, ROUND rounds to the specified number of places, and 
AVG computes the average of a list of arguments. Function names may be preceded with 
an '@' sign, but this is not required.

• After typing the function name, enter arguments in parentheses. Most functions use one 
or more arguments to define the task to be performed. For example, the @AVG function 
averages the value of two or more arguments. The @LENGTH function returns the 
length of an argument that is a character string.

• Use only the arguments required by the function, in the exact order specified in the 
function syntax. If you enter other arguments or enter them in the wrong order, 
Spreadsheet misinterprets their meaning or return an error message.

• All the function names in this chapter are typed in uppercase letters, but you can enter 
them in upper or lower-case for your entries.

Arguments

Arguments specify the values the function should use in its calculations. The number of 
arguments, their types, and their formats varies from one function to another. Arguments are 
usually numeric values, cell or range references, or string values. Most functions have at least 
one argument; a few have none.

The following chart shows different types of arguments used in Spreadsheet functions.

Argument Example:

Numeric Value 123

Address of a cell A10

Address of a range F9..F99

String Value ``Quarterly Report''

Using Operators with Functions

The result of a function depends on the order in which Spreadsheet handles the calculations. 
Please see Chapter Calculations, for more information on operators and their precedence.
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Computed Cell References

Several Spreadsheet functions such as @CELLREF and @RANGERE return a result that is 
itself a cell reference or range reference. This is a powerful facility, but it must be used with 
caution because Spreadsheet can not take these indirect references into account when 
determining the order of recalculation. The same caution applies to constraint expressions 
used in conditional statistical functions. As a rule, cells that are indirectly referenced by a 
function are not automatically recalculated. Spreadsheet provides a special construct to force a 
recalculation, referred to as an explicit dependency.

Spreadsheet does not recalculate the spreadsheet unless explicit dependencies have been 
changed, so you may need to force recalculation if you change the value of a cell that is 
referenced only indirectly through a function.

For example, suppose you want to count the numeric values in the range C3..J100 that fall 
within the limits specified in cells A1 and A2. The Spreadsheet formula to compute this is

@CCOUNT(C3..J100,#A1 && #<A2)

This formula correctly counts the numeric values in the range C3..J100. However, if you 
change the value in A1, Spreadsheet does not automatically recalculate the result, because A1 
is referenced only indirectly through the constraint expression.

• To force Spreadsheet to recalculate the entire spreadsheet you should call the Recalc() 
command. You should also add Recalculate menu in your application that calls Recalc().

• You can also force Spreadsheet to do a partial recalculation with respect to that cell, edit 
the cell and append a blank and press the [Return] key on the cell containing the 
@CCOUNT formula.

• You can also use explicit dependencies to circumvent the limitation described above, if 
you entered the formula below in the form

@CCOUNT(C3..J100,#A1 && #<A2)\A1\A2

Spreadsheet would take into account the dependencies on A1 and A2 and update the 
spreadsheet just as you expect.

• Another approach is to construct the condition string with an expression that references 
the cells directly. For example,

@CCOUNT(C3..J100, @STRCAT("#",A1,"&_<",A2))

In this example, A1 and A2 are directly referenced and thus properly triggers recalculation.

Explicit Dependency is described in more detail in Section Explicit Dependency.
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Spreadsheet checks for a variety of errors. Depending on the error type, the most recent error 
message is displayed either inside the affected cell(s), on the Message Line or is displayed 
inside the Spreadsheet Message dialog box.

Types of Errors

• Errors in Functions

Errors that occur inside functions are reported along with the name of the function in 
which the error occurred.

• Formula Syntax Errors

These errors occur only when you are typing in a formula. When you finish entering the 
formula, Spreadsheet attempts to read the formula and convert it to an internal 
representation. If it is unable to do so, it continues to display the erroneous formula, 
switches into ``edit mode'', places the text cursor at the beginning of the text which it had 
difficulty parsing, and displays the error message.

The problem must be corrected before Spreadsheet can continue.

• Formula Evaluation Errors

Formula evaluation error occurs when Spreadsheet reads in a formula and converts it into 
its internal formula representation, but is not able to evaluate the formula and produce a 
correct numeric or string formula. In some cases, the formula has been entered 
incorrectly, for example, an operand or parenthesis is missing. In other cases, an error has 
occurred as a result of computation that cannot be handled properly by the computer's 
floating point hardware, or there is an error condition in a cell or range that is referenced 
in the context of this formula. Errors can also occur in the evaluation of Spreadsheet 
built-in functions.
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Summary of Error Messages

Error Message Description

argument must be an integer @FACT has been passed a non-integer argument.

argument not a cell or range @@ has been passed an argument that is neither a cell nor 
a range.

argument out of range An argument to a function is not within the correct range 
for the function and its other arguments.

arguments must be numeric The function requires numeric arguments, which may be 
literal numbers, formulas which return numeric values, or 
references to cells containing numeric values.

arguments must be positive The arguments in this function must be all positive 
values.

can not parse condition string Spreadsheet has encountered a malformed conditional 
expression.

cannot find interpolation @INTERP2D or @INTERP3D is unsuccessful in 
finding interpolated values.

cash flow series must be a range @NPV and @MIRR require that their cash flow series 
must be a range, which must represent a single column or 
row.

cash flow series must be single column or row @NPV and @MIRR require that their cash flow series 
must be a range, which must represent a single column or 
row.

cell operand contains error condition A cell which is referenced from the cell in which the error 
occurs contains an error condition.

cell reference out of range A cell reference has been made which is outside the range 
A1..FAN32767

coefficient matrix has linearly dependent columns The existence of a unique solution to a linear least squares 
(@LLS) problem, Ax=b, requires that the columns of A 
are linearly independent.

column offset out of range The third argument to the @VLOOKUP function 
specifies an offset that is less than 0 or is greater than the 
width of the range specified in the second argument.

constraint check not supported with ``As Needed'' Constraint checking is not supported when the 
recalculation is set to ``As Needed''.

contains an error indicator A cell in one or more of the data ranges for a graph 
contains an error condition. The error condition must be 
resolved before Spreadsheet can plot the graph.
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could not find real root @IRR could not find a real root. This suggests that the 
data given to @IRR is probably wrong.

count less than zero User has passed a negative argument to a function which 
requires a count, for example, with @LEFT, it is 
impossible to take the -2 leftmost characters of a string.

data set size must be = 3 @LINFIT and @LINCOEF require a data set of size 3 or 
larger.

data set size must be = polynomial degree + 2 @PLS, @POLYFIT, and @POLYCOEF require that the 
data set size be greater than or equal to the polynomial 
degree + 2.

date series must be single column or row @XIRR and @XNPV require the argument D (date 
series) to be a single column or single row.

decimal places out of range @STRING only takes a decimal place argument between 
0 and 15.

degrees of freedom must be 0 @F and @T require degrees of freedom greater than zero, 
as ``degrees of freedom'' is mathematically undefined for 
zero or less.

dimension must be power of 2 @FFT and @INVFFT require matrices whose 
dimensions are powers of two. The somewhat slower 
functions @DFT and @INVDFT, respectively, are 
equivalent functions which do not share this requirement.

divide by zero An attempt has been made to divide by zero. Note that 
Spreadsheet considers cells which are empty or contain 
text strings to have the value zero in the context of a 
numerical calculation.

does not accept arguments Several Spreadsheet functions, including @PI, @TRUE, 
@FALSE, @RAND, and @GRAND, do not accept any 
arguments.

domain is -1 < x < 1 @ATANH only takes arguments between -1 and 1, 
exclusive.

domain is -1 <= x <= 1 @ACOS and @ASIN only take arguments between 
-1 and 1, inclusive.

domain is 0 <= x <= 170 @FACT only takes arguments between 0 and 170, 
inclusive. (Most platforms) 

domain is 0 <= x <= 33 @FACT only takes arguments between 0 and 33, 
inclusive. (VAX platforms)

domain is x 0 @LN, @LOG2, @LOG, @GAMMA, and 
@LNGAMMA only take arguments greater than zero.

Error Message Description
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domain is x = 1 @ACOSH only takes arguments greater than or equal 
to 1.

``End Period'' must be = 1 @CUMIPMT and @CUMPRINC require the argument 
E (end period) to be greater than or equal to 1.

``End Period'' must be = ``Start Period'' @CUMIPMT, @CUMPRINC and @VDB require the 
argument E (end period) to be greater than or equal to 
S (start period).

ending line with a \ The \ is an escape sequence introducer, which should be 
followed by another character for interpretation, but the 
string ended prematurely.

ending line with a superscript command When displaying text in the context of graphics, a ^ is a 
superscript introducer. Like y^2 means ``y squared.'' 
This message occurs when a ^ occurs at the end of the 
string.

ending line with subscript command When displaying text in the context of graphics, an `_' is 
a subscript introducer. Like y_2 means ``y subscript 2.'' 
This message occurs when an `_' occurs at the end of the 
string.

error in regular expression An error occurred while parsing the regular expression 
used in a search or extract operation, or while executing 
@REGEX or @MATCH.

expected the right hand side of a range here The outer range reference is missing.

expected to find [something] here There was a parsing error. The cursor is placed in the edit 
window in edit mode. Read the documentation for the 
function and correct the error.

expecting a function There is something wrong with the formula you have 
entered on the edit line. The parser was expecting to find 
a function name at the point indicated by the cursor 
position.

expecting an operand There is something wrong with the formula you have 
entered on the edit line. The parser was expecting to find 
a function name at the point indicated by the cursor 
position.

expecting an operator There is something wrong with the formula you have 
entered on the edit line. The parser was expecting to find 
a function name at the point indicated by the cursor 
position.

Error Message Description
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extraneous operands There is something wrong with the formula you have 
entered on the edit line. The parser was expecting to find 
a function name at the point indicated by the cursor 
position.

F must be = 0 The third argument to @F must be greater than or equal 
to 0.

first argument must be numeric @NPV and @CHOOSE require that their first argument 
be numeric.

floating exception A floating-point arithmetic hardware exception occurred 
during the computation of the function or expression. 
This means that the calculations resulted in a number out 
of the range that the computer hardware is able to 
represent.

found something unexpected here Spreadsheet has found something it doesn't understand 
in an expression.

``Fraction'' must be = 1 @DOLLARDE and @DOLLARFR require the argument 
F (fraction) to be greater than and equal to 1.

``Frequency'' must be 1, 2 or 4 The argument Frequency (number of coupon payment 
per year) in financial functions is limited to one of the 
following choices: 1, 2 or 4

function not installed This error occurs when Spreadsheet encounters an ``@'' 
followed by a function name which it does not recognize 
as one of its built-in functions, or one that has been 
installed by a connection program.

function stack overflow This error occurs when functions are nested too deeply. 
Spreadsheet supports nesting of functions up to 50 levels 
deep.

hex number greater than 32 bits Spreadsheet cannot convert a hex string to a number if 
the hex string is longer than 8 characters, which translates 
to 32 bits in the internal binary representation.

IEEE Floating Exception (Infinity or NaN) This error means that the formula caused a computation 
to occur which could not be calculated properly by the 
computer's IEEE standard floating point hardware. Most 
likely, this means that the computation would produce an 
intermediate or final result outside the range +/-1.8e308.

illegal cell or range reference It happens when a copy or move operation results in a cell 
or range reference that is outside the range 
A1..FAN32767.

Error Message Description
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illegal operand of ``operator''` This error occurs when one or both of the operands of the 
specified ``operator'' are not valid. Most likely, a range 
name was used as an operand in an arithmetic expression.

improper argument type One or more arguments to the function are incompatible 
with the type of arguments required by the functions.

improper coefficient type In the polynomial evaluation function (@POLY), one or 
more of the polynomial coefficients are non-numeric.

improper dimensions Several Spreadsheet matrix functions and embedded tools 
have certain requirements on the dimensions of their 
matrix arguments. Check the reference manual if you are 
uncertain about those requirements.

incompatible matrix dimensions In matrix multiplication (@MMUL), the number of 
columns in the first matrix must equal the number of 
rows in the second matrix.

incompatible range dimensions The Spreadsheet dot product functions (@DOT) requires 
vectors of equal size. It will also compute the 
sum-of-products of any two ranges with equal 
dimensions.

index column contains empty cell The first column in the lookup table referenced by 
@VLOOKUP must not contain empty cells. 

index out of range In @FIND, the third argument may not be larger than 
the length of the second argument. In @MID, the second 
argument may not be larger than the length of the first 
argument.

index row contains empty cell The first row in the lookup table referenced by 
@HLOOKUP must not contain empty cells.

integer parameter out of range An integer parameter greater than 4294967296 or less 
than -2147483649 has been entered.

interest rate should be 0 @EFFECT and @NOMINAL require that argument 
R (interest rate) to be greater than 0.

interest schedule must be a single column or row The argument R (array of interest rates) in 
@FVSCHEDULE must be a single column or row.

invalid cell reference User has tried to access a cell with a row which is 
negative, zero, or greater than 32767, or with a column 
which is negative or greater than FAN, or 4095.

Error Message Description
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invalid date Spreadsheet could not understand the date format. Date 
values must be in the range 1-73,050, representing the 
dates January 1, 1900, to December 31, 2099, 
respectively. This error can also occur when the year, 
month, and day values passed to @DATE do not 
represent an actual date within this range (February 31, 
1950, or January 1, 2589, for example).

invalid day count basis The day count basis in financial functions should be one 
of the following choices: 0 (30/360), 1  (actual/actual), 
2 (actual/360) or 3 (actual/365)

invalid range reference User has tried to make a range reference that references 
cells beyond the range of the spreadsheet; that is, a row 
which is negative, zero, or greater than 32767, or a 
column which is negative or greater than FAN, or 4095.

invalid table The table of reference points in @INTERP2D or 
@INTERP3D contains non-numeric values or blank 
cells.

invalid time Spreadsheet cannot parse a time which the user has 
provided. Time values are fractional values from 0 to 1, 
representing fractions of a 24-hour period. When 
interpreting a number as a date/time value, Spreadsheet 
interprets the integer portion of the number as the date 
and the fractional portion as the time on that date. A 
negative value is invalid. Also, the @TIME function must 
have arguments in the range of 0-23 hours, 0-59 minutes, 
and 0-59 seconds. Any other values are invalid.

iterative calculation not supported with ``As Needed'' To avoid infinite looping, iterative (self-referential) 
calculations are not supported when the recalculation 
method is ``As Needed''. To use iterative calculations, the 
user must choose manual recalculation.

less than 2 arguments @POLY requires 2 or more arguments.

``Life'' and ``Period'' must be integers @DDB requires that ``Life'' and ``Period'', arguments 3 
and 4, respectively, be integers.

``Life'' must be 0 @SLN and @SYD require that ``Life'' is greater than 0.

lookup failed to produce a match @HLOOKUP or @VLOOKUP failed to produce a 
match. This should only happen with an alphabetic 
lookup.

``Lower limit'' must be =0 The argument L (lower limit) should be greater than or 
equal to 0 in @ERF and @ERFC.

Error Message Description
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magnitude too large @NUMTOHEX requires an argument between 
2147483646 and -2147483647, inclusive.

matrix is singular It is mathematically impossible to invert a singular 
matrix.

matrix must be square It is impossible to invert, take the eigenvalue of, or take 
the determinant of a non-square matrix.

``Match Type'' must be 0 for string match The argument T (type of match) must be 0 if argument V 
(value to be matched) is text in @MATCH.

matrix must be symmetric @EIGEN requires a symmetric matrix.

modula divide by zero Mod 0 is an undefined operation.

must be -15 to +15 places @ROUND cannot round to greater than 15 places on 
either side of the decimal point.

must have ``Cost'' = ``Salvage'' = 0 @DDB, @SLN, @SYD, @DB, and @VDB require that 
the ``Cost'' argument be greater than or equal to the 
``Salvage'' argument, which must be greater than or equal 
to 0.

must have issue < first coupon < maturity The values of argument I (issue date), FC (first coupon 
date) and M (maturity date) must satisfy the following 
condition: I < FC < M

must have issue < last coupon < maturity The values of argument I (issue date), LC (last coupon 
date) and M (maturity date) must satisfy the following 
condition: I < LC < M

must have ``Life'' = ``Period'' = 1 @DDB, @DB, and @VDB all require that the ``Life'' 
argument be greater than or equal to the ``Period'' 
argument, which must be greater than or equal to 1.

must have N 0, K 0 and N < K The arguments N (number of objects to choose from) 
and K (Number of objects to be chosen) in @PERMUT 
must follow the following condition: N0, K0 and N <K.

need at least 2 cash flow values A single data point does not a cash flow series make; it 
takes two to trend. Computing the internal rate of return 
(@IRR) is undefined for only one value.

no duplicate number found The @MODE can not find the most frequently occurring 
number because all numbers appears only once in the 
argument list.

no match was found @MATCH is unsuccessful in finding a match.

non hex digits in string @HEXTONUM requires that its argument be a string 
containing only hex digits, 0-9 and a-f.

Error Message Description
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non-numeric operand An expression of some sort has a non-numeric operand 
where a numeric operand is required, making the result of 
the expression undefined.

non-numeric value in ... Doing arithmetic on alphabetic entities is undefined.

not enough arguments to function User has entered too few arguments to the function.

``Number'' is not in the reference list The number to be ranked is not in the reference list in 
@RANK.

number is too [large|small] The number is at or beyond the limit of the ability of the 
computer to express, and is treated as if it were slightly 
within the limit.

number of compounding periods should be =1 @EFFECT and @NOMINAL require that argument C 
(number of compounding periods) to be greater than or 
equal to 1.

one argument must be non-zero @ATAN2 requires that one of it's arguments be 
non-zero.

operand contains error condition Some cell referenced by the operand is in an error 
condition, or contains a reference to a cell which is in an 
error condition, etc.

operand equal to 0 @HMEAN does not take arguments whose value is 0.

operand larger than 32 bits Integers in Spreadsheet cannot take more than 32 bits to 
express. This restricts integers to the range 2147483647 
to -2147483648, or 4294967295 to zero, depending on 
whether the operand is only positive or can be negative.

operand less than or equal to 0 @GMEAN does not take arguments which are 0 or 
negative.

operand out of range @CHAR only takes integers between 1 and 255

operands of "&" must be same type The “&” operator serves a dual purpose: if its operands 
are numeric, then it performs a bitwise AND operation; if 
its operands are text strings, then it concatenates the two 
strings. If the operands are neither numeric nor both 
strings, this error occurs.

operands of “..” must be cell reference The .. operator can only join two cell references to create 
a range. It cannot join integers to make a range of 
integers, or do anything else.

“Payment” and “FV” must have the same sign @TERM requires that Payment and Future Value have 
the same sign.

“Payment” must be non-zero @TERM requires that Payment be non-zero.

“Period” must be = 0 @SYD requires that Period be greater than or equal to 0.

Error Message Description
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“Period” must be an integer 0 @FV, @PMT, @PV, and @RATE require that Period be 
an integer greater than 0.

polynomial degree must be between 1 and 10 @PLS, @POLYFIT, and @POLYCOEF require that the 
polynomial degree by between 1 and 10.

pooled sample size less than 3 @TTEST2EV requires a pooled sample size greater than 
2 to be mathematically defined.

population less than 1 @CVAR, @CSTD, @SSE, @VAR, and @STD require a 
population greater than or equal to 1.

“PV” and “FV” must be non-zero @CTERM and @RATE require that Present and Future 
Values be non-zero by definition.

“PV” and “FV” must have the same sign @CTERM and @RATE require that Present and Future 
Values have the same sign.

ranges must be same dimensions @PTTEST and @CORR require that both their 
arguments be ranges of equal dimensions, since they work 
with pairs of values, one value from each range.

“Rate” must be greater than -1 @CTERM, @FV, @PMT, @PV, @TERM, @NPV, 
@XNPV, and @XIRR require that their Rate argument 
be greater than -1.

“Rate” must be non-zero @CTERM requires that its Rate argument be non-zero.

rate found is less than -1 @IRR has found a rate less than -1 after iterating the 
maximum number of times.

recursion too deep This error occurs if Spreadsheet encounters ``a condition 
string within a condition string.” For example, it happens 
with a conditional statistical formula whose condition 
string calls another conditional statistical function which 
in turn contains its own condition string.

result of expression is a range Some Spreadsheet functions, such as @CELLREF and 
@RANGEREF, return cell references or range references 
as a result. Cell and range references can not be the final 
result of a formula.

resultant string too long A string generated by a formula is too long (greater than 
512 characters).

row offset out of range The third argument to the @HLOOKUP function 
specifies an offset that is less than 0 or is greater than the 
depth of the range specified in the second argument.

Error Message Description
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sample missing from pair The two input ranges to the paired t-test (@PTTEST) 
and Pearson product-moment correlation (@CORR) 
functions contain paired values. If a value appears at a 
given position in the first range, then there must also be a 
value in the corresponding position of the second range.

sample size less than 2 @CVARS, @CSTDS, @VARS, @STDS, @TTEST, 
@PTTEST, @TTEST2UV, and @FTEST require a 
sample size greater than 1.

searching NULL list searching list with a NULL function.

selector out of range The first argument to @CHOOSE must be 0 or more 
and be less than or equal to the number of the rest of the 
arguments - 1.

settlement date should be < maturity date Settlement date should be earlier than maturity date in 
financial functions.

settlement date should be = issue date Settlement date should not be earlier than the issue date.

showing NULL list showing list with a NULL function

“Start Period” must be = 1 @CUMIPMT and @CUMPRINC require the argument 
S (start period) to be greater than or equal to 1.

starting date should be at beginning of ``Dates” The number in argument D (dates) should not precede 
the starting date in @XIRR and @XNPV.

substring longer than string @FIND cannot find an instance of the pattern string 
within a shorter target string, since it is impossible to 
embed a string in a string shorter than itself.

substring not found @FIND could not find an instance of the pattern string 
in the target string.

token buffer overflow This error can only occur when a formula is entered 
which is more complex than Spreadsheet can accept. 
Spreadsheet can accept up to 200 operators, numbers, 
function calls, and text strings in a single formula, which 
is more than any human can reasonably deal with.

too few arguments The function requires more arguments.

too many arguments to function User has provided too many arguments to the function. 
No function can take more than 100 arguments. 

too many arguments @NOT only takes one argument, unlike the rest of the 
digital logic functions. @ROW and @COL take 1 
argument, @ANNOTATE takes 3-5 arguments.

Treasury Bill should not be outstanding more than 
1 year

The period between the settlement date and maturity 
date of a Treasury bill should not exceed one year.

Error Message Description
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unable to parse extract filter Happens when you are doing an Extract operation and 
you specify an invalid boolean expression; e.g., #==/5.

unable to parse search condition Happens when you are doing a numeric search and you 
specify an invalid boolean expression; e.g., #==/5

undefined symbolic name This error occurs when Spreadsheet encounters a 
symbolic range or cell reference which has not been 
defined. To use a symbolic name to refer to a cell or 
range, you must first define it using the SetRangeName 
command.

unexpected question mark Spreadsheet supports C-language compatible condition 
expressions, which use the operator pair ``?” and ``:”. If 
one of these operators appears without the other, an error 
occurs.

unresolved name in expression A name which is not a valid function or named range has 
been used in the expression. 

“Upper limit” must be =0 The argument U (Upper limit) should be greater than or 
equal to 0 in @ERF.

“values” and “dates” series must have the same 
dimension

@XIRR and @XNPV require the argument V (cash flow 
series) and the argument D (date series) to have the same 
dimension.

“Values” must have at least one inflow and one 
outflow

@MIRR requires the value range contains at least one 
income (positive value) or one payment (negative value)

wrong number of arguments The number of arguments passed to the function is 
incorrect. Check the reference manual to determine the 
correct number of arguments that the function expects.

Error Message Description
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Advanced Report Templates

This chapter describes the functionality available for creating advanced reports with the 
template editor.

Contents

• Functional Reference

• Datafile Functions

• Extended Helper Functions

• Group Functions

• Instrument Functions

• Peak Functions

• Project Functions

• Sequence Functions

• Summary
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Functional Reference
The following functions are available when creating advanced reports using the template 
editor.

Syntax Notes:

• All of the functions described here are placed in cells in the template reporting 
spreadsheet, and must begin with an '=' sign. For example, if a function were described as 
Custom.Func(["Param A"]), then the actual function would look something like

=Custom.Func("Param A")

•  [] These brackets indicate optional parameters. The brackets themselves are not included 
in the actual parameters. For example, if a function were described as 
Custom.Func(["Param A"]), then the actual function would look something like

=Custom.Func("Param A")

• <> These brackets indicate required parameters. The brackets themselves are not included 
in the actual parameters. For example, if a function were described as 
Custom.Func(<"Param A">), then the actual function would look something like

=Custom.Func("Param A")

• "" Quotation marks shown are required. The quotation marks are included in the actual 
parameters. For example, if a function were described as Custom.Func(<"Param A">), 
then the actual function would look something like

=Custom.Func("Param A")
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Datafile Functions
These functions return information about data files that have been collected and analyzed.

Data.AcquisitionDate

Returns date and time of acquisition for the specified data file.

Data.AnalysisDate

Returns date and time of the last analysis for the specified data file.

Data.BCDValue

Returns BCD value of the specified data file. 

Syntax

=Data.AcquisitionDate(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

Date/Time

Syntax

=Data.AnalysisDate(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

Date/Time

Syntax

=Data.BCDValue(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

Number
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Data.Description

Returns the description of the specified data file.

Data.Filename

Returns file name of the specified data file. Only the file name is returned the path 
information is not returned.

Data.FullFilename

Returns full file name of the specified data file. The file name and path information is 
returned.

Syntax

=Data.Description(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

String

Syntax

=Data.Filename(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

String

Syntax

=Data.FullFilename(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

String
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Data.InstrumentName

Returns the name of the instrument that was used to acquire the specified data file.

Data.ISTDAmount

Returns ISTD amount of the specified data file. 

Data.LastMethodFilename

Returns the name of the last method file that was used to analyze the specified data file.

Syntax

=Data.InstrumentName(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

String

Syntax

=Data.ISTDAmount(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

Number

Syntax

=Data.LastMethodFilename(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

String
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Data.LastMethodFullFilename

Returns the full name and path of the last method file that was used to analyze the specified 
data file.

Data.MultiplierFactor

Returns multiplier factor of the specified data file. 

Data.OriginalMethodFilename

Returns the name of the method file that was used to acquire the specified data file.

Syntax

=Data.LastMethodFullFileName(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

String

Syntax

=Data.MultiplierFactor(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

Number

Syntax

=Data.OriginalMethodFilename(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

String
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Data.OriginalMethodFull Filename

Returns the full name and path of the method file that was used to acquire the specified 
data file.

Data.SampleAmount

Returns sample amount of the specified data file. 

Data.SampleID

Returns sample id of the specified data file. 

Syntax

=Data.OriginalMethodFullFileName(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

String

Syntax

=Data.SampleAmount(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

Number

Syntax

=Data.SampleID(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

String
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Data.SystemWideParam

Returns a custom system wide result from the specified data file. 

Data.TraceName

Returns trace name for the specified index and data file. 

Data.UserName

Returns the name of the user that acquired the specified data file.

Syntax

=Data.SystemWideParam (<Param ID>, <Run Info>)

Parameters

<Param ID> A numeric identifier of the requested system wide custom parameter.

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

String / Number

Syntax

=Data.TraceName(<Trace Index>, <Run Info>)

Parameters

<Trace Index> A numeric index of the requested trace.

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

String

Syntax

=Data.UserName(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

String
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Data.Vial

Returns vial of the specified data file. 

Data.Volume

Returns volume of the specified data file. 

Syntax

=Data.Vial(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

Number

Syntax

=Data.Volume(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

Return Type

Number
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Extended Helper Functions
These functions are provided to make the user of other features in the spreadsheet easier 
to user.

Ex.D

Returns a cell range for a dynamic set of data. If data in a cell is expanded dynamically, then 
this function can be used to create a reference to the cells that the data expands into.

Ex.R

This function can be used to repeat an enclosed spreadsheet formula over a series of cells, 
based on a dynamic data set. For example, this function could be used to produce a total field 
showing the sum of a set of peak areas for all peaks in a data file. 

When using the EX.R function, the enclosed function must not have any run, trace, or peak 
information. For example, the formula to show the peak area for the first named peak from 
the current data file using the first trace would be: 

Syntax

=Ex.D (<Cell>, [Range Direction])

Parameters

<Cell> Contains a reference to a cell that is expanded for a dynamic 
data range. This is in the form of 'B5', 'C12', etc. There are no 
enclosing quotes on the cell reference.

[Range Direction] This is an optional numeric parameter that specifies the 
direction of the dynamic expansion to use. If data is being 
expanded in only one direction, then this parameter is not 
necessary. If data is being expanded both across and down, 
then this parameter can be used to control the range that is 
used. The values of this parameter are as follows:

• Not Used or 0

Use any dynamic range that is available. If the data 
expands both across and down, then a range is generated 
that contains the entire expansion.

1. Only generate a range for dynamic data that expands 
across the spreadsheet.

2. Only generate a range for dynamic data that expands 
down the spreadsheet.

Return Type

Cell Range
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=Peak.Area("RC", "T1", "P1;3")

However, when repeating the formula with the EX.R function to show the peak area for all 
named peaks from all runs of a sequence using the first trace, the formula would look as 
follows:

=Ex.R(Peak.Area(), "RA;1;0", "T1", "PA;3;0;0")

Syntax

=Ex.R(<Spreadsheet Formula>, <Dynamic Run Info>, [Trace Info], [Dynamic Peak Info])
or

=Ex.R(<Spreadsheet Formula>, <Dynamic Run Info>, [Trace Info], [Dynamic Group Info])

Parameters

<Spreadsheet Formula> Contains any valid spreadsheet formula that is expanded for a 
dynamic data range. 

[Range Direction] This is an optional numeric parameter that specifies the 
direction to repeat the formula. If the referenced cell is being 
repeated in only one direction, then this parameter is not 
necessary. If the referenced cell is being repeated both across 
and down, then this parameter can be used to control the 
direction that is used. The values of this parameter are as 
follows:

• Not Used or 0

Repeat exactly like the referenced cell. If the referenced cell 
repeats both across and down, then this formula is 
repeated both across and down.

1. Only repeat the formula across the spreadsheet as the 
referenced cell does.

2. Only repeat the formula down the spreadsheet as the 
referenced cell does.

<Dynamic Run Info> Used to determine the dynamic range to expand the formula 
over.

[Trace Info] This is an optional parameter that is used to determine the 
dynamic range to expand the formula over. See the appendix 
for a description of this parameter.

[Dynamic Peak Info] This is an optional parameter that is used to determine the 
dynamic range to expand the formula over.

Return Type

None
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Dynamic Run Info may be one of the following:

Dynamic Peak Info may be one of the following:

Dynamic Group Info may be one of the following:

"RC" The current run or currently loaded data file.

"R<x>" The sequence run specified by run <x>.

"R<x-y>; <direction>; <separation>" The sequence runs specified by <x-y>. The runs 
are repeated in the direction specified by 
<direction>, and are separated by <separation> 
rows or columns.

"RA; <direction>; <separation>" All sequence runs. The runs are repeated in the 
direction specified by <direction>, and are 
separated by <separation> rows or columns.

"P<x>; <peak type>" The peak with an index of <x> having the given 
peak type.

"P<x-y>; <peak type>; <direction>; 
<separation>

The peaks with an index in the range of <x-y> 
having the given peak type. The peaks are 
repeated in the direction specified by 
<direction>, and are separated by <separation> 
rows or columns.

"PA; <peak type>; <direction>; 
<separation>"

All peaks of the given peak type. The peaks are 
repeated in the direction specified by 
<direction>, and are separated by <separation> 
rows or columns.

"G<x>; <group type>" The group with an index of <x> having the given 
group type.

"G<x-y>; <group type>; <direction>; 
<separation>"

The groups with an index in the range of <x-y> 
having the given group type. The groups are 
repeated in the direction specified by 
<direction>, and are separated by <separation> 
rows or columns.

"GA; <group type>; <direction>; 
<separation>"

All groups of the given group type. The groups 
are repeated in the direction specified by 
<direction>, and are separated by <separation> 
rows or columns.
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Direction may be one of the following:

Peak Type may be any combination of the following:

Group Type may be one of the following:

Group Functions
These functions return information about groups.

Group.Area

Returns the area for the requested group(s).

0 The data is repeated across the spreadsheet.

1 The data is repeated down the spreadsheet.

1 Report named peaks that were detected.

2 Report named peaks that were not detected.

4 Report unnamed peaks.

0 Report calibrated range groups that calculate concentrations for unnamed peaks in 
this group.

1 Report calibrated range groups that do not calculate concentrations for unnamed 
peaks in this group.

2 Report named peak groups.

Syntax

=Group.Area(<Run Info>, <Trace Info>, <Group Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Group Info> Describes the group(s) to use for the value.

Return Type

Number
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Group.AreaPercent

Returns the area percent for the requested group(s).

Group.ESTDConcentration

Returns the ESTD concentration for the requested group(s).

Group.Height

Returns the height for the requested group(s).

Syntax

=Group.AreaPercent(<Run Info>, <Trace Info>, <Group Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Group Info> Describes the group(s) to use for the value.

Return Type

Number

Syntax

=Group.ESTDConcentration(<Run Info>, <Trace Info>, <Group Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Group Info> Describes the group(s) to use for the value.

Return Type

Number

Syntax

=Group.Height(<Run Info>, <Trace Info>, <Group Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Group Info> Describes the group(s) to use for the value.

Return Type

Number
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Group.HeightPercent

Returns the height percent for the requested group(s).

Group.ISTDConcentration

Returns the ISTD concentration for the requested group(s).

Group.Name

Returns the group name for the requested group(s).

Syntax

=Group.HeightPercent(<Run Info>, <Trace Info>, <Group Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Group Info> Describes the group(s) to use for the value.

Return Type

Number

Syntax

=Group.ISTDConcentration(<Run Info>, <Trace Info>, <Group Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Group Info> Describes the group(s) to use for the value.

Return Type

Number

Syntax

=Group.Name(<Run Info>, <Trace Info>, <Group Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Group Info> Describes the group(s) to use for the value.

Return Type

String
hermo Scientific ChromQuest Reference Guide 233



11 Advanced Report Templates
Group Functions

234
Group.NORMConcentration

Returns the NORM concentration for the requested group(s).

Group.Number

Returns the group number for the requested group(s).

Syntax

=Group.NORMConcentration(<Run Info>, <Trace Info>, <Group Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Group Info> Describes the group(s) to use for the value.

Return Type

Number

Syntax

=Group.Number(<Run Info>, <Trace Info>, <Group Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Group Info> Describes the group(s) to use for the value.

Return Type

Number
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Group.Quantitation

Returns the group quantitation for the requested group(s). This returns 'Area', 'Height', or 
'Counts'.

Group.ResponseFactor

Returns the response factor for the requested group(s).

Syntax

=Group.Quantitation (<Run Info>, <Trace Info>, <Group Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Group Info> Describes the group(s) to use for the value.

Return Type

String

Syntax

=Group.ResponseFactor(<Run Info>, <Trace Info>, <Group Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Group Info> Describes the group(s) to use for the value.

Return Type

Number
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Group.Units

Returns the units for the requested group(s).

Instrument Functions
These functions return information about the current instrument.

Instrument.ID

Returns the internal instrument id of the current instrument.

Instrument.Name

Returns the instrument name of the current instrument.

Syntax

=Group.Units(<Run Info>, <Trace Info>, <Group Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Group Info> Describes the group(s) to use for the value.

Return Type

String

Syntax

=Instrument.ID()

Parameters

None

Return Type

Number

Syntax

=Instrument.Name()

Parameters

None

Return Type

String
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Instrument.UserName

Returns the name of the user logged into the current instrument.

Peak Functions
These functions return information about detected and named peaks.

Peak.AOHResolution

Returns the AOH resolution for the requested peak(s).

Syntax

=Instrument.UserName()

Parameters

None

Return Type

String

Syntax

=Peak.AOHResolution(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
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Peak.AOHTheoreticalPlates

Returns the AOH theoretical plates for the requested peak(s).

Peak.AOHTheoreticalPlatesPerMeter

Returns the AOH theoretical plates per meter for the requested peak(s).

Peak.Area

Returns the area for the requested peak(s).

Syntax

=Peak.AOHTheoreticalPlates(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.AOHTheoreticalPlatesPerMeter(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.Area(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
ChromQuest Reference Guide Thermo Scientific



 11 Advanced Report Templates
Peak Functions

T

Peak.AreaPercent

Returns the area percent for the requested peak(s).

Peak.Asymmetry

Returns the asymmetry for the requested peak(s).

Peak.AsymmetryTenPercent

Returns the asymmetry at 10% for the requested peak(s).

Syntax

=Peak.AreaPercent(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.Asymmetry(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.AsymmetryTenPercent(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
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Peak.CapacityFactor

Returns the capacity factor for the requested peak(s).

Peak.CurrentResponseFactor

Returns the current response factor for the requested peak(s).

Syntax

=Peak.CapacityFactor(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.CurrentResponseFactor(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
ChromQuest Reference Guide Thermo Scientific



 11 Advanced Report Templates
Peak Functions

T

Peak.CustomParam

Returns a custom peak result for the requested peaks.

Peak.DABResolution

Returns the DAB resolution for the requested peak(s).

Syntax

=Peak.CustomParam(<Param ID>, <Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Param ID> A numeric identifier of the requested peak custom parameter.

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

String / Number

Syntax

=Peak.DABResolution(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
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Peak.DABTheoreticalPlates

Returns the DAB theoretical plates for the requested peak(s).

Peak.DABTheoreticalPlatesPerMeter

Returns the DAB theoretical plates per meter for the requested peak(s).

Peak.EMGResolution

Returns the EMG resolution for the requested peak(s).

Syntax

=Peak.DABTheoreticalPlates(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.DABTheoreticalPlatesPerMeter(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.EMGResolution(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
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Peak.EMGTheoreticalPlates

Returns the EMG theoretical plates for the requested peak(s).

Peak.EMGTheoreticalPlatesPerMeter

Returns the EMG theoretical plates per meter for the requested peak(s).

Peak.ESTDConcentration

Returns the ESTD concentration for the requested peak(s).

Syntax

=Peak.EMGTheoreticalPlates(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.EMGTheoreticalPlatesPerMeter(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.ESTDConcentration(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
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Peak.ExpectedRetentionTime

Returns the expected retention time for the requested peak(s).

Peak.Height

Returns the height for the requested peak(s).

Peak.HeightPercent

Returns the height percent for the requested peak(s).

Syntax

=Peak.ExpectedRetentionTime(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.Height(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.HeightPercent(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
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Peak.Index

Returns the peak index information for the requested named peak, based on its peak id. The 
returned information can be used in place of <Peak Info> for another function. For example 
to find the peak name of a named peak with a peak id of 2 in the current data file, use the 
following formula: =Peak.Name("RC", "T1", Peak.Index(2, "RC", "T1"))

Peak.IntegrationCodes

Returns the integration codes for the requested peak(s).

Syntax

=Peak.Index(<Peak ID>, <Run Info>, <Trace Info>)

Parameters

<Peak ID> A numeric identifier of the requested named peak. This number 
comes from the peak table.

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

Return Type

String

Syntax

=Peak.IntegrationCodes(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

String
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Peak.ISTDConcentration

Returns the ISTD concentration for the requested peak(s).

Peak.JPResolution

Returns the JP resolution for the requested peak(s).

Peak.JPTheoreticalPlates

Returns the JP theoretical plates for the requested peak(s).

Syntax

=Peak.ISTDConcentration(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.JPResolution(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.JPTheoreticalPlates(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
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Peak.JPTheoreticalPlatesPer Meter

Returns the JP theoretical plates per meter for the requested peak(s).

Peak.Name

Returns the peak name for the requested peak(s).

Peak.NORMConcentration

Returns the NORM concentration for the requested peak(s).

Syntax

=Peak.JPTheoreticalPlatesPerMeter(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.Name(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

String

Syntax

=Peak.NORMConcentration(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
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Peak.Number

Returns the detected peak number for the requested peak(s).

Peak.Quantitation

Returns the peak quantitation for the requested peak(s). This returns 'Area', 'Height', or 
'Counts'.

Syntax

=Peak.Number(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.Quantitation (<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

String
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Peak.RelativeRetentionTime

Returns the relative retention time for the requested peak(s).

Peak.Resolution

Returns the resolution for the requested peak(s).

Peak.ResolutionID

Returns the resolution ID for the requested peak(s).

Syntax

=Peak.RelativeRetentionTime(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.Resolution(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.ResolutionID(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
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Peak.ResponseFactor

Returns the response factor for the requested peak(s).

Peak.RetentionTime

Returns the retention time for the requested peak(s).

Peak.StartTime

Returns the start time for the requested peak(s).

Syntax

=Peak.ResponseFactor(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.RetentionTime(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.StartTime(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
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Peak.StopTime

Returns the stop time for the requested peak(s).

Peak.TheoreticalPlates

Returns the theoretical plates for the requested peak(s).

Peak.TheoreticalPlatesPerMeter

Returns the theoretical plates per meter for the requested peak(s).

Syntax

=Peak.StopTime(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.TheoreticalPlates(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.TheoreticalPlatesPerMeter(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
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Peak.Units

Returns the concentration units for the requested peak(s).

Peak.USPResolution

Returns the USP resolution for the requested peak(s).

Peak.USPTheoreticalPlates

Returns the USP theoretical plates for the requested peak(s).

Syntax

=Peak.Units(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

String

Syntax

=Peak.USPResolution(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.USPTheoreticalPlates(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
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Peak.USPTheoreticalPlatesPer Meter

Returns the USP theoretical plates per meter for the requested peak(s).

Peak.USPWidth

Returns the USP width for the requested peak(s).

Peak.Width

Returns the width for the requested peak(s).

Syntax

=Peak.USPTheoreticalPlatesPerMeter(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.USPWidth(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.Width(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
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Peak.WidthFiftyPercent

Returns the width at 50% for the requested peak(s).

Peak.WidthFivePercent

Returns the width at 5% for the requested peak(s).

Peak.WidthTenPercent

Returns the width at 10% for the requested peak(s).

Syntax

=Peak.WidthFiftyPercent(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.WidthFivePercent(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number

Syntax

=Peak.WidthTenPercent(<Run Info>, <Trace Info>, <Peak Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

<Trace Info> Describes the trace that is used to extract the value.

<Peak Info> Describes the peak(s) to use for the value.

Return Type

Number
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Project Functions
These functions return information about the current project.

Project.DataPath

Returns the default path used to store data files in the current project.

Project.Description

Returns the description for the current project.

Project.MethodPath

Returns the default path used to store method files in the current project.

Syntax

=Project.DataPath()

Parameters

None

Return Type

String

Syntax

=Project.Description()

Parameters

None

Return Type

String

Syntax

=Project.MethodPath()

Parameters

None

Return Type

String
hermo Scientific ChromQuest Reference Guide 255



11 Advanced Report Templates
Project Functions

256
Project.Name

Returns the name of the current project.

Project.RootPath

Returns the default root path for the current project.

Project.SequencePath

Returns the default path used to store sequence files in the current project.

Syntax

=Project.Name()

Parameters

None

Return Type

String

Syntax

=Project.RootPath()

Parameters

None

Return Type

String

Syntax

=Project.SequencePath()

Parameters

None

Return Type

String
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Project.TemplatePath

Returns the default path used to store report template files in the current project.

Sequence Functions
These functions return information about the sequence file that is used for reporting 
purposes.

Sequence.Filename

Returns file name of the sequence file that is used for reporting. Only the file name is returned 
the path information is not returned.

Sequence.FullFilename

Returns full file name of the sequence file that is used for reporting. The file name and path 
information is returned.

Syntax

=Project.TemplatePath()

Parameters

None

Return Type

String

Syntax

=Sequence.Filename()

Parameters

None

Return Type

String

Syntax

=Sequence.FullFilename()

Parameters

None

Return Type

String
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Sequence.RunNumber

Returns the run number of the specified sequence run. This function can be used in 
conjunction with the EX.R() formula to generate the run number of the runs in a sequence. 
For example, the following formula would generate run numbers for all runs of a sequence 
going down: =EX.R(SEQUENCE.RUNNUMBER(),"RA;1;0")

Summary
The following describes the parameters that may be passed to template functions to describe 
the requested data file, peak, and group information.

Run Info may be one of the following:

Trace Info may be one of the following:

Peak Info may be one of the following:

Group Info may be one of the following:

Direction may be one of the following:

Syntax

=Sequence.RunNumber(<Run Info>)

Parameters

<Run Info> Describes the data file(s) that are used to extract the value.

See the appendix for a description of the above parameter(s).

Return Type

Number

"RC" The current run or currently loaded data file.

"R<x>" The sequence run specified by run <x>.

"T<x>" The trace specified by index <x>.

"P<x>; <peak 
type>"

The peak with an index of <x> having the given peak type.

"G<x>; <group 
type>"

The group with an index of <x> having the given group type.

0 The data is repeated across the spreadsheet.

1 The data is repeated down the spreadsheet.
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Peak Type may be any combination of the following:

Group Type may be one of the following:

1 Report named peaks that were detected.

2 Report named peaks that were not detected.

4 Report unnamed peaks.

0 Report calibrated range groups that calculate concentrations for unnamed peaks in 
this group.

1 Report calibrated range groups that do not calculate concentrations for unnamed 
peaks in this group.

2 Report named peak groups.
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